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INTRODUCTION
Using the Inquiry Model for Effective Research in a Scientific Context
This unit will provide you with skills, knowledge and resources to conduct a powerful inquiry-based
investigation. The unit is set in a science context with a focus on sustainability and the environment,
but the skills you will learn can be used in a range of areas:
• Future research-based tasks in your academic course
• Design and development of strategies for improving the information literacy competencies in
students that you will be teaching in the future
• Greater confidence and expertise in the use of a range on Web 2.0 tools that you will find useful
when you begin to develop curriculum resources for students in your classes
• A good understanding of key aspects of the Australian Curriculum: Science, which will help you to
plan valid and relevant student activities in this curriculum area
You will conduct a single topic investigation over 13 weeks around sustainability and the environment
and then complete a report and present your inquiry topic in an exhibition. Along the way there will
be tasks to complete and tools to use and experiment with. Throughout the unit you will be using a
range on Web 2.0 tools which you will review and evaluate.
Why Whale, Sharks and Whale Sharks
Whale sharks are an enigma, they are not whales and they are the largest ocean fish growing up to 40
feet long. Despite the enormous size of these creatures very little is known about their movements and
their habits. Whale sharks are found on the North West coast of Western Australia but where they go
to breed, how they travel and where they travel to during the months they are not seen off W.A. is
unknown. Research is currently under way in W.A. to determine more about these majestic creatures.
Sharks. We have always had a love / hate relationship with these majestic creatures. We love them,
we fear them, we eat them and we are enthralled by their behavior. Are there more sharks in the ocean
or are there just more people swimming? See our interview. Can inquiry and research answer
questions and provide us with a more detailed picture these majestic creatures?
WATCH: National Geographic Whale Sharks http://youtu.be/1Fp4cBG18R4
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Before You Start Your Inquiry Journey
An Inquiry is a journey not just the destination.
Each week you will be required to reflect on each stage of the process as you undertake your inquiry.
This reflection can take many forms:
- It may be a mind map that shows how you have developed your prior knowledge on your topic.
- It may be the repository of web resources you developed as part of your content curation activity.
- It may be a dilemma that causes you to reflect on your thinking.
All the tasks form part of your journey that culminates in your final project.

What is Science?
This unit uses the inquiry process to examine scientific questions and so the first question we seek to
answer the question 'What is Science?'
Explore now, the purpose and meaning of science and what science means to a wide variety of
scientists in the following examples.
1) With Richard Dawkins and Ricky Gervais consider the purpose of science and how it helps us add
meaning to our lives (Sex, death and the meaning of life (time 39.30 to 46.45)).
2) Persevere through the early footage of this video to determine why laws/theories are tentative and
why evolution should be taught in Dover Schools (USA) (What is science 2.15 -10.0).
3) Some thoughts about the Nature of Science and Science Inquiry by Science Educators Norman and
Judith Lederman (p 4-8)
So what is science inquiry and why is it important?
Do you need to have science in your life?
Examine the links below, an article from Ben Goldacres (Bad Science) and a video from Ted about Science.
Videos
Sex, Death, Meaning of Life
http://youtu.be/kw9i7vIWxgc
Battling Bad Science
http://www.ted.com/talks/ben_goldacre_battling_bad_science.html
What is science? What is a scientific theory? http://youtu.be/_JjT_6_mX1k

Readings
What is Science? (See Appendix)
The Nature of Science (See Appendix)

Reflection
In workshops you will often be required to go to Collaborize or Padlet and post your response in the
Forum.
Not only will you benefit from sharing your ideas with your peers but it will also provide evidence of
your participation in the reflective process.
e.g. You could be asked to comment on a tool you have used in the workshop or an interview you
have watched or an issue that has arisen.
You will need the attached information or the help page of the website to help you register in
Collaborize.
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Data Collection
It is very important that you establish a systematic way to collect and collate the information and
research data as part of your journey. You may collect lots of data in the form of articles and sheets
and if you use the dropbox you can find the information on any computers.
We strongly suggest that you use a facility such as Weekly task journal on BB to manage these
resources. See the help page for support in creating and managing your assessment and for any other
technical support you require.
For this unit we are using a survey instrument called survey monkey as our method of data collection
enabling us to assess the value to you of the unit. We are seeking to examine the information
technology and also the inquiry process that you have used and your experiences. Please complete the
pre survey here.
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Unit Outline
This unit is designed to guide you through the inquiry process and the resulting product of this
inquiry will be a report and presentation on a science or social science problem that you have chosen
to investigate. For example the question could be Why do whales beach themselves? or Where do
whale sharks go during the breeding months? You will then investigate the question, research the
data around the subject and synthesize and create a report on your findings.
You need to complete the tasks in the workshops in order (week 1 - week 10) as the development of
your inquiry skills are as important as the final product. These inquiry skills will be transferable into
your science and social science classrooms and will set you on the road to becoming a researcher.
The unit outline is available on the BB site and here.
Inquiry in Action
The button accompanying the picture each week will link you to a video that documents Inquiry in
Action.
We have interviewed and filmed a number of scientists and historians to examine how they use
inquiry in real world contexts. Please watch each video before the workshop so you can discuss the
inquiry process.

Matrix
See Appendices
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Working Together
There are 2 ways to collaborate
1) Partnerships - you may choose to work with a partner on the project
2) Support and Critique Group - you will be expected to have your project considered by your peer
support group and you will participate in the support group to help others refine their project.
Partnerships
You have the opportunity to work with a partner on your project if you want to or you can work alone.
If you work together you will create some tasks on your own and others you can create with your
partner and hand in one task.
Be aware that although working with someone seems fantastic you need to consider how you will
work with them. These issues include
1) How will you connect? (will it be face-to-face, Skype Google hangouts etc)
2) How often will you connect? (weekly, twice per week)
3) Who will be responsible for what tasks? (consider a discussion on diversion of labour before you
start)
4) Identify which tasks you must complete and which you can complete jointly (see assessment)
Support and Critique Group
Helping you to refine your project and giving feedback comes in several forms, one is through tutor feedback
in week 7 when you have your formative project marked and comments made to help you refine your
work. The other is through a support and critique group 3 times in week 3, week 6 and week 10.
The purpose of this group of your peers is to provide a place where you can express your problem and others
can ask you questions about how you might research, expand, contain and write about it. It will happen in
class or for on-line students on discussion board.
You will also be in a S & C group for your peers to help them with their project.
There are Guidelines for this process as well as specific questions for each stage
1) Use warm feedback and positive comments first
2) Use cool feedback carefully and think about your expression (see video right for examples)
3) Listen when you should listen and speak when you should speak
4) BE SUPPORTIVE (You could be next)
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WORKSHOP ONE: YOU AS A LEARNER
Objectives
- Examine a number of models that will encourage students to reflect on their learning styles,
attitudes and behaviours.
- Articulate three strategies that help you learn.
- Create a Podcast and post to the weekly journal.

Discussion
Learning Styles
Use the links on the thinglink diagram of the brain to visit the websites and investigate your learning
style. Remember these are only a guide but may help you become cognizant of the ways you collect,
retain and share information and knowledge as part of the inquiry in this unit. Post your findings on
our Wall. See the Reflection below.
The power of collaboration when it comes to learning new things
There is great truth in the saying 'two heads are better than one' when it comes to innovation and
problem solving. You may want to work with a partner on the project. To get ideas on tools to help
you set up a useful collaborating environment go here.
Why is collaboration such a powerful catalyst for creative thinking?
What are some of the new innovative ways that we can collaborate now with the support of
technology?
Online learning communities use a range of collaborative tools to problem solves and co-create
solutions. This may become a powerful learning strategy for you in this unit when you can share
interesting websites and tools you have discovered.

Tasks
1) Post 2 things you learnt about yourself and your learning styles in 2 sentences on Padlet. Use only
your first name and list 5 things you have discovered about yourself as a learner.
2) Set up your Weekly Task Journal in BB and alert your tutor by email.
3) Complete the survey monkey about your on-line experiences and confidence
4) Explore Collaborize as an on-line tool and register to join the unit group by following this link.
5) Create a podcast that answers the question “Is sustainability important to me?” Start this answer
with an example of sustainability and then consider how it relates to you in your life so far and
then what you think sustainability actually is (don't research it). Total 2-3 mins and then Post the
podcast in Weekly Task Journal in BB

Your Inquiry Journey
- - Complete survey monkey one about your on-line experiences.
- Read the newspaper and engage in local environmental news to find problems.
Create a podcast that answers the question “Is sustainability important to me?” start this answer
with an example and how it relates to you in your life so far and then what you think that
sustainability is (don't research it). Total 2-3 mins and then Post the podcast in Weekly Task Journal
in BB
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WORKSHOP TWO: UNPACKING INQUIRY
Objectives
- Consider what is science?
- Define the key aspects of the inquiry process and explain the significance of each.
- Practice the strategy of active reading for understanding.
- Examine the science stories and identify and analyse the inquiry process used.
- Complete a scaffolded investigation about paper towels absorbency.
.

Discussion
Using the Inquiry Model for Effective Research
This unit is designed to provided you with the skills, knowledge and resources to conduct powerful
inquiry based investigations. As you will see there are many similarities between science inquiry and
the information literacy process - we use aspects from both to provide the framework that you will
follow over the next 11 weeks.
You will develop a strong foundation that can then be applied to future inquiry-based tasks, not only
in your academic course, but as a framework for the development of information literacy
competencies in your future students.
Inquiry Method
Empirical inquiry includes "quantitative" and "qualitative" methods that are the types of tangible data
assessed using the evidence of our senses. While these kinds of data collection methods are not the
only way in which we "know" things, they are useful for testing research hunches or hypotheses in a
variety of fields.
Inquiry methods are most often used for two major purposes:
(1) To establish "facts" or recurring regularities in the environment.
Examples of facts include:
• The incidence of violence on high school campuses.
• The number of shark sightings on the WA coast
(2) To test (and, more surreptitiously, establish) causal explanations for established facts. Most
theories address explanations for factual material. Explanations typically assert causal relationships
among variables of interest.
For example:
• Students who engage in explosive violence on high school campus have been bullied at that school.
• Science professionals have greater access to the Internet at work than other workers do.
Online Resource: Inquiry Method

Tasks
1) Inquiry in action 1. Complete the investigation exactly as outlined and answer the questions. Post
you completed investigation in the Weekly Task Journal. Post your answer about paper towels to
the Collaborize page
2) With your friends consider the Dilemma here and consider how you would help the whales.
3) Read the science stories of inquiry that have been included. Summarize each briefly, identifying the
aspects of the inquiry process and consider the questions asked.
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3) Use the newspaper and other sources to identify one fact establishing article and one attempting to
establish a causal relationship.

Your Inquiry Journey
From the local newspaper or the Internet find an example of a study that establishes facts and one that
attempts to establish a causal relationship.

Readings:
How to: Inquiry Website)
A Case Study of Memory Loss in Mice (See Appendices)
Childbed Fever (See Appendices)
Salem’s Secrets: A case Study on Hypothesis Testing and Data Analysis (See Appendices)
Platypus: an anitipodal mystery (See Appendices)
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Inquiry in Action 1
As we cruise the supermarket aisles we need to choose which products to buy. How can we make a
decision about which paper towel is the most effective in soaking up stains?
WATCH: VIVA Paper Towels Ad Featuring Trevor Heins

http://youtu.be/kw9i7vIWxgc

Question
Which paper towel brand will soak up the most water?
Independent variable (we are changing)
Type of paper towel
Dependent variable (we are measuring)
Measure the amount of water soaked up
Controlled variables (all other variables need to be controlled)
• The size of the paper towel, time of towel in water
• The place where the water has been spilled
• The measuring container
Can you think of anything else?
Materials
Paper towels (3 types A, B, C), water (coloured), measuring device, container, scissors.
Method
1) Cut the paper towels so that they are all the same size and shape
2) Fill a container with 30 ml of coloured water
3) Put the paper towel into the container and wait for 30 seconds
4) Pull out the towel and wait until the towel has stopped dripping
5) Then measure the amount of water remaining in the containing using a
measuring cylinder
6) You need to repeat this investigation with each brand of paper towel, and
you need to repeat the investigation three times each.
Results (see the table and graph attached)
Discussion
The graph shows that the paper towel 3 absorbs the most water and paper towel
1 absorbs the least amount of water. So the best paper towel is paper towel 3.
The science behind this phenomena relates to the design of the paper which
impacts on the capillary action and consequently the absorbency.
PMI Positive Negative and Improvement
PositiveNegative - the paper towel dripped on the bench and not in the container
Improvement - the measuring cylinder was only accurate to 2 ml, more trials would improve the
accuracy of the investigation

Inquiring about the World

Page 15

WORKSHOP 3: DEFINING
Objectives
- Identify 2 research areas that interest you.
- Using 1 mind mapping tool and 1 graphic organiser on-line tool identify all the prior knowledge and
general information about each area and other related topics identified.
- Explore the topic of emotional bias about sharks, consider the websites and highlight the use of
emotive imagery and language.
- Create an avatar that will provide a brief overview of the topic

Discussion
Defining the topic
At the start of an investigation it is important to be clear about the topic, issue or problem.
Here are some questions you need to ask yourself before you start.
• What do I want to find out about the topic?
• What do I already know?
• Who is the audience for my final presentation / product?
• What kind of information / data do I need to find?
How will this learning change my thinking / knowledge?
Identifying prior knowledge
Before you begin your inquiry you need to identify prior knowledge / understandings/ or
preconceptions about the topic or issue. This initial task will not only clarify the extent of you
knowledge but also establish the "gaps" in your understanding.
(A KWL chart provides a simple framework to document this knowledge and is an excellent tool to
use in this Defining stage).
Identifying information needs
Use the graphic organisers and mind mapping tools to start expanding your ideas. You need to
examine each of the tools we have provided and then pick one tool from each category and start to
populate it with your ideas and what you already know. Use the pages attached through the buttons
below to complete Task 2.
Emotions and Bias
Many interesting topics around the environment and sustainability are charged with emotion. Whilst
this is normal, you need to be aware of the two sides to every situation and be able to put the emotion
aside at least initially to gather your data and complete your analysis. Visit the page on emotions
through the button below and complete Task 1.

Tasks
There has been a significant increase in fatal shark attacks in Australian Waters.
1) Explore how emotional bias will affect research and/or proposals around this issue. To do
this choose 1 website on the emotions page and highlight the use of emotive imagery and language
and explain how this helps to create their message.
2) What might constitute an educational or academic website? Explain
3) Use 1 mind mapping tools and 1 graphic organizer tools to explore 2 topics (1 tool type for each
topic)
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4) Create a Voki about the topic you have chosen. In 75 words explain what problem you have
chosen and post it on Collaborize. The Voki should identify the problem and why you have chosen it
(this will form the beginning of your rationale).
5) Time to support your peers and perform a critique, to present your data to your peer group and get
feedback and critique. Critique and Support - Questions and Instructions here.

Your Inquiry Journey
ASSESSMENT 1

15%

Submit in the Assessment 1 Drop Box in Blackboard
a) 1 mind map or 1 graphic organizer that illustrates the planning for the investigation you have
chosen.
b) Submit the URL of the Voki you have created that outlines the problem you have chosen in

75 words.

Readings
Emotional Bias
Emotions
Emotions are an important part of our lives and are necessary to keep us functioning. But coming to a
topic with a very strong bias will prevent you from considering all the data available and prevent you
from being able to be objective in your analysis
Help me please!!
Hello. My name is Cyril the shark and I want to talk about sharks in the ocean. Now there has been a lot of
hysteria recently about the number of people interacting with us sharks and we have heard that there are
plans to catch, kill and drive us away. Before we all get completely carried away can we have a look at the
facts! How many sharks are there currently on the West Australian coast? Are there more swimmers in the
water at times of low light? Where are the local fish shoals? So before anyone rushes off to buy a large
fishing hook and cooks chips we need to have more data
Finding authentic, authoritative sources of information on the web.
When searching for quality resources on the internet it is important to ensure the information is objective,
unbiased and accurate. Use the websites below and pick one and look at the emotive language used to
create a feeling about this issue.
Mindmapping
A mindmap is a great way to record your information as you do research. You can use colours,
pictures, shapes...anything you like to help you organise information. Lines help you to connect
information that goes together. You can draw these maps on paper or you can use some great Web
2.0 tools and iPad Apps to create your maps.
Graphic Organisers
Graphic Organisers allow you to strategically place information on a prepared framework. This helps
you to organise your information as you conduct your inquiry and links information to develop
concepts and relationships.
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WORKSHOP FOUR: DEVELOPING AND REFINING YOUR RESEARCH
QUESTIONS
Objectives
- Identify1area of interest and expand the mind map.
- Synthesize a variety of questions using the models: the 5Ws, Question Matrix and Blooms
Taxonomy.
- Create question(s) to answer in your investigation.

Discussion
The question is the answer
The quality of questions that you ask will determine the focus and depth of your inquiry. There are a
number of frameworks that you can use to help broaden your questions and thinking. Examine each
of these frameworks to expand the questions around your chosen topic. Some questions will not be
suitable or re-searchable, but is important to have an understanding of the different approaches to
questioning that you can use both for personal use and as an educator.
Questioning Resources
The 5Ws
Question Matrix
Six Thinking Hats
Bloom’s taxonomy of Questions
The Question Toolbox
Open and Closed Questions

Inquiry in Action 2 (see appendix)
Complete Inquiry in Action 2.
It is a simple inquiry to answer another very important question.
Under what conditions will the headache tablet dissolve most quickly?
You need to design the methodology yourself focusing on making your investigation as accurate as
possible.

Tasks
1) Examine all the questioning tools that have been provided for you and use them with your topic to
create as many different questions as possible. Choose 3 or 4 open ended questions that will form the
basis of your inquiry.
2) Inquiry in action 2. Design and complete the investigation as outlined and answer the questions.
Post you completed investigation in the Weekly Task Journal.
3) Answer the question on Collaborize - ‘Which tool has generated the best questions for your
investigation?’
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Your Inquiry Journey
Post in Weekly Task Journal a list of 3 or 4 questions that will form the framework of your topic and
lead your investigation.
Resources
These websites provide a range of templates and approaches to developing powerful questions
Questioning (From Making Metacognition Mainstream)
The Question (Inquiring Mind)
Dimensions of Learning and the Questioning Process
Question Skills
Questioning Techniques

Readings
Effective Questioning Handout
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Inquiry in Action 2
You have a really bad head ache and need to dissolve the pan killer as quickly as possible. Instead of
icy water would water at room temperature water be quicker, or even warm water What temperature
enables the tablet to dissolve most rapidly?
WATCH: Tablet Dissolving RnD http://youtu.be/gF1xQaIgmao
Question
What temperature of water would see the tablet dissolve most rapidly?
Independent variable (we are changing)
Temperature of the water
Dependent variable (we are measuring)
Measure the time it takes for the tablet to dissolve
Controlled variables (all other variables need to be controlled)
Materials
Complete the rest of the experiment
Method
1)
2)
3)
4) etc
Results (see the table and graph attached)
Discussion
The graph (is it a line or bar graph?) shows
The science (can you explain this phenomena)
PMI Positive Negative and Improvement
PositiveNegative - the paper towel dripped on the bench and not in the container
Improvement - the measuring cylinder was only accurate to 2 ml, more trials would improve the
accuracy of the investigation
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WORKSHOP FIVE: LOCATING RICH SOURCES OF DATA AND
INFORMATION
Objectives
- Identify the issues and advantages surrounding primary and secondary sources of knowledge.
- Facilitate on-line searches using a variety of search engines.
- Consider the advantages and disadvantages of qualitative vs. quantitative data and work with
statistics.
- Identify creative commons information and describe its benefits.

Discussion
Sources of Knowledge
Finding and Organising information
How do you know what is an authoritative source of information and where are the best places to get
this information?
There are millions of online information sources with varying degrees of accurate information. In
many instances data integrity is not an imperative BUT when it comes to making an informed decision
about something important then data and information accuracy is essential.
So how do you know that the information is accurate and that it has been sourced from an organisation
or an individual who is an acknowledged and reputable authority?
To Google or Not to Google!
While Google is perhaps the most popular search engine on the web today there are many other search
engines available - some of which have been specifically designed with education in mind.
Now though Google scholar provides parameters that you can use when you search to limit the search
to full papers. See the link here to find out how .......Google scholar
'Good' versus 'bad' information
When conducting research how do we know whether a resource is authoritative or not?
How do we become discerning users of information?
To help you learn how to interrogate web resources complete the task below as part of your Research
Journey.
Creative Commons and Copyright
The issues of copyright, intellectual property, creative commons and co-creation of information are all
aspects of the inquiry process that need to be considered when conducting your inquiry. While it is not
a focus of this unit it is still an important area of consideration when sing information that is found on
the web.
The importance of data sources for scientific inquiry
It is important that you approach inquiry with skepticism. Some amazingly strange
and bizarre research has been carried out over the years. Some would never be authorized now due to
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ethics constraints or as we discover more information about the area of research and revise ideas.
Here are some of the considerations that we need to review.
a) Peer Review
What is the source of the material? This relates to when and where it was published. This is important
as when papers are printed in a reputable journal they have been subjected to extensive peer review.
That means it has been examined and considered by others in the field.
b) Replicable
Has the methodology been extensively examined? When the methodology is listed other researchers
can review the method used and replicate the results. If the results are replicable then it gives the
results more value.
c) Generalisable
Are the results able to be generalised to other situations? If the research looked at the action of a new
drug on the mind of small mammals such as mice, there is no way the research can be applied to
humans without further research. Studies on the effect of caffeine on post-menopausal women yield
different results from the effect of caffeine on young male athletes under 25 years old.
Interpreting Data
Ensuring that you can read and examine the data presented to you and make sense of the information
is vital. These short articles examine the data related to infectious diseases and are from Health
Protection Agency in the UK. Download all the 3 PDF's attached to the buttons to the right and
examine the data collected and presented to answer the questions contained below.

Tasks
1) Use 2 search engines and search the same phrase related to your investigation to determine what
different sites are presented to you.
2) Complete the Questions relating to the data on infectious diseases presented above which will help
you interpret and understand statistics.
3) Evaluate the 5 websites on the scoop.it site using the rubric provided and determine which sites
contain reliable material and why you think it is reliable.
4) Visit the ethics page and read the information provided. Document your thoughts and comments on
the report.
5) Conduct a virtual tour of the library (via website). What does this strange building have for you that
you can utilise to complete this investigation? For real excitement take an actual tour.
6) Comment on the statement on Collaborize ‘How do the notion of creative commons impact on
plagiarism at University?’
7) On Padlet post a comment to ‘Does the end justify the means with research in relation to the
Tuskedee Report?’
8) Time to support your peers and perform a critique, to present your data to your peer group and get
feedback and critique. Critique and Support - Questions and Instructions here.

Your Inquiry Journey
On Padlet post a comment to ‘Does the end justify the means with research in relation to the Tuskedee
Report?’

Assessment
Assessment 2
20%
Post in Assessment Drop Box 2 on BB your completed proposal form that includes the problem,
questions, a rationale, mind map and summary of 4 key references
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Readings
Malaria Deaths

Malaria Countries
Salmonella

Questions
From Imported malaria cases and death, United Kingdom 1992 – 2011
1) Which year had the most deaths in the UK as a result of Malaria?
2) Which year had the most recorded cases of Malaria and how many cases were
there?
3) Describe the trend of Malaria cases in the UK from 2000 to 2011.
4) Do you feel that there is an overall meaningful reduction in the number of Malaria
cases in the UK over the years the data has been recorded? Explain
5) Research Malaria and describe how it is spread. From your newly acquired
knowledge do you think Malaria is spread in the UK or are all the cases imported
from overseas? Explain your answer.
From Imported malaria cases by species and region of travel, United Kingdom 2007 –
2011
6) Use the data in the table from 2011 only to plot the number of cases of malaria in the
UK from the different parts of Africa. (Hint will this be a bar graph or a line graph).
Include your hand drawn graph with these questions.
7) Which continent has the greatest cases of Malaria?
8) Why is Europe not included?
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WORKSHOP SIX: CURATING
Objectives
- Evaluate sources of knowledge and make decisions on the quality of data collected.
- Create a digital organizer.
- Create a reference list using EndNote or similar programme.

Discussion
What is content curation?
Pulling together information is an important part of research, and then storing that information in such
a way that it is easily accessed at a later date is equally important. Curation tools are ways of
capturing, organising and holding useful information to be accessed at a later day.
You need to decide, by examining the tools below, which curation tool you will use for your inquiry
and then start searching and collating material pertinent to your chosen topic.
Content Curation Tools
Scoop.it
Edcanvas
Evernote
Themeefy
Bag the Web
Learnist
Pinterest
Sources of Knowledge
Primary and Secondary Sources of Information
Primary sources of knowledge are the original documents, photographs, letters, manuscripts, reports
and statistics that have been created by an individual. If you are using the work of others then you are
using secondary sources of information.
As you complete your topic investigation you will not be collecting data (primary source) you will be
analysing materials you have collected from the web or other reports and sources (secondary source).
You need to analyse the secondary data and ensure that it is reliable, accurate and valid.
Referencing
It is imperative that you reference all of your sources of information as you collect your data. The
Curtin Referencing Guide is what you will need to follow….See Appendices
Referencing at Curtin
Endnote (free download for Curtin students)
APA Referencing Guide
Getting Started with Endnote

Tasks
1) Inquiry in action 3. Design and complete the investigation as outlined and answer the questions.
Post you completed investigation in the weekly task journal
2) Examine data that contains qualitative and/or quantitative information and consider the limitations
and advantages of each.
3) Examine a range of digital organisers, select one to store and organise your collected information.
4) Begin to generate a reference list using End note to capture and display your references correctly.
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Your Inquiry Journey
Create a reference list and add it to your Proposal and Post all in weekly task journal

Inquiry in Action 3
Complete Inquiry in Action 3 below.
It is a simple inquiry to answer another very important question. This time it relates to Hot cars in
summer?
You need to design the methodology yourself focusing on making your investigation as accurate as
possible.
Children in hot cars is a tragic and terrible thing and there is always a story over the summer where a
child is rescued or dies in a hot car. How hot do cars get in the sun and is there a large difference
between a white car and a dark (black) car.
Inquiry in Action 3
Design an investigation to test the temperature of a white car (or similar object) against the
temperature of a black car over a set time (1/2 hour or short shopping trip)
Question
What
Independent variable (we are changing)
Dependent variable (we are measuring)
Controlled variables (all other variables need to be controlled)
Materials
Method
1)
2)
3)
4) etc
Results (see the table and graph attached)
Discussion
The graph (is it a line or bar graph?) shows
The science (can you explain this phenomena)
PMI Positive Negative and Improvement
PositiveNegative Improvement
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WORKSHOP SEVEN: SYNTHESISING
Objectives
- Examine the reporting style and using that format to synthesize your report.
- Review your report using formative assessment to guide their progress and make appropriate
modifications.
- Synthesize data into a report format examining the structure and type of language.

Discussion
Synthesising your paper
This is where you need to start synthesizing your information into a report. You will need to use the
skills you acquired in your literacy unit and apply them here.
There is a specific style that you need to use for a report and an example is attached here for you to
consider. Read the report carefully and identify the major headings, relevant sections use of
appendices.
Ethical use of information and avoiding plagiarism
Correct referencing and ethical treatment of the data is important; the notion of plagiarism is one that
continues to plague students through out their University career.
The only way that best describes the notion of plagiarism is to explain it like this.
Coke is a product of the Coke Cola Corporation but if you copied the can, the shape, the colour and
the style and said the 'can' was your own then that would not be right and the company would be
unhappy - the company would probably prosecute you.
When academics write papers, the ideas contained within are their products and if you copy them
then without acknowledging the author, then you are plagiarising - you are pretending their ideas are
your own.
Plagiarism
Assessment
There are several assessment tasks through out the unit.
Week 6 Formative Assessment - you will get feedback from your tutor to refine your developing
report.
Week 10 Summative Report - this will contain your report on your chosen problem and aspects of the
inquiry
Formative vs Summative
Formative assessment is important in helping to craft reports, with feedback given to enable
refinements to be made in the final product. It is important to realize that all the comments and
changes suggested by your tutor while appearing terrible and demoralizing are actually positives to
help you create a much better finished product.
Summative assessment is a final assessment of the whole body of work and there is no opportunity to
make changes - it is assessed as it stands.
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Task
These tasks may take several weeks to complete
1) Highlight the key aspects of the report style with a focus on the headings that guide the report you
are creating
2) Search the Curtin library and other digital sources to continue to synthesise the data in the literature
review
3) Review the Universities plagiarism documents and website to be very clear on what constitutes
plagiarism and how to avoid this in your writings. Consider how Turnitin works and how it can impact
on a cut and paste effort
4) Continue to craft your inquiry topic, drawing on your tutor’s formative comments and your internet
and library studies.
5) Examine the summative framework and the marking guide to ensure you address the necessary
criteria and read the information about report writing

Your Inquiry Journey
On Padlet site post a comment about how you see plagiarism.’ Is it a big deal or just the University
making a fuss?’
Formative Feedback from your tutor.
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WORKSHOP EIGHT: COMMUNICATING
Objectives
- Examine the presentation tools provided detailing how each can be used (on-line or in person).
- Select a tool that would be suitable for presenting the research and briefly explain why it was
chosen.
- Consider what factors are important in creating a successful presentation.
- Create a presentation that clearly and concisely articulates the key sections of the report.

Discussion
Creating Powerful Presentations (beyond Powerpoint)
There are many different ways that you can present your findings or the outcome of your research.
The presentation format you use will greatly depend on the purpose and audience for your tasks. More
and more, with the advent of new technologies, we can merge mediums (mashups etc) to creatively
present our work and share with a world-wide audience. Listed below are a range of presentation and
digital storytelling tools that you may consider using for your final product.
This video tells you what not to do with a power point and other examples can be found on the
technical help page. Link: http://youtu.be/KbSPPFYxx3o
Presentation Web 2.0 Tools
Slideshare
Prezi
Slidebomb
Author Stream
Empressr
Zoho Show
Pixorial
Digital Stories
Digital stories are becoming a popular way to make presentations. They combine text, images, sound
and movies to connect with the audience. Here are just a few that are available, many are free or have
a free version which makes them very accessible for students and schools.
Storybird
Slidestory
Animoto
Smilebox
VoiceThread
Capzles

Task
1) Examine the presentation tools and select 3 of the tools listed and create a brief summary to explain
how to use the tool and any advantages and disadvantages. Explain as if to a novice or a year 7
student.
2) Select a tool that would be suitable for presenting your research and briefly explain why you are
using this tool and who you audience would be.
3) Identify the audience with whom you want to share the presentation
4) Watch the video of ‘what not to do’ in creating a power point
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5) Identify the key points for your presentation and create your presentation.
6) Critique and Support - Questions and Instructions here

Your Inquiry Journey
On Collaborize post any questions and any useful finds (websites, tools etc.). This will help you and
your peers and as you all have different topics.

Assessment
Assessment 3
30%
Inquiry Project
Using the summative proforma attached to add to the work and complete a project report of
your problem max 3000 words
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WORKSHOP NINE: EVALUATING
Objectives
- Reflect of the inquiry process undertaken.
- Identify the strengths and weakness of your skills in each stage.
- Summarise how the knowledge and skills learnt in this process will be of benefit.
- Examine the inquiry strand of the Australian science curriculum.
- Present the findings of the project and as a consequence the answers or findings of their inquiry.

Discussion
Reflection
a) How is your thinking about science inquiry changed?
b) Now you have completed the process, what do you see as the essential skills that need to be
mastered to conduct effective inquiry?
c) From the technology tools you have used which do you think has the highest value for you as a
learner? Why?

Task
1).Complete the self-assessment rubric on the process and knowledge gained with a PMI of your
strength and weakness.
2) Reflect on the questions around your learning and discuss your completed rubric in class
3) Now you have completed the process, what do you see as the essential skills that need to be
mastered to conduct effective inquiry?
4) From the technology tools you have used which do you think has the highest value for you as a
learner? Why?
5) Examine the Australian Curriculum: Science, considering specifically the science inquiry strand,
list the key aspects of the inquiry process, describing specifically what you have done in this unit for
each of these key aspects. Which aspect did you find most challenging?
6) What aspect do you think would be most challenging for a: Year 3 student?, a year 6 student? A
year 10 student?
7) Justify your answers
8) Display your project in the format you have chosen

Your Inquiry Journey
1) Complete the Survey Monkey survey about your on-line experiences.
2) Hand in your presentation through the Submission point Assessment 4 box on BB.
3) Create a podcast that answers the question “sustainability?” consider how sustainability connects to
your project and your life. Total 2-3 mins and then Post the podcast in Weekly Task Journal in BB
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EXTRA
Sustainability
Why do whales beach themselves and should humans try to help them. Do we have
a responsibility to help? As we have the capacity to engage in ethical conversations and act
with compassion should we? If we take this further should we consider our decisions about
how we live our lives, how we use limited resources such as energy, and reduce over using
other resources such as plastic bags. Should we be considering the impact on the environment
and how sustainable our lives are?
What is Sustainability?

Humanity has the ability to make development sustainable to ensure that it meets the needs of
the present without compromising the ability of future generations to meet their own
needs. (Brundtland Report 1987 p 24)
Questions about what 'humanity' does or does not do in order to preserve and sustain
the environment has been an issue for many years now. Sustainability has been an important
focus for scientists and science educators for many years. As the biggest impacting species in
the world with the capacity for reflection and ethical behavior should we be considering as
stated in the Bundtland Report (1987) our impact on the current environment and on the
future?
Consider the Whale Dilemma (from Dilemmas website)
You and your family are on holidays on the south-east coast of Tasmania. You suggest a
beach walk on a remote beach about 5 minutes from your chalet. Whilst walking on the
beach you notice a large dark patch in the water off in the far distance. Excitement spreads
through the whole family. This is what you came to Tasmania for, this is whale watching
season. Could this be a pod of whales on their way down to Antarctica? As you move closer
to the dark patch you notice it is not out in the ocean, but quite close to the beach. The
feeling of excitement from the groups starts to dissipate and a very different feeling descends
upon the group.
You come across 100 or more adult Long-finned Pilot Whales that are either in shallow water
or on shore. Some are already dead but some are still alive. The species is not endangered but
they are listed as "Lower Risk; conservation dependent" on the Red List of Threatened
Species of the International Union for the Conservation of Nature and Natural Resources
(IUCN). Tourists and locals are present on the beach around the whales and they are asking
what course of action should be taken. Three options emerge; do nothing, euthanize the
whales that are still alive or push the whales back into the water.
1 What would you do? Why? (Discuss this with a peer, friend or family member)
The decision to push the whales back into the water is taken and while you help, the National Park
ranger tells you about the whales. Each whale 3.5 to 5 m long and weighs between 1.5 and 3 tons, for
females and males. Males live for about 45 years and females for about 60 years. Whales are social
animals living in large groups with a leader and a communal support system in which weaker or
endangered animals are helped by the rest of the pod. The groups are mainly 10 to 30 in number, but
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some groups may be 100 or more. They eat mainly squid. Some of the females are pregnant. It takes a
lot of work and effort to push each whale back into the water. It is obvious that you will not have
enough time to save them all.
Q 2 Which animals would you push back first? Why? (Discuss this with a peer, friend or family
member)
This group of stranded pilot whales has attracted the attention of a group of Marine scientists who
would like to take tissue and blood samples to study the whales and try to find some explanation for
the stranding. The scientists want to know if the whales are closely related using DNA profiling
techniques and assess their health by testing for toxic poisoning, infection or organ failure. All these
causes have been observed in other single stranded cetaceans.
Q 3 Would you agree for the scientists to take samples from all the whales? Why? (Discuss)
After 2 days, only a dozen whales have been successfully pushed back into sea because each animal
needs to be put on a sling and dragged across the sand of the sea bed to deeper water. Their skin is
fragile and the crew does not want to harm them further. Also, because the beach is in a remote part
of Tasmania, it is impossible to use heavy equipment to lift and put the animals back in the water
because there is no dock or access road for heavy equipment. The whales cannot be towed from the
beach to the water using a towboat because it would break their back. Time is crucial and it becomes
obvious that some animals will not be rescued. Before whaling bans, the pilot whale was hunted for
meat and fat. It is possible to contact a company that would euthanize the remaining whales and
process them for fat. The company will take only the animals that are freshly killed and would pay for
each whale. This money would help to cover part of the cost of the rescue.Because they want to
process the meat and fat for human consumption, the company propose to euthanize the whales by
blowing their heads off with a small explosive, rather than an overdose of drugs which would render
the meat unfit for consumption.
Q 4 Would you agree for the company to euthanize the remaining whales and process them?
Why? Do you agree with this method of euthanasia? Why? (Discuss)
A few months after the event, the scientists publish their finding in a public report. The scientists point
out that the causes for the stranding of cetaceans are numerous and not fully understood. One of the
hypotheses proposed by the scientists is that the whale’s navigation system and communication was
disturbed by ultrasound emitted during sonar equipment testing by the Navy. The number of cetaceans
stranded on beaches has doubled over the last decade in the UK. There are no reliable data available
for Tasmania.
Q 5 If you knew that the whales beached themselves because of human activities, would you
have taken the same decision in Q 1? Why? If you found that it was due to a genetic mutation in
the whale would that change your decision?

Task
What, if any, responsibility do we have to the environment and how do the problems we are
considering touch the area of sustainability. Discuss your response in a 2 mins podcast and
post.

Resources
Australia Curriculum - Sustainability
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Readings
Whale Rescue Dilemma (See Appendices)

Science in the Australian Curriculum
Science Inquiry Skills

Although this unit "Inquiring about the world' does not focus specifically on science in the
Australian Curriculum it is important, when you are navigating your way through the
activities and exercises, that you become aware of where the process of Inquiry sites within
the new curriculum. Science Inquiry Skills are one of the three key components of the
Content Structure of the Science Curriculum - the other two being Science Understanding
and Science as a Human Endeavour (see below for a more detailed description).
The following extract from the Australian Curriculum website will give you an overview of
the key features of the Science Curriculum
Science in the Australian Curriculum
The Australian Curriculum: Science provides opportunities for students to develop an
understanding of important science concepts and processes, the practices used to develop
scientific knowledge, of science’s contribution to our culture and society, and its applications
in our lives. The curriculum supports students to develop the scientific knowledge,
understandings and skills to make informed decisions about local, national and global issues
and to participate, if they so wish, in science-related careers.
The science curriculum promotes six overarching ideas that highlight certain common
approaches to a scientific view of the world and which can be applied to many of the areas of
science understanding. These overarching ideas are patterns, order and organisation; form
and function; stability and change; systems; scale and measurement; and matter and
energy.
Content Structure
Science has three interrelated strands: Science Understanding, Science as a Human
Endeavour and Science Inquiry Skills.
Together, the three strands of the science curriculum provide students with understanding,
knowledge and skills through which they can develop a scientific view of the world. Students
are challenged to explore science, its concepts, nature and uses through clearly described
inquiry processes.
Science Understanding

Science understanding is evident when a person selects and integrates appropriate science
knowledge to explain and predict phenomena, and applies that knowledge to new situations.
Science knowledge refers to facts, concepts, principles, laws, theories and models that have
been established by scientists over time.
The Science Understanding strand comprises four sub-strands. The content is described by
year level.
Biological sciences

The key concepts developed within this sub-strand are that: a diverse range of living things
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have evolved on Earth over hundreds of millions of years; living things are interdependent
and interact with each other and their environment; and the form and features of living things
are related to the functions that their body systems perform.
Chemical sciences

The key concepts developed within this sub-strand are that: the chemical and physical
properties of substances are determined by their structure at an atomic scale; and that
substances change and new substances are produced by rearranging atoms through atomic
interactions and energy transfer. In this sub-strand, students classify substances based on their
properties, such as solids, liquids and gases, or their composition, such as elements,
compounds and mixtures.
Earth and space sciences

The key concepts developed within this sub-strand are that: Earth is part of a solar system that
is part of a larger universe; and Earth is subject to change within and on its surface, over a
range of timescales as a result of natural processes and human use of resources. Through this
sub-strand, students view Earth as part of a solar system, which is part of a galaxy, which is
one of many in the universe and explore the immense scales associated with space.
Physical sciences

The two key concepts developed within this sub-strand are that: forces affect the behaviour
of objects; and that energy can be transferred and transformed from one form to another.
Through this sub-strand students gain an understanding of how an object’s motion (direction,
speed and acceleration) is influenced by a range of contact and non-contact forces such as
friction, magnetism, gravity and electrostatic forces. They develop an understanding of the
concept of energy and how energy transfer is associated with phenomena involving motion,
heat, sound, light and electricity. They appreciate that concepts of force, motion, matter and
energy apply to systems ranging in scale from atoms to the universe itself.
Science as a Human Endeavour

Through science, humans seek to improve their understanding and explanations of the natural
world. Science involves the construction of explanations based on evidence and science
knowledge can be changed as new evidence becomes available. Science influences society by
posing, and responding to, social and ethical questions, and scientific research is itself
influenced by the needs and priorities of society. This strand highlights the development of
science as a unique way of knowing and doing, and the role of science in contemporary
decision making and problem solving. It acknowledges that in making decisions about
science practices and applications, ethical and social implications must be taken into account.
This strand also recognises that science advances through the contributions of many different
people from different cultures and that there are many rewarding science-based career paths.
The content in the Science as a Human Endeavour strand is described in two-year bands.
There are two sub-strands of Science as a Human Endeavour. These are:
Nature and development of science: This sub-strand develops an appreciation of the unique
nature of science and scientific knowledge, including how current knowledge has developed
over time through the actions of many people.
Use and influence of science: This sub-strand explores how science knowledge and
applications affect peoples’ lives, including their work, and how science is influenced by
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society and can be used to inform decisions and actions.
Science Inquiry Skills

Science inquiry involves identifying and posing questions; planning, conducting and
reflecting on investigations; processing, analysing and interpreting evidence; and
communicating findings. This strand is concerned with evaluating claims, investigating ideas,
solving problems, drawing valid conclusions and developing evidence-based arguments.
Science investigations are activities in which ideas, predictions or hypotheses are tested and
conclusions are drawn in response to a question or problem. Investigations can involve a
range of activities, including experimental testing, field work, locating and using information
sources, conducting surveys, and using modelling and simulations. The choice of the
approach taken will depend on the context and subject of the investigation.
In science investigations, collection and analysis of data and evidence play a major role. This
can involve collecting or extracting information and reorganising data in the form of tables,
graphs, flow charts, diagrams, prose, keys, spreadsheets and databases.
The content in the Science Inquiry Skills strand is described in two-year bands. There are five
sub-strands of Science Inquiry Skills. These are:
Questioning and predicting: Identifying and constructing questions, proposing hypotheses
and suggesting possible outcomes.
Planning and conducting: Making decisions regarding how to investigate or solve a problem
and carrying out an investigation, including the collection of data.
Processing and analysing data and information: Representing data in meaningful and
useful ways; identifying trends, patterns and relationships in data, and using this evidence to
justify conclusions.
Evaluating: Considering the quality of available evidence and the merit or significance of a
claim, proposition or conclusion with reference to that evidence.
Communicating: Conveying information or ideas to others through appropriate
representations, text types and modes.
Content Descriptions

The Australian Curriculum: Science includes content descriptions at each year level. These
describe the knowledge, concepts, skills and processes that teachers are expected to teach and
students are expected to learn. However, they do not prescribe approaches to teaching.
Retrieved from: http://www.australiancurriculum.edu.au/Science/Content-structure
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Planning and Report Worksheet for Science Investigations
Phase one: Planning
What is the problem you are investigating?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
What do you know about this topic from personal experience and from science?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

What variables may affect the phenomenon you are investigating?
______________________________________________________________________
______________________________________________________________________
Which of the variables are you going to investigate as your independent variable? (This is the
variable you will change to see what affect it has on the dependent variable)
______________________________________________________________________

How will the independent variable be changed in the experiment?
______________________________________________________________________
______________________________________________________________________
What is the dependent variable? (ie the variable that responds to changes in the independent
variable)
______________________________________________________________________
How will you measure the dependent variable?
______________________________________________________________________
______________________________________________________________________
What question are you investigating?
______________________________________________________________________
OR
What hypothesis are you testing? State your hypothesis as a relationship between the
independent and dependent variables.
______________________________________________________________________

Predict what you think will happen. Explain why.
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

What variables are to be controlled (kept constant) to make it a fair test?
______________________________________________________________________
______________________________________________________________________

______________________________________________________________________
Describe your experimental set-up using a labelled diagram and explain how you will collect
your data.

______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Are there any special safety precautions?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Phase two: Experimenting
Carry out some preliminary trials. Were there any problems?

______________________________________________________________________
______________________________________________________________________
How did you modify your experiment to fix the problems?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
Collect and record the data you need to test your hypothesis. Draw your data table here.
Title

of
table:
________________________________________________________________

How did you make sure your data were accurate?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Phase three: Data analysis
What is the best way to present your data? Is it appropriate to draw a graph? What type of
graph is most suitable?
Remember to plot the independent variable on the horizontal axis.
Remember that the title of the graph should mention both the independent and dependent
variables.
Analyse your data. Are there any patterns or trends in your data? What is the relationship
between the variables you have investigated? Is the hypothesis supported by the data?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Using science concepts explain the patterns, trends or relationships you have identified in
your data. What is your conclusion?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

Draw your graph on this page.
Title: ______________________________________________________________________

Phase four: Evaluation
What were the main sources of experimental error? (sample size and selection, measurement
error, poor control of variables)
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
How confident are you with your conclusions? How much uncertainty/error is associated with
your data?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
How could the design of the experiment have been improved to reduce error?
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
What have you learned about the topic of your investigation? Was the outcome different from
your prediction? Explain.
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
What have you learned about the methods of investigating in science?
______________________________________________________________________

The Six Steps of Investigation
First
Write a short statement that makes clear what the problem is that you have to solve. Also
write a research question or hypothesis, and then a prediction. Give a reason for your
prediction.

Second
Write a plan which says what you intend doing. Say what you will do to make any tests fair.
Explain what measurements are to be made and how they will be made. Draw a diagram to
show how the equipment will be used to conduct your tests.

Third
Carry out your investigation and record all your observations and measurements. If you found
that you needed to change your plan write down what changes were made and why they were
necessary. Present your data in a way that helps show the patterns or trends in your results.

Fourth
Write a couple of paragraphs in response to these questions: What patterns or trends were
present in the results? How do you explain the patterns? What did your results show you
about the question or hypothesis that you were investigating?

Fifth
Write a paragraph that evaluates your investigation. Were your findings what you expected?
To what extent did you reduce the errors associated with measurements, controlling variables
and sampling?

Sixth
How will you communicate your findings? Who is the ‘audience’ for your report? What will
be the most appropriate means of communicating your findings – a formal written report, a
poster, an oral report, a PowerPoint presentation?
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What is science?
Science is a way of knowing, a method of learning about nature. Rooted in common sense, its
formal, systematic method is called scientific inquiry. In doing scientific inquiry, scientists
use a variety of empirical approaches, techniques, and procedures to collect
data from nature, examine and analyze that data, and construct knowledge based on it. This
knowledge relates to living organisms, non-living matter, energy, and events that occur
naturally. To analyse data scientists often, but not always, use mathematics, and they always
apply logical arguments that obey strict empirical standards and healthy skepticism.
The product of scientific inquiry is the body of scientific knowledge. Scientific knowledge
takes four forms: hypotheses, facts, laws, and theories. Hypotheses are tentative statements
about relationships between variables in nature. Long ago the rotation of the earth on its axis
and the orbit of the earth about the sun were hypotheses. Over time and through scientific
inquiry, hypotheses may become facts. Facts are scientific observations that have been tested
and confirmed repeatedly. The motion of a Foucault pendulum over a 24-hour period
documents Earth’s rotation on its axis. Observations of the shifting shadows of fixed objects
over several weeks and the changing hours of daylight and darkness over several months help
document Earth’s revolution around the sun. Earth’s rotation and orbit are now scientific
facts. Hypotheses may also become laws. Laws describe the behaviour of specific aspects of
nature under specific conditions. Boyle’s Law states that the volume (one property) of an
ideal gas varies inversely (behaviour) with its pressure (second property) when the
temperature (third property) of the gas is constant (specific condition). Theories are
explanations about broad aspects of nature that encompass large numbers of hypotheses,
facts, laws, and events. These explanations are well tested and valued for their ability
to predict new scientific knowledge and produce practical benefits. Evolutionary theory
explains the extensive diversity across living organisms as well as the underlying unity.
Scientists in health, agriculture, and industry use evolution to develop new medicines, hybrid
crops, and new molecules that enhance the performance of systems and benefit individuals
and societies.
Education in science serves three purposes. First, it prepares students to study science at
higher levels of education. Second, it prepares students to enter the workforce, pursue
occupations, and take up careers. Third, it prepares them to become more scientifically
literate citizens. The relative priority and alignment of these three purposes varies extensively

across countries and cultures. Regardless of the setting, a sound education in science
emphasizes that science is both a way of knowing and a body of knowledge; it also
emphasizes integrating scientific inquiry with scientific knowledge. Much is known about
teaching science effectively to learners of all ages. This knowledge comes from research and
scholarship conducted in both developed and developing countries.
References
1. Abell & Lederman, 2007; Bransford, Brown, & Cocking, 1999;
Gauch, 2003; National Academy of Sciences, 1998; National
Academy of Sciences & Institute of Medicine, 2007; National
Research Council, 1996, 2000, 2007; Project 2061, 1990.
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A Case Study of Memory Loss in Mice
by

Michael S. Hudecki
Department of Biological Sciences
University at Buffalo, State University of New York

Please read the following abstract of an article in the New York Times and prepare a short written response
addressing each of the following questions.

Memory Loss in Mice
A biochemist, Eugene Roberts, and researchers
at the City of Hope Medical Ctr. [in Duarte,
California] discovered that injecting fragments
of a brain protein called beta-amyloid into the
brains of mice caused the mammals to forget
chores they had just been taught [J.F.Flood et
al. Amnestic effects in mice of four synthetic
peptides homologous to amyloid B protein
from patients with Alzheimer disease. Proc.
Nat. Acad. Sci., USA, 88(8):3363-6, Apr 91].
“This is really the first correlation between the
presence of [beta-amyloid] in the brain and
the loss of memory,” said Rachael Neve, a
molecular biologist at U. California at Irvine.

Questions
1. State in concise terms the problem being investigated.
2. Describe the details if any of the experimental method apparently used in this study.
3. Describe any pertinent results that originate from the study.
4. What specific conclusions can you draw from this study?

Copyright held by the National Center for Case Study Teaching in Science, University at Buffalo, State University of New
York. Originally published August 7, 2001. Please see our usage guidelines, which outline our policy concerning permissible
reproduction of this work.
Photo ©Alex Ishchenko | Dreamstime.com.

CHILDBED FEVER
A Nineteenth-Century Mystery
by
Christa Colyer
School of Science
University of Ontario Institute of Technology

PART I
Ignaz Semmelweis, a young Hungarian doctor working
in the obstetrical ward of Vienna General Hospital in the
late 1840s, was dismayed at the high death rate among
his patients. He had noticed that nearly 20% of the
women under his and his colleagues' care in "Division I"
of the ward (that is, the division attended by physicians
and male medical students) died shortly after childbirth.
This phenomenon had come to be known as "childbed
fever." Alarmingly, Semmelweis noted that this death
rate was four to five times greater than that in "Division
II" of the ward (that is, the division attended by female
midwifery students).
Study Questions:
1. What were Semmelweis' initial observations?
2. What was the problem at hand?
3. What possible explanatory story might
Semmelweis come up with?
4. How might Semmelweis test his suspicions?

PART II
One day, Semmelweis and some of his colleagues were in the autopsy room performing autopsies as
they often did between deliveries. They were discussing their concerns about death rates from childbed
fever. One of Semmelweis' friends was distracted by the conversation, and he punctured his finger with
the scalpel. Days later, Semmelweis' friend became quite sick, showing symptoms not unlike those of
childbed fever. His friend's ultimate death strengthened Semmelweis' resolve to understand and prevent
childbed fever.
Study Questions:
1. What might Semmelweis now propose as an explanatory story?
2. How could Semmelweis test his new hypothesis?

PART III
In an effort to curtail the deaths in his ward due to childbed fever, Semmelweis instituted a strict
handwashing policy amongst his male medical students and physician colleagues in "Division I" of the
ward. Everyone was required to wash their hands with chlorinated lime water prior to attending patients.
Mortality rates immediately dropped from 18.3% to 1.3% and, in fact, not a single woman died from
childbirth between March and August of 1848 in Semmelweis' division.
Study Questions:
1. What conclusions can be drawn from Semmelweis' experiment?
2. How might Semmelweis revise his original hypothesis or his experiments to gain additional
information?

PART IV
Despite the dramatic reduction in the mortality rate in Semmelweis' ward, his colleagues and the greater
medical community greeted his findings with hostility or dismissal. Even after presenting his work on
childbed fever (more technically referred to as puerperal sepsis) to the Viennese Medical Society,
Semmelweis was not able to secure the teaching post he desired, and so he returned to Hungary. There,
he repeated his successful handwashing attack on childbed fever at the St. Rochus hospital in Pest. In
1860, Semmelweis finally published his principal work on the subject of puerperal sepsis but this, too,
was dismissed. It is believed that the years of controversy and repeated rejection of his work by the
medical community caused him to suffer a mental breakdown. Semmelweis died in 1865 in an Austrian
mental institution. Some believe that his own death was ironically caused by puerperal sepsis.
Study Questions
1. When presented with what appears to be unequivocal evidence in support of handwashing, why
might Semmelweis' colleagues have dismissed his ideas?
2. How else might Semmelweis have approached the problem of disseminating his research findings
in order to ensure their acceptance?
3. What, if any, role did serendipity play in Semmelweis' story of childbed fever?

Image Credit: Stamp of Ignaz Philipp Semmelweis, 1818-1865. Issued in Austria, 1965, on the 100th anniversary of
Semmelweis' death.
Date Posted: 12/08/99 nas. Revised 03/12/03.
Copyright © 2003 by the National Center for Case Study Teaching in Science. Please see our usage guidelines, which
outline our policy concerning permissible reproduction of this work.

Salem’s Secrets:
A Case Study on Hypothesis
Testing and Data Analysis*
Susan M. Nava-Whitehead
Sciences and Education Department
Becker College, Worcester, MA
Joan-Beth Gow
Biology Department
Anna Maria College, Paxton, MA
“Scientiﬁc research can reduce superstition by encouraging people to think and survey things in terms of cause and
eﬀect. Certain it is that a conviction, akin to religious feeling, of the rationality or intelligibility of the world lies
behind all scientiﬁc work of a higher order.” —Albert Einstein

Part I—Salem’s Secrets
There was a chill in the courtroom that day—a chill colder than could be explained by the unbearable winter.
It was a cold that started at the back of the neck and lodged deep in the spine. Something evil was afoot. The
question was: to whom did that evil belong?
“She killed Goodwife Betty’s baby. She killed it with those evil eyes. I saw her staring, as in a trance, at Betty’s
house at sunset one evening last week. Then her cow and her baby died. She also makes poisons in her house.
When people won’t take her poison, she sends her spirit to force them by choking them until they swallow it.
I see her spirit here now. It is over near Abby. Oh Abby, Abby! Be careful Abby, she has pins and they are red
hot! Stop her, she is pricking me! Help me, I am burning… Help me…”
The courtroom hummed with whispers as the spectators watched two young girls, Elisabeth, the speaker, and
Abby, her best friend, tear and swat at their arms and legs as if swarmed by invisible bees. Their contortions
escalated into convulsive ﬁts, which were so grotesque and violent that witnesses agreed they could not be
manufactured. Soon, as if on cue, other girls from Elisabeth and Abby’s circle of friends joined in. The girls
collapsed in exhaustion. Dr. William Griggs, the village physician, examined the girls and, ﬁnding only
bruised skin, made a diagnosis; “… the evil hand is upon them. They are bewitched.”
Hathorne, the magistrate, directed his attention to Sarah Good, the latest woman to be accused of witchcraft
in Salem in , and in a powerful voice demanded, “Goodwife, why do you torture these girls so?”
“Sir, I do not hurt them.”
“Who do you employ then to do it?”
*Note: This case study, although based on an actual historical event, is ﬁction. The dialogue is fabricated by the authors from
background material, in particular translations of actual depositions given in The Salem Witchcraft Papers (Boyer and Nissenbaum,
). Dr. William Griggs was the village physician at the time of the Salem witchcraft trials. Abigail Williams and Elisabeth Parris
were among the ﬁrst girls to be aﬀected; Sarah Good was one of the ﬁrst to be accused.

“I employ nobody.”
“And what say you of the poisons you keep at your home?”
“They are nothing more than good broths. When a child is to be born to a woman of this village… my
broths bring them ease.”
Figure 1. Salem Village 1692.

“What evil spirit directs you in the making of these broths?”
“No spirit good sir, I am falsely accused.”
Scenes such as this were not uncommon in New England in the early colonial days. It is commonly known
by most that a group of young girls in Salem were the initial catalyst that led to accusations of witchcraft
against more than  people. These accusations resulted in the execution of twenty persons.
Question 1—What do you think caused the girls to behave this way?
To understand the phenomena at Salem, it is necessary to understand the culture and community of the
time. In general, colonial life was hard. Rich farmable land was scarce, and any food it yielded was a result
of strenuous physical labor. Diet was poor, deﬁcient in essential nutrients and vitamins. Often colonists,

“Salem’s Secrets” by Nava-Whitehead and Gow

Page 

including children of a young age, worked from ﬁrst light until after dark. Disease and death rates were high.
It was not uncommon for families to suﬀer the loss of children.
The year spanning – was not a particularly good one for the Puritans, with an unusually severe
winter and a rainy spring. As a result, the harvest that year was extremely poor. In addition, many families
escaping the Indian Wars of Maine had moved into the northwest side of the area known as Salem, an
area called Salem Village. This situation forced farmers to “utilize their swampy, sandy, marginalized land”
(Matossian, ) for rye production and families in the community to share crops. Compounding these ills
was a perceived imbalance in social status and power, the “haves” of the east side of town in direct conﬂict
with the “have nots” of the village. Salem Villagers were disgruntled by having to pay taxes to, and serve in,
the militia for Salem Town without receiving any direct beneﬁt, namely a church of their own. In addition,
Salem was factionalized by the leadership of two strong men (Parris of the Village and Proctor of the Town).
The original/core group of girl accusers was kin of the Parris family.
Puritans were fervently religious and believed strongly in the balance of good and evil. To them, the devil
was “a physical being who was incarnate, there to seduce them from the path of righteousness” (Woolf,
). When the march to the gallows struck Salem in , it struck hard. The litmus test for bewitching
was not substantial: the mere accusation of spectral evidence (victims would “see” a witch touching,
pinching, or otherwise harming them) was suﬃcient to place a citizen in jeopardy. Likewise, one could earn
the title of witch when the “passing by” of a person’s house or the “ﬁxing a gaze” upon someone correlated
with the stillbirth of a child or the death of a domestic animal.
Question 2—In the opening passage, what “evidence” did the girls provide for the presence of witches/
witchcraft? (List this information in column 1 of your data management sheet—see page 10.)
Question 3—Assume you are living in Salem in 1692. Develop a hypothesis based on your observations.
(Remember that a hypothesis must be supported by scientiﬁc evidence.)
Question 4—Reﬂect for a moment on this concept of evidence. How do we deﬁne “evidence” in science?
Does the girls’ evidence pass scientiﬁc muster?
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Part II—Mass Hysteria
For over  years, the prevailing belief was that the Salem tragedy was a direct result of mass hysteria, a
condition in which a large group of people exhibit similar physical or emotional symptoms not attributable
to any physiological cause. The Salem girls as a group experienced an array of unusual symptoms. In the
absence of a clear medical diagnosis, and based on the limited technology of the time, the doctor who
examined the girls pronounced them bewitched.
Collective human behaviors, however, are more common than many people realize. Some are simply the
crazes and fads that often aﬀect teenagers and other social groups. Others are bizarre, such as the example
given below that occurred in the early s when several students were convinced their penises were
shrinking. Many, though, are less innocuous, and involve severe symptoms of illness. Below are listed some
selected examples of mass hysteria events spanning several centuries.
Table 1. Mass Hysteria Events Throughout History
Mass Hysteria Event Year
Southern Europe,
s–
especially Italy
s
Milan, Italy



Szechwan, China
Newark, NJ




West Bank, Jordan



Kosovo, Yugoslavia



Central Falls, RI



A large midwestern
university



McMinnville, TN



Amman, Jordan



Summary
Symptoms such as headache, giddiness, twitching, and delusions,
culminating in frenzied dancing, in response to perceived bites from a
tarantula spider.
Several people executed after being pronounced guilty of spreading
poison throughout the city in cooperation with the Devil.
Twenty students convinced their penises were shrinking.
Following radio broadcast of H.G. Wells’ War of the Worlds dramatizing a
“gas raid from Mars,” mass panic occurred, involving thousands. Several
were treated at hospitals for shock.
Nearly a thousand people, mostly young females, aﬄicted with headaches,
fainting, dizziness, and abdominal pain. Initially attributed to poison gas.
Outbreak of ﬂu-like symptoms such as headache, dizziness, and
respiratory distress that persisted for weeks among thousands of mostly
adolescent Albanians. Initially attributed to poisoning by Serbs.
Seventeen middle school students and four teachers with rapid onset
of an array of symptoms such as dizziness, pain, vomiting, and chills.
Initially attributed to chemical spill or toxic gas exposure.
Sixty-nine college students and workers treated for shortness of breath,
eye and skin irritation, and general feelings of illness. Initially attributed
to a dusty substance in the snack bar.
Following a “gasoline-like” smell detected in a classroom, close to 
students and staﬀ members experienced headache, nausea, shortness of
breath, and dizziness.
More than  students in st–th grades displayed a variety of
symptoms such as fever, chest tightness, chills, and feeling faint following
tetanus-diphtheria vaccination.

Have your thoughts regarding the events at Salem changed after examining this table? Reﬂect on the
observations you listed in column  of your data management sheet.
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Part III—Ergot: A Toxic Fungus
Question 1: Incidences of witchcraft are found universally among cultures of this time, but none had
the devastating impact that Salem’s had. What other factors may have contributed to the phenomena
at Salem?
Claviceps purpurea is the genus and species name of a toxic fungus that grows
as a parasite on many grains, particularly rye. In rainy, wet weather, all plants
become more vulnerable to fungi. Because rye also grows best in damp
weather, it is particularly susceptible to fungal growth. When Claviceps spores
germinate, they form distinct dark, hard structures called sclerotia. These
sclerotia are commonly known as ergots, thus the term ergot poisoning, or
ergotism. Within the ergots is produced a poisonous brew of fungal toxins,
ingestion of which can lead to severe illness or death. Ergot fungal toxins are
particularly stable and are not destroyed by boiling or baking (Bennett and
Bentley, ).

Figure 2. Ergot

Two forms of ergotism exist: convulsive and gangrenous. The convulsive
form has the greatest eﬀect on the central nervous system, leading to seizures,
insomnia, and insatiable appetite. In the gangrenous form, blood ﬂow to the
extremities is restricted; in severe cases, this can lead to blackened tissue and
subsequent bloodless limb loss. Either form of ergotism may cause tingling,
itching, alternating perception of hot and cold temperatures, hallucinations,
perceptual disturbances, and gastrointestinal upset. In addition, people
under the inﬂuence of ergot derivatives are known to be highly suggestible
(Matossian, ).
Several factors play a role in the severity of ergot poisoning. Nutritional status, in particular vitamin A
deﬁciency, is one such factor (Bennett and Klich, ). Age and sex play a role as well, and ergotism
preferentially seems to aﬀect teenage females (Bennett and Bentley, ; Caporael, ). Humans are not
the only species to suﬀer from ergot poisoning; farm animals can be aﬀected as well.
Question 2: In column 2 of your data management sheet, list evidence that the events at Salem could
have been caused by ergot poisoning.
Question 3: After reading Parts II and III of the case study, develop a second hypothesis, diﬀerent from
your ﬁrst, explaining the events at Salem. Record this hypothesis on your data management sheet.
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Part IV—Data Interpretation
Table  is extracted from an article written by Nicholas Spanos and Jack Gottlieb on ergotsim and the Salem
witch trials published in  in Science. Spanos and Gottleib collected these data by reading through
the Records of Salem Witchcraft (Woodward, ; reprinted ) and making note of the frequency of
symptoms suﬀered by witnesses outside of the original group of girls. At the time of the trials, the adult
population of Salem was estimated to be  persons; no estimate is provided for the child population.
Table 2. Frequency of Symptoms
Reported
suﬀerers

RSW
vol. & page*

A

B

C

D

E

F

G

H

I

J

K

L

M N

O

P

Total

W. Allan
J. Bayley

I:
I:

















































1
4

S. Bittford
A. Booth
J. Childen
G. Cory
J. Doritch

I:
II:
I:
I:
I: and
II:
II:
I:
I:
I:
I:
**
I:
I:
I:
I:
II:
II:
II:
II:















































?

















































2
1
1
1
3

B. Gould
               
3
J. Holton
       ?        
1
J. Hughes
               
1
J. Indian
               
2
T. Indian
       ?        
2
E. Keysar**
         ?      
2
M. Pope
               
3
H. Putnam
               
1
J. Putnam
       ?        
1
W. Putnam
               
1
D. Wilkins
               
2
R. Wilkins
       ?        
3
S. Wilkins
               
3
E. Woodwell
               
1
Total
               
39
Key: Symptoms of witnesses (other than the aﬄicted girls) who testiﬁed against the accused witches.
A: vomiting; B: diarrhea; C: livid skin; D: permanent contractures; E: pain in extremities; F: death; G: temporary
muscle stiﬀness; H: convulsions; I: ravenous appetite; J: perceptual disturbances (not including apparitions);
K: apparitions; L: sensations of hot and cold; M: skin sensations (biting and pinching); N: stomach pain; O:
choking sensations; P: temporary inability to speak; : symptom reported; : symptom not reported; ?: symptom
questionable.
* RSW stands for Records of Salem Witchcraft, compiled by W.E. Woodward in –.
** This testimony comes from Boyer & Nissenbaum, , page .
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After reviewing the data from this table, use the information it provides and your observations from columns
 and  of your data management sheet to prepare an argument in support of either one of your hypotheses.
Consider the following questions:
Question 1: What do the data suggest? What symptoms are reported in high frequency? In low frequency?
What patterns exist?
Question 2: Consider who was aﬄicted; what other health information was reported in 1692?
Question 3: Why did the idea of witchcraft occur here and now? Is this situation unique?
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Part V—The Societal Frame: What Is the Secret of Salem?
Review the data from your data management sheet and then answer the questions below.
Question 1. In the beginning, did you think the girls at Salem were bewitched? Faking?
Question 2. Did your group acknowledge or dismiss the idea of mass hysteria with respect to Salem? Did
you consider the social dynamics of the time in your thinking?
Question 3. After reading about the events of Salem, did your thinking about what happened change as
you progressed through the material? How many times?
Question 4. If a similar set of symptoms was presented today, do you think the result would be similar?
Why or why not? In other words, how does who we are and what we know change what we interpret?
Question 5. What questions still remain? What other information would help you decide what
happened at Salem?

“Salem’s Secrets” by Nava-Whitehead and Gow

Page 

Part VI—Classroom Extension
Further research one of these topic extensions to this case study. Choose one of the following questions to
develop into a one-page essay.
Question 1. How does public health reporting diﬀer today from reporting in the 1600s?
Question 2. What can you infer from this case about the general safety of the world’s food supply in 1692? Today?
Question 3. If you, as a member of the Department of Public Health, were informed of a group of people
seemingly aﬄicted with a similar set of symptoms, what might be your initial thoughts and course of action?
Question 4. Ergot derivatives today are used to treat migraine headaches and alleviate bleeding after
childbirth. How is it possible that such toxic substances can have therapeutic uses?
Question 5. If Salem had had a well-deﬁned government in 1692, would the “March to the Witches Gallows”
have occurred?
Question 6. The testimony of the children at Salem was accepted without question. Children often make
accusations of many kinds of abuse by adults. Should such accusations be accepted at face value?
Question 7. Will it ever be possible to prove that the events at Salem were attributable to a speciﬁc cause?
Why or why not? What is the diﬀerence between correlation and causation?

Further Reading
Boyer, P., and Nissenbaum, S. (eds.) () Salem Village Witchcraft: A Documentary Record of Local Conﬂict
in Colonial New England. Belmont, CA: Wadsworth.
Boyer, P., and Nissenbaum, S. (eds.) () The Salem Witchcraft Papers. Verbatim Transcriptions of the Court Records.
New York: De Capo Press. Available online at http://etext.virginia.edu/salem/witchcraft/texts/transcripts.html
Caporael, L.R. (). Ergotism: The Satan loosed in Salem. Science :–.
Goldfrank, L.R., et al. () Goldfrank’s Toxicologic Emergencies. New York: McGraw-Hill Companies.
Matossian, M.K. (). Ergot and the Salem witch aﬀair. American Scientist :–.
Spanos, N.P., and Gottlieb, J. (). Ergotism and the Salem witch trials. Science :–.
Woodward, W.E. (comp.) (, ) Records of Salem Witchcraft, Copied from the Original Documents. 
vols. New York: Da Capo Press.
Woolf, A. (). Witchcraft or mycotoxin? The Salem witch trials. Journal of Toxicology—Clinical Toxicology
.:–.

Image credits: Woodcut in title block from a pamphlet for the witchcraft trial in  of a Scottish woman, Agnes Sampson. Map
in Figure  by W.P. Upham, . Illustration detail in Figure  from a plate in Medizinal-Pﬂanzen in naturgetreuen Abbildungen
mit kurz erläuterndem Texte by H. A. Köhler (), Gera-Untermhaus.
Case copyright © by the National Center for Case Study Teaching in Science. Originally published December ,  at
http://www.sciencecases.org/salem_secrets/case.asp. Please see our usage guidelines, which outline our policy concerning
permissible reproduction of this work.
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Data Management Sheet
Observations from Part I:

Observations from Part III:

Data Interpretation:

Hypothesis :

Hypothesis :

Final Conclusion:

“Salem’s Secrets” by Nava-Whitehead and Gow

Page 

An Antipodal Mystery
by
Clyde Freeman Herreid
Department of Biological Sciences
University at Buﬀalo, State University of New York

Part I—A Letter from Down Under
… The river was very still on the curve where the eucalyptus dips
towards the water. The light shaded near late afternoon and
twilight would soon darken the outline of the wooded bank and
the ﬂat landscape stretching to the horizon. Bubbles broke the
surface of the water. A small brown head, its sleek furred cap
glided silently in the river’s ﬂow.
As you can imagine, my esteemed colleague, I wondered what the aborigine was spearing in the lake near
Hawkesbury River close to Sidney. I soon discovered the answer. A small creature fought for its life with such force
that it caught its assailant with its spur and seemed to cause much pain. I have taken the liberty of posting the skin
of the specimen to you for your study. It is preserved in a keg of spirits with another antipodal beast. I send it to
your keeping for the Literary and Philosophical Society of Newcastle-upon-Tyne.
I remain your servant,
John Hunter, Governor
New South Wales
Thomas Bewick looked at the letter closely, pursing his lips. He gingerly unfolded the pages of notes and
drawings that spilled from the governor’s weathered envelope, addressed months ago. With each passing
moment his surprise increased; this creature was nothing like any animal seen before. What would he write
in his next edition of General History of Quadrupeds? What could he possibly say? The animal seemed hardly
real. Is it a mammal, he mused, or …?

Questions
Hunter’s drawings seem unbelievable. Bewick suspects that this is not going to be a simple problem in
classiﬁcation. How should he decide what the creature is? What is the deﬁnition of a mammal?
. Predict in as much detail as possible exactly what features a mammal would be expected to
have. Consider the external as well as internal anatomy of a mammal; list all characteristics you
can think of. Indicate which of these are exclusive to mammals and which are found in other
vertebrates such as ﬁsh, amphibians, reptiles, and birds.
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Part II—”A Three-Fold Nature”
“The cask containing the two specimens … reached Newcastle late in , transported from quayside to the
Society’s rooms by a woman servant. She carried it on her head and, by mischance, the bottom of the cask
gave way, dousing her with pungent spirits. But her dismay was reportedly the greater when, looking down,
she saw not only the small chunky wombat, but the remains of ‘a strange creature, half bird, half beast, lying
at her feet’.”
Thomas Bewick was to write that the creature “seems to be an animal sui generis; it appears to possess a
three-fold nature, that of a ﬁsh, a bird and a quadruped, and is related to nothing that we have hitherto
seen.” It was about the size of a “small cat,” with a bill “very similar to that of a duck,” with four short legs,
“the forelegs … shorter than those of the hind and their webs spread considerably beyond the claws.” Bewick
concluded “it resisted any attempt to arrange it in any of the useful modes of classiﬁcation.”
Dr. George Shaw, a Fellow of the Royal Society and Assistant Keeper of Natural History at the British
Museum, also obtained a dried specimen in . He wondered if it was a hoax, an animal stitched together
by clever Chinese or Japanese taxidermists to deceive credulous sailors. He wrote: “I almost doubted the
testimony of my own eyes.” But he could not ﬁnd any deception.
A specimen found its way into the hands of Professor Johann Blumenbach, a comparative anatomist of
the University of Göttingen in Germany, who christened the creature Ornithorynchus paradoxous. “In
every way a paradox,” the Australian arrival raised a host of questions. Was it, as its brown fur suggested, a
mammal? But where were its mammary glands? Where were its nipples? And how could a young animal
suckle with that duckbill? Or was it a reptile, among which amphibians were then grouped, for this beast
was surely aquatic? Or perhaps it was avian; its duck-like bill indicated an aﬃnity with warm-blooded birds.
Blumenbach was stumped. Ornithorynchus did not fall into any of the major classes of vertebrates—the
mammals, ﬁsh, birds, and reptiles.
Other specimens were forwarded to the distinguished British anatomist Everard Home at the Royal College
of Surgeons in London. The mystery deepened, for Home made a series of wonderful discoveries published
in papers written from –. The “duck-bill” beak was an exploratory organ for touching and tasting
the muddy bottom of rivers as the animal searched for its food, small crustaceans and insects underwater.
The beak was not hard like that of a bird; rather it was moist, soft, and highly ﬂexible. And the reproductive
organs were a surprise!

Quesitons
. Examine the drawings on the following page showing the reproductive systems of animals. What
conclusions do you make? Which seems most similar to Ornithorynchus?
. What does this imply about evolution?
. Think about how young Ornithorynchus are likely born. Are they born alive (viviparous)? Or are
eggs laid, incubated, and then hatched (oviparous)? Or are eggs produced and then held in the
body for a time and then hatched inside the mother as in some snakes (ovoviviparous)? All of
these opinions of Ornithorynchus development were ﬁrmly held by some of the great anatomists of
the time.
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Figure 1: The female reproductive systems of six vertebrates. All dissections are depicted as if the animal
were lying on its back facing the reader. All of the systems are bilaterally symmetrical except for the bird
where only the left side is functional; the right side degenerates during development. The term cloaca is
used for a chamber that receives the contents of the digestive, urinary, and reproductive tracts. The term
urogenital sinus is a chamber that receives products from the urinary and reproductive tracts; the digestive
tract empties separately via its own ﬁnal chamber, the rectum (not shown). (Redrawn by Jim Stamos, based
on various sources).
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Part III—“This Highly Interesting Novelty”
Sir Joseph Banks, who had traveled with James Cook on his ﬁrst voyage, ventured this in : “Our
greatest want here is to be acquainted with the manner in which the Duck Bill Animal [platypus] and the
Porcupine Ant Eater [spiny echidna] which I think is of the same genus, breed, their internal structure is
so very similar to that of Birds that I do not think it impossible that they should lay their Eggs or at least as
Snakes and some Fish do Hatch Eggs in their Bellies.”
The French zoologist Etienne Geoﬀroy St-Hilaire, reading Home’s anatomical works, declared that both
animals should be placed in a new animal class, the Monotremata, which means “one hole” to designate
that the animal has a single opening (cloaca) through which it eliminates digestive and urinary wastes
and reproductive products (eggs or sperm). There were three central questions about Ornithorhyncus that
emerged from the foment of the times:
. First, how can we ﬁt this strange beast into the classiﬁcation and taxonomic schemes that had
worked so well in the Northern Hemisphere?
. Second, how does Ornithorhyncus produce its young?
. Third, what relevance does this anomalous animal have for the old ideas of a perfectly created world? What is
the relevance of Ornithorhyncus to the idea of evolution, which was beginning to be whispered about?

Questions
Let’s consider the ﬁrst question: how should we classify such an animal? Classiﬁcation experts like John Ray
and Carl von Linneaus said that reproduction was the essential criterion for classiﬁcation. Linneaus set the
presence of mammary glands and the suckling of the young as the deﬁning characteristic for the class of
animals he named “Mammalia.” He said that warm-blooded quadrupeds (four-legged beasts) with a four
chambered heart and double circulation were viviparous and mammiferous.
Henri Marie Ducrotay de Blainville said mammals could be arranged by decreasing complexity from the
primates down through the marsupials to the monotremes. He was the ﬁrst to note many resemblances
between platypus and echidna and the marsupials. He said that regardless of the apparent absence of
mammary glands, the monotremes belonged as mammals in their own distinct order, Ornithodelphia.
France’s scientiﬁc leader, Georges Cuvier, pronounced they were indeed mammals but put the monotremes
squarely in the order Edentata that included other toothless mammals, anteaters, and sloths.
Not everyone agreed. Although the platypus was warm-blooded, had a four chambered heart, and double
circulation (two diﬀerent sides of the heart, one pumping to the lung and the other to the rest of the body),
birds had these traits too. And it had a duck-like bill! Everard Home reported in his  paper that the
structure of the ear and shoulder girdle combined both mammalian and reptilian features. The presence
of a cloaca was clearly a reptilian and avian feature. The absence of a well-formed uterus and the apparent
absence of nipples persuaded Home that the “duck-billed mole” was related to ovoviviparous reptiles.
Lamarck said the platypus and echidna could not be mammals without mammary glands. He placed them
in a separate vertebrate class called Prototheria.
. So what is the best solution for classiﬁcation for this unusual animal? If birds, reptiles, ﬁshes, and
mammals are placed in separate classes, where should an animal like Ornithoryncus be classiﬁed?
. What is the best logic for predicting how the young platypus is born: viviparous, oviparous, or
ovoviviparous? What seems to be the most probable reproductive method and least probable
method? And once produced, how will they be fed?
“An Antipodal Mystery” by Clyde Freeman Herreid

Page 4

Part IV—Solving the Mystery
How do platypuses reproduce? In , there was a breakthrough when Patrick Hill, a naval surgeon, wrote
to the Linnean Society saying he had talked to an Aboriginal elder and “it is a fact well known to them
that the animal lays two eggs about the size, shape, and colour of those of a hen; that the female sits for a
considerable time on the eggs in a nest which is always found among the reeds on the surface of the water.”
More importantly, in , the German anatomist Johann Meckel reported that he had found mammary
glands in the platypus! They appeared primitive and opened directly onto the skin without any sign of
nipples. Monotremes would represent a transitional form between reptiles and mammals. Geoﬀrey St-Hilaire
rejected this view and said the structures described by Meckel couldn’t be mammary glands because the
absence of nipples would make feeding diﬃcult with a duck-bill. He stated that the monotremes belonged
in their own separate mammalian order, Monotremata.
In , the Hon. Lieutenant Maule, who was stationed in Australia, reported to the Zoological Society of
London that he found several nests of platypus with fragments of eggshell and in one nest he found a female
and two young. Two weeks later when the female died, he reported: “on skinning her while yet warm, it was
observed that milk oozed through the fur on her stomach.” No teats were visible.
Richard Owen, England’s great comparative anatomist, received two baby platypuses from Lieutenant Maule
in New South Wales, and determined in  that the suckling infant’s mouth was designed to take milk in
the normal manner. In addition, he clearly determined that there was milk in the babies’ stomachs.
Not until  was the picture clear. The Scottish embryologist, William Caldwell of Cambridge, arrived in
Australia and gathered a group of  aborigines to search the Burnett River for the elusive monotremes. He
shot a platypus in the act of laying eggs: her ﬁrst egg had been laid and her second was still in the partially
dilated mouth of the uterus. He claimed victory. Platypus was oviparous. It laid soft-shelled eggs with large
yolks that were gradually absorbed by the growing young, just as in birds and reptiles! In contrast to birds,
where the calciﬁed egg does not change in shape or size, the monotreme egg increases in size during its time
in the uterus. Its ﬂexible shell is stretched as nutrients are absorbed from the uterus.

Question
. Do these discoveries change your view about how to classify the platypus?
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Part V—The Big Picture
Turning to the third question: How does the platypus ﬁt into the doctrine of creation? Recall that Aristotle’s
view of a ladder of nature (Scala Naturae, or Great Chain of Being) suggested that species were ﬁxed in a
position on an ascending ladder leading toward humans at the top. This may have made sense a couple of
thousand years ago when only  species of animals were known, but as new species were discovered, with
more and more intermediate or hybrid characteristics, this static view of the world seemed less and less
tenable. For example, in  French expeditions returned from Australia with , animal specimens;
, were species new to science. Trumpeted France’s scientiﬁc leader, Georges Cuvier, they had collected:
“more new creatures than all traveling naturalists of recent times put together.” Robert Brown, who traveled
extensively around Australia’s coasts, collected  genera and , species of plants in , all new
to science. Classiﬁcation schemes that had been created for Europe were completely inadequate for the
Southern Hemisphere. The platypus was only one of a thousand new riddles, albeit the most spectacular.
Another problem was emerging: fossils were being discovered everywhere. Many were of animals no longer
alive. This suggested that some species had gone extinct. If extinction occurred, then what had happened to
the ladder of life? Are there even more missing steps?
How do scientists solve this problem? Throw out the Scala Naturae concept altogether? France’s Georges
Cuvier did. He argued physical catastrophes periodically occur and destroy organisms. They were replaced
after each disaster by successive creations of new and more complex unrelated species. Revise it? Cuvier’s
compatriot, Jean-Baptiste de Lamarck, believed there was a linear order of living organisms from simple to
complex, and that organisms could move upward on the ladder via evolution—rather like an escalator. He
thought extinction was impossible.

Questions
. When Charles Darwin came into the picture, he had his own view of the Scala Naturae. What do
you think was his view?
. Today, we have DNA evidence as well as that from the traditional ﬁelds of comparative anatomy
and physiology. Based upon everything that you know, draw a likely phylogenic tree showing the
evolutionary relationships among birds, marsupials, monotremes, placental mammals, and reptiles.

Image Credit: Ferdinand Bauer, Natural History Museum, London.
Copyright ©  by the National Center for Case Study Teaching in Science.
Originally published // at http://www.sciencecases.org/antipodal_mystery/antipodal_mystery.asp
Please see our usage guidelines, which outline our policy concerning permissible reproduction of this work.
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Effective Questioning
to promote learning, foster higher
order thinking, develop imagination,
creative thinking and pitch challenge
Asking questions is natural and intuitive. As teachers, we ask questions as soon as the lesson starts
and continue until the end. Asking questions forms part of any lesson because it invites the student to
think, and even within a ‘lecture’ style lesson, rhetorical questions are used to invite silent agreement or
begin the organisation of ideas to present a response.
Teachers use questions to engage the students and sustain an ‘active’ style to the learning. The teacher
also uses questions as part of the assessment of learning in order to determine how they best structure,
organise and present new learning. However, research has found that most teachers only wait
0.7seconds for an answer. Developing questioning, requires much greater emphasis on the time
provided for students to think individually, collaboratively and deeply to develop and share better
answers.
Historically, teachers have asked questions to check what has been learnt and understood, to help them
gauge whether to further review previous learning, increase or decrease the challenge, and assess
whether students are ready to move forward and learn new information. This can be structured as a
simple ‘teacher versus the class’ approach, where the teacher asks a question and accepts an answer
from a volunteer, or selects/conscripts a student to answer. These approaches are implicit in any
pedagogy, but teachers need a range of questioning strategies to address different learning needs and
situations.
This paper encourages teachers to plan their questioning approaches, prepare the most important
questions and pre-determine the level of challenge they wish to set.

How and why do we use Questions in the classroom?
Teachers use questioning as part of their teaching for many reasons, but often to:

n maintain the flow of the learning within the lesson
n engage students with the learning
n assess what has been learned
n check that what has been learnt is understood and can be used
n test student memory and comprehension
n seek the views and opinions of pupils
n provide an opportunity for pupils to share their opinions/views and seek responses from their peers
n encourage creative thought and imaginative or innovative thinking
n foster speculation, hypothesis and idea/opinion forming
n create a sense of shared learning and avoid the feel of a ‘lecture’
n challenge the level of thinking and possibly mark a change to a higher order of thinking
n model higher order thinking using examples and building on the responses of students
All the following examples and many others are useful and necessary within different classroom
situations. They help teachers move students from simple responses, to engage in more developed
complex thinking. This helps them apply what they understand, to bridge learning from other times and
different situations, to think more actively in lessons and learn from each other’s answers.

Questioning approaches e.g.
‘thinking time’, the ‘no hands’
rule and ‘phone a friend’
Strategy/approach

Process

Gains and benefits

Thinking Time:
Consciously waiting for a pupil
or class to think through an
answer (before you break the
silence) e.g 15-30secs
No Hands Questioning:
Using the ‘no hands up’ rule

Provide time between setting the
question and requiring an answer.
Sometimes alerting pupils to the
approach and the time available to
develop an answer.
Pupils aware that those required to
give an answer, will be selected by
the teacher. Teachers alert them to
this as questions are asked.
Linked to ‘thinking time’.

Prompts depth of thought and increases
levels of challenge. Ensures all pupils
have a view or opinion to share before
an answer is sought.

Basketball questioning:
Move questions and
discussions between pupils

Teacher establishes movement of
ideas and responses around the
class. Builds on other pupils’ ideas
and comments. Accepts ‘half-formed’
ideas. NB not ‘ping-pong’

Engages more pupils. Stops teacher
being focus for all questioning.
Develops connected thinking and
development of ideas.

Conscripts and Volunteers:
Using a planned mix of
‘conscripts’ and ‘volunteers’

Teacher selects answers from those
who volunteer an answer and an
equal amount of those who do not.

Enhances engagement and challenge
for all.

Phone a friend:
Removes stress to enable
those who cannot answer to
participate

Those who cannot answer are
allowed to nominate a fellow pupil to
suggest an answer on their behalf,
but they still have to provide their own
answer, perhaps building on this.

Encourages whole-class listening and
participation. Removes stress and
builds self-esteem.

Hot-seating:

A pupil is placed in the ‘hot-seat’ to
take several questions from the class
and teacher.

Encourages listening for detail and
provides challenge

Mantle of the expert:

A wears the cloak of the expert to
answer questions from the class.

Builds self-esteem through opportunity
to share detailed knowledge.

Preview:
Previewing questions in
advance

Questions are shared/displayed
before being asked, or the start of the
lesson.

Signals the big concepts and learning of
the lesson

Pair rehearsal:
of an answer or a question

Pairs of pupils are able to discuss
and agree responses to questions
together.

Encourages interaction, engagement
and depth

Eavesdropping:
Deploying specific targeted
questions

Listen in to group discussions and
target specific questions to groups
and individuals.

Facilitates informed differentiation.

5Ws:
Modeling simple exploratory
questions to gather information

Teacher models the use of Who,
What, Where, When and Why to set
out a simple information gathering
response based on the information
provided.

Encourages students to rehearse
enquiry and comprehension, can extend
into reasoning and hypothesis.
Creates an inquisitive disposition and a
thinking/self reflective approach to
learning.

Ref. AfL publication - Working
Inside the Black Box.

Improves engagement and challenges
all pupils to think. When linked to
Thinking Time, pupils share ideas and
‘position’ their own views in relation to
others.

Strategy/approach

Process

Gains and benefits

High Challenge:
Phrasing questions carefully to
concentrate on Bloom’s
Taxonomy higher challenge
areas

Questions must be pre-planned, as
very difficult to invent during a lesson.
Focus questions to address analysis,
synthesis, evaluation and creativity,
based on Bloom’s Taxonomy.

Provides high challenge thinking,
requiring more careful thought, perhaps
collaborative thinking and certainly
longer more detailed answers. For
Able, Gifted and Talented.

Staging or sequencing:
questions with increasing
levels of challenge

Increasing the level of challenge with
each question, moving from low to
higher-order questioning

Helps pupils to recognise the range of
possible responses and to select
appropriately.

Big questions:
The setting of a substantial
and thought provoking
question

Big questions cannot be easily
answered by students when the
question is posed. They are often set
at the beginning of the lesson and can
only be answered by the end of the
lesson, using all of the thinking based
on all of the contributions to the
lesson.

These questions develop deeper and
more profound thinking. Big Questions
are often moral issues or speculative
questions such as, Where are we from?
How big is the universe? What is the
meaning of life?

Focus questioning:
This will help students to
answer bigger questions

When students struggle to answer
bigger or more complex questioning,
the teacher can model or lead the
thinking by asking Focus questions to
lead the student through the steps of
the thinking.

Develops confidence and the
sequencing of small steps in thinking
and response. Allows students to
reveal the stages in their thinking.

Fat questions:
Seeking a minimum answer

Pupils are not allowed to answer a
question using less than e.g. 15
words or using a particular word or
phrase. They must give an extended
answer or make a complete
sentence/phrase.

Develops speaking and reasoning skills,
the correct use of critical and technical
language .

Skinny questions
A traditional approach to Q&A
asking everyday questions with
a fixed or specific answer

In its simplest form, students can
answer yes or no to a skinny
question, or give a number or
knowledge based response.

Challenge level is low in skinny
questions that do not seek and
extended answer or reasons for the
answer. Mostly knowledge and
comprehension based. Does not
develop thinking or reasoning.

Signal questions:

Providing signals to pupils about the
kind of answer that would best fit the
question being asked. Teacher
responds to pupils attempt to answer,
by signaling and guiding the answers.

The essence of purposeful questioning,
moving pupils from existing knowledge
or experience (often unsorted or
unordered knowledge) to organized
understanding, where patterns and
meaning have been established.

Seek a partial answer:

In the context of asking difficult whole
class questions, deliberately ask a
pupil who will provide only a partly
formed answer, to promote collective
engagement.

Excellent for building understanding
from pupil-based language. Can be
used to lead into ‘Basketball
questioning’. Develops self-esteem.

They require extended answers and
usually rely on collaborative thinking
and a personal interpretation of the
information provided.

Many of these teaching approaches are taken from the National Secondary Strategy for School Improvement
‘Questioning’ Unit of the Foundation Strand materials and Assessment, or from the work of members of the AfL
team including Paul Black and Christine Harrison.

5xWs
The Five Ws, also known as the Five Ws (and one H), is a concept used in journalism, research and in
Police Investigations that most people consider to be fundamental when examining any new learning
sitation. It is a formula for getting the "full" story on something. The maxim of the Five Ws (and one H) is
that in order for an analysis of basic facts and information to be considered complete it must answer a
checklist of six questions, each of which comprises an interrogative word:

Who?

What?

Why?

Where?

When?

& How?

The principle underlying the maxim is that each question should elicit a factual answer — facts that it is
necessary to include for a report to be considered complete. Importantly, none of these questions can be
answered with a simple "yes" or "no".
The technique uses basic question generating prompts provided by the English language. The method is
useful at any level from a formal checklist to complete informality.
For example:
n
For informal ‘rough-book’ use as a quick-aide checklist, as a private checklist to keep in mind when in
an on going discussion, as quick points scribbled down in a lesson, to generate further questions for
yourself or to raise in the lesson with your group/whole class.
n
To generate data-gathering questions in any subject, during the early stages of problem solving
when you are gathering data, the checklist can be useful either as an informal or systematic way of
generating lists of question that you can try to find answers for.
n
To generate idea-provoking questions, whilst brain-storming, brain-writing or some other such similar
technique, the checklist could be used as a source of thought provoking questions to help build on
existing ideas.
n
To generate criteria, the checklist could help in generating criteria for evaluating options.
n
To check plans, the checklist is a useful tool for planning implementation strategies.

Adding IWWM – In What Way Might ….
NB: The 5xWs and How ‘question words’ owe their strength to their fundamental place in the English
language, and can conceal some of the assets of nature that our language copes less well with. The
responses to these questions in the checklist are usually facts, rather than actions or conclusions. You
may well need to link these questions to Blooms Taxonomy if you want to achieve the correct level of
challenge or use IWWM.
n
For example, the answer to ‘Who does X?’ in a History lesson context could be ‘King …’. To use this
answer in a problem-solving or conclusion finding context you may have to take this to another level
of challenge.
n
For example ‘OK – if King … does X, in what way might we conclude this was a wise action by him
and his court?
n
This ‘in what way might’ (IWWM) stage is crucial if the facts are to come alive and contribute to the
creative thinking process.

Questions
Who … ?
What … ?
Why … ?
When … ?
Where … ?
How … ?
In What Way Might … ?

Conclusions / Hypothesis

“Dialogic teaching harnesses the power of talk to stimulate and extend children’s thinking,
and to advance their learning and understanding. It also enables the teacher to diagnose and
assess. Dialogic teaching is distinct from the question-answer-tell routines of so-called
‘interactive’ teaching, aiming to be more consistently searching and more genuinely reciprocal
and cumulative.”
Robin Alexander

Dialogic Teaching

Dialogic teaching provides a strategy for managing and
assimilating many aspects of the other approaches to
developing classroom talk, identified elsewhere in this
paper.

Dialogic teaching harnesses the power of talk to engage children, stimulate and extend their thinking,
and advance the learning and understanding. Not all classroom talk secures these outcomes, and some
may even discourage them. Dialogic teaching, therefore, is:

■ Collective: teachers and children address learning tasks together, whether as a group or as a
whole class;

■ Reciprocal: teachers and children listen to each other, share ideas and consider alternative
viewpoints;

■ Supportive: children articulate their ideas freely, without fear of embarrassment over ‘wrong’
answers; and they help each other to re ach common understandings;
■ Cumulative; teachers and children build on their own and each others’ ideas and chain them into
coherent lines of thinking and enquiry;
■ Purposeful: teachers plan and steer classroom talk with specific educational goals in view.
Most teachers use a basic repertoire of three kinds of classroom talk:
o rote
o recitation
o instruction/exposition
These provide the bedrock of repertoire of teaching by direct instruction, but some teachers also use:
o discussion
o scaffolded dialogue
These all have their place in a thinking classroom, but Dialogic talk is part of a larger repertoire, needed
to ensure children are empowered both in their learning now and later as adult members of society.
As part of their cognitive development, children need to acquire the capacity to:

■
■
■
■
■
■
■
■
■
■
■

narrate,
explain
instruct,
ask different kinds of questions,
receive, act and build upon answers
analyse and solve problems
speculate and imagine
explore and evaluate ideas
discuss
argue, reason and justify
negotiate

and, in order that they can do this effectively with others:
■ listen
■ be receptive to alternative viewpoints
■ think about what they hear
■ give others time to think.

AS part of a comprehensive classroom approach to talk for learning and empowerment, teachers will
need to engage with both of these repertoires, through:
Teacher-pupil interaction, Pupil-pupil interaction, Teacher-pupil one-to-one monitoring,
Questioning, Responses to questioning, Feedback on responses, Pupil talk.
Text and principles taken from: Towards Dialogic Teaching – Rethinking classroom talk
Robin Alexander – ISBN 0-9546943-0-9 Published by Dialogos UK Ltd

Tools for questioning to engage and encourage the
exploration of ideas to develop a particular thinking

Pose,	
  Pause,	
  Pounce	
  &	
  Bounce	
  
A strategy for structuring questioning in the classroom, to ensure thinking time, selection of students to
answer and collaborative sharing of ideas and response.
Pose – Teacher poses the question as a big question for all to consider and form a response to.
Pause – Teacher gives thinking time and possibly discussions/thinking together.
Pounce – Teacher selects who will provide and answer (no hands and not hands up).
Bounce – Teacher ‘bounces’ the answers from student to student developing the ideas/encouraging all
to add their views or extend the e.g. depth and breadth of answers.

DEAL
DEAL is often used in science to explore:
• ideas about what is seen (experiments or phenomenon)
• to develop the thinking and analyse these perceptions
• make links with previous learning and convey understanding
• develop the ability to apply what has been learnt
• make connections with other areas of previous learning.

D
E
A

Describe
Explain
Analyse

L

Link

Describe what you see, experience and can measure
Explain what you know or understand, what you experienced or think happened
Analyse the information or evidence to draw conclusions or determine what you
believe is happened and why
Link with previous knowledge or make connections with other phenomenon or
outcomes where these connections bring further conclusions or lead to hypothesis

SATIP
A strategy for beginning to engage with ‘Reading’ any text. This develops in the reader, further
questions in order that they then form a sense of meaning from the text, to develop understanding and
before the teacher might use Blooms Taxonomy to set more challenging questions.
1. Sense – or meaning – what is it about?
2. Audience – or tone – who is it intended for?
3. Technique – what are the techniques that have been used - what is their effect?
4. Intentions – What was the writer’s purpose?
5. Personal opinion – what is your reaction – what do you start to conclude?

CPFMC

Content

P

Process

F

Form

M

Mood/
emotion

Content, Process, Form and Mood

Analyse and describe the Content. This refers to much more than the subject matter of a
work of art. It can manifest itself in three overlapping ways. What the piece of work
represents or symbolises, what story or event is portrayed (referred to as narrative content),
and what idea the artist is attempting to pursue.
Analyse and describe the Process. This refers to the way in which media and materials have
been used to formulate and create a particular piece of work. This could refer to a single
process or a sequence of processes that have been combined to create the final outcome or
work of art.
Analyse and describe the use of the artistic, ‘formal’ elements or elements that make up that
artform. These can be described in simple terms as the building blocks for the artform, e.g in
Art and Design: line, tone, colour, pattern, texture, shape, form and space
Analyse and describe the Mood. This refers to the way in which the artist has handled form
and subject matter to create an emotionally affective piece of work. How the piece of work
makes the person experiencing the artform feel, and the viewer being able to find evidence in
the piece of work to support this feeling.

A guide to Critical Studies and how to look at, think and talk about objects, images and works of art, craft and design. Rod Taylor (Educating
for Art -Critical Response and Development, SCDC Publications 1986)

The Six Thinking Hats
developed by Edward de Bono
“Thinking is a skill, intelligence is not enough.”
“Within the information age – using the Internet to find information
is not enough, you have to think about what you find.”
Edward de Bono
When using the six thinking hats, we move thinking away from an emphasis on criticism and judgement,
towards the direction of creative or constructive thinking. This is achieved by considering six different
modes of thought, each shared by the thinkers together at the same time. They do not each consider
different modes at the same time. Hence, the thinking is in parallel.
The six hats represent six modes of thinking and are directions to think rather than
labels for thinking. That is, the hats are used proactively rather than reactively.
The method promotes fuller input from more people. In de Bono's words it "separates
ego from performance". Everyone is able to contribute to the exploration without
denting egos as they are just using the yellow hat or whatever hat. The six hats
system encourages performance rather than ego defence. People can contribute
under any hat even though they initially support the opposite view.
The Six Thinking Hats system has four specific uses:
1. It’s a critical meeting facilitation tool
2. It’s an outstanding team productivity/communication tool
3. It’s a creativity enhancer
4. It’s a control mechanism used to maximize and organize a person’s thoughts (help make
decisions and solve problems).
Thinking is separated into six distinct categories. Each category is identified with its own coloured
metaphorical "thinking hat.” By mentally wearing and switching “hats,” you can easily focus or redirect
thoughts, the conversation, or the meeting. The difference between brilliant and mediocre teams and
group activity, lies not so much in their collective mental equipment, but in how well they use it and how
well they work together. It artificially allows people to switch thinking quickly.
There is a range of methodology:
§ There are six metaphorical hats and the thinker can put on or take off one of these hats to
indicate the type of thinking being used.
§ When done in-group, everybody wears the same hat at the same time.
§ The hats must never be used to categorize individuals, even though their behaviour may seem to
invite this.
§ This putting on and taking off is essential.
§ Hats can be used individually – as symbols to request a particular type of thinking i.e. …”I think
we need some green hat thinking here.”
§ Hats can be used in a sequence e.g. Blue, Any, Any, Any, Any, Any, Blue – any hat can be used
as often as you like, There is no need to use every hat; the sequence can be made up of two,
three, four or more hats; there are two broad types of sequence: evolving and pre-set.
§ Evolving – facilitator chooses first hat and when this hat is completed, the next hat is chosen and
so on (but this process needs to avoid manipulation and users need to be very experienced)
§ Pre-set sequences - is set up at the beginning of the meeting, under an initial blue hat. Minor
variations can be permitted, depending on output.

The White Hat
The White Hat calls for information known or needed.
This covers facts, figures, information needs and gaps. "I think we need some white hat
thinking at this point..." means Let's drop the arguments and proposals, and look at the data
base."
The Yellow Hat
The Yellow hat symbolizes brightness and optimism, benefits, value sensitivity. This is the
logical positive. Why something will work and why it will offer benefits. It can be used in looking
forward to the results of some proposed action, but can also be used to find something of value
in what has already happened.
The Black Hat
The Black hat is judgment—the devil’s advocate or why something may not work, risk
assessment, caution. It is most useful, but can be over used.
This is a most valuable hat. It is not in any sense an inferior or negative hat. The black hat is
used to point out why a suggestion does not fit the facts, the available experience, the system
in use, or the policy that is being followed. The black hat must always be logical.
The Red Hat
The Red Hat signifies feelings, intuition, hunches, and emotion – gut feelings.
The red hat allows the thinker to put forward an intuition without any need to justify it. "Putting
on my red hat, I think this is a terrible proposal." Usually feelings and intuition can only be
introduced into a discussion if they are supported by logic. Usually the feeling is genuine but
the logic is spurious. The red hat gives full permission to a thinker to put forward his or her
feelings on the subject at the moment.
The Green Hat
The Green hat focuses on creativity: the possibilities, alternatives, and new ideas, growth,
energy, hypothesis. (Too little time is spent on this at present). This hat explores what is
interesting, provocations and changes.
The Hat
The Blue Hat is used to manage the thinking process (metacognition).This is the overview or
process control hat. It looks not at the subject itself but at the 'thinking' about the subject.
"Putting on my blue hat, I feel we should do some more green hat thinking at this point." In
technical terms, the blue hat is concerned with meta-cognition.
Using the six hats in the classroom
The six hats are used by teachers to structure a sequence of questions and discussions between small
groups of students or a whole class. Teacher’s best lead the discussions by wearing the blue hat and
managing the sequence in the wearing of the hats. You may use the following sequence of hats to help
you phrase your questions.
1. It is typical to begin the process of discussions by asking students a question that asks them to
wear the red hat and share their emotional response to the issue under discussion. The question
may encourage them to share their ‘gut feelings’ or intuition.
2. This first phase is often followed by a white hat question, which calls for the sharing of
information or data that can inform the students and make them more aware of any information
pertinent to the issue under discussion. This builds on their emotional response.
3. The next phase of questioning usually uses the green hat to ask students to explore creative
possibilities.

4. This is then followed by either the black hat which explores potential problems with the green hat
suggestions.
5. Alternatively, a yellow hat question might explore optimistic ideas or explore the value of the
green hat ideas already suggested.
6. The blue hat can be called for by the students or the teacher can offer the blue hat to the
students to invite them to suggest whether any of the hats should be worn again, to focus any
further questions.

Creative questioning using

SCAMPER

SCAMPER, devised by American Bob Eberle, is a useful technique to extend all pupils' thinking and can
provide real imaginative opportunities to all pupils to extend their work. The SCAMPER technique uses
a set of directed questions which pupils answer in order to come up with new ideas. The stimulus comes
from answering questions that you (as a teacher) and pupils (as learners) would not usually ask. It helps
pupils to ask questions that require them to think 'out of the box', helping to develop their critical thinking
skills. It's also a useful tool for creative writing and a stimulus for role play.
§
§

Remember, you don't have to use all the steps in SCAMPER.
Use it to spark off creative development and then let pupils work on their own. If they get stuck, they
can return to the SCAMPER framework.

Scamper is reproduced from issue 14 of the Primary focus G&T Update magazine

Other uses for SCAMPER
SCAMPER makes a good starter activity for all sorts of lessons.
1. Show pupils an object (probably from a school or museum collection) and ask them to use the
SCAMPER technique to come up with uses for the object.
2. Show or project in large scale for pupils an image (probably taken from the web or an illustration
from a book) and ask them to use the SCAMPER technique to come up with descriptions of
alternative images relating to the SCAMPER technique

Creativity

Bloom's Taxonomy
Higher order questioning in the context of looking at works of art
and reading
Evaluation
Synthesis
In 1956, Benjamin Bloom headed a group
of educational psychologists who developed a classification of
levels of intellectual behaviour important in learning. Bloom found that over 95 % of the test questions
Analysis
students encounter require them to think only at the lowest possible level...the recall of information.
Application

Bloom identified six levels within the cognitive domain, from the simple recall or recognition of facts, as
Understanding
the lowest level, through increasingly
more complex and abstract mental levels, to the highest order,
which is classified as evaluation. VerbKnowledge
examples that represent intellectual activity on each level are
listed below.

SCAMPER is an acronym that stands for a series of questions to ask about a familiar piece or work or process:
S Substitute Substitute one aspect of your product/process

C Combine
A Adapt
M Modify
P
E

(distort or)
Magnify
Put to
other
purpose
Eliminate

R Reverse

What else instead? Who else instead? Other ingredients? Other material? Other
power? Other place?
Combine two or more parts with something else
How about a blend, an alloy, an ensemble? Combine purposes?
Adapt or alter one aspect
What else is like this? What other idea does this suggest? Does past offer
parallel? What could I copy?
Change part/all of the current situation
Order, form, shape? What to add? More time? Greater frequency? Higher?
Longer? Thicker?
How could you put your current item/process to another use?
What else could I use this for? New ways to use as is? Other uses I modified?
Other places to use?
Delete one aspect
What would happen if I got rid of something? What difference would this make?
What to subtract? Smaller? Condensed? Miniature? Lower? Shorter? Lighter?
Omit? Streamline? Understate?
Reverse one thing
What if I did it the other way round? What if I reverse the order it is done or the
way it is used? How would I achieve the opposite effect? Other sequence?
Transpose cause and effect? Change pace? Transpose positive and negative?
How about opposites? Turn it backwards? Turn it upside down? Reverse roles?

1. Knowledge: arrange, define, duplicate, label, list, memorize, name, order, recognize, relate, recall,
repeat, reproduce state.
2. Comprehension: classify, describe, discuss, explain, express, identify, indicate, locate, recognize,
report, restate, review, select, translate,
3. Application: apply, choose, demonstrate, dramatize, employ, illustrate, interpret, operate, practice,
schedule, sketch, solve, use, write.
4. Analysis: analyze, appraise, calculate, categorize, compare, contrast, criticize, differentiate,
discriminate, distinguish, examine, experiment, question, test.
5. Synthesis: arrange, assemble, collect, compose, construct, create, design, develop, formulate,
manage, organize, plan, prepare, propose, set up, write.
6. Evaluation: appraise, argue, assess, attach, choose compare, defend estimate, judge, predict, rate,
core, select, support, value, evaluate.
Creativity: imagine, invent, resolve, investigate, explore, create, originate, innovate
This guidance is intended to help teachers to order and phrase suitably challenging questions when
using works of art, craft and design to inform and develop pupils thinking and response, to inform the
development of their ideas, imagination and creativity. Creativity has been added above Evaluation as a
higher order thinking activity, since Bloom first developed the taxonomy. This has been proposed also
by the national secondary strategy as a suitable addition.
As teachers we tend to ask questions in the "knowledge" category 80% to 90% of the time. These
questions are not bad, but using them all the time is. Try to utilize a higher order level of questions.
These questions require much more "brain power" and a more extensive and elaborate answers. On the
next page are the six question categories as defined by Bloom.

BLOOMS TAXONOMY
Competence Skills Demonstrated

Question Cues:

Knowledge

•
•
•
•

observation and recall of information
knowledge of dates, events, places
knowledge of major ideas
mastery of subject matter

list, define, tell, describe, identify,
show, label, collect, examine,
tabulate, quote, name, who, when,
where, etc.

Comprehension
(understanding)

•
•
•
•
•
•

understanding information
grasp meaning
translate knowledge into new context
interpret facts, compare, contrast
order, group, infer causes
predict consequences

summarize, describe, interpret,
contrast, predict, associate,
distinguish, estimate, differentiate,
discuss, extend

Application

•
•

use information
use methods, concepts, theories in new
situations
solve problems using required skills or
knowledge:

apply, demonstrate, calculate,
complete, illustrate, show, solve,
examine, modify, relate, change,
classify, experiment, discover

•

Analysis

•
•
•
•

seeing patterns
organization of parts
recognition of hidden meanings
identification of components

analyze, separate, order, explain,
connect, classify, arrange, divide,
compare, select, explain, infer

Synthesis

•
•
•
•

use old ideas to create new ones
generalize from given facts
relate knowledge from several areas
predict, draw conclusions

combine, integrate, modify,
rearrange, substitute, plan, create,
design, invent, what if?, compose,
formulate, prepare, generalize,
rewrite

Evaluation

•
•
•
•
•

compare and discriminate between
ideas
assess value of theories, presentations
make choices based on reasoned
argument
verify value of evidence
recognize subjectivity

assess, decide, rank, grade, test,
measure, recommend, convince,
select, judge, explain,
discriminate, support, conclude,
compare, summarize

Adapted from: Bloom, B.S. (Ed.) (1956) Taxonomy of educational objectives: The classification of educational
goals: Handbook I, cognitive domain. New York ; Toronto: Longmans, Green.

Example of the use of Bloom's Taxonomy for planning questions - Looking
at, thinking and responding to a work of art and design
PURPOSE
EXPLANATION

To apply Bloom's theory of developing higher levels of thought processes
to looking at, thinking and talking about works of art, craft and design.
Typically when learning about art and design, students are encouraged to
look at works of art, to develop their understanding of the artist, the
period or movement and an understanding of process, technique, content
the artistic form and emotional response or mood evoked by the work.
Judgements are often subjective and operate principally at a level of
knowledge and understanding. Students are encouraged to evaluate
their views, but are more rarely taken beyond comprehension and
through the intermediate stages of application, analysis and synthesis.
This focus is limiting because the purpose of looking at works of art is
principally twofold.
§
§

Firstly, we wish to enrich and enhance the quality of life of students,
to develop their cultural understanding.
Secondly, we hope to develop students own visual literacy skills and
their ability to look and think, to develop their own response to art
works which will in turn inform their own imagination and ideas for
their own art making. This should assist students in their learning
about technique, process, composition, use of mark, shape, colour,
organisation of content and elements, the use of signs and symbols
or cultural references and ultimately meaning.

Questions that teachers ask can direct students to the realisation that
visual literacy has a greater purpose than just acquiring facts about an
artist. It is hoped that students can learn to ‘read’ a work of art and make
connections between the work they are viewing and other art works they

PROCEDURE

have seen at different times, or between other art forms and other areas
of learning. Higher order questioning can lead pupils to make these
‘connections’ leading to a more developed or imaginative response,
which will in turn establish it as a life-long habit and enrich the experience
of looking at works of art.
For any identified visual literacy activity, develop questions that reflect the
progression of thinking and responding from the literal (descriptive) level
to the evaluative. Not all levels need to be developed for every art work.
Consider a range that will lead the pupil to the greater purpose of looking
and responding.
Each level of Bloom’s original taxonomy has been restated for clarity and
simplification. Examples of appropriate questions or directives are given
to illustrate each level. The familiar portrait Anna Christina by Andrew
Wyeth has been used to assist understanding and enable the
exemplification.

Anna Christina by Andrew Wyeth
1967
Tempera
21 1/4 x 23 1/2 in
Museum of Fine Arts, Boston

Wyeth has remained visually and emotionally attached to the real world, a world all but forgotten by his
contemporaries and the 20th Century. The importance of this cannot be over-estimated. In this way,
Wyeth has served as a link with the great tradition of artists responsive to life and humanity that was
essentially severed following the Post-Impressionists, and which is now in the early stages of
resumption.
Wyeth reacts to and expresses the character of the people whose lives he has passed through and
shared. He searches out the pose, the look in the eye, the set of the mouth, the significant facial wrinkle,
the sweater out at the elbow, the signals a dress gives when it has been worn a thousand times,
retaining the form and postures of the wearer.
He sees significance in the simplest objects, implements, animals and landscapes of a rural life. A
basket, a stump, a hound, an egg-scale, a hillside painted by Wyeth contain a meaning, rising to the
level of symbol, which is a blend of the meaning -- poetic and divine -- inherent in all things in life, and
the depth of Wyeth's emotional response and visual commitment to them. Wyeth's sensitivity,
perception and symbolic intensity elevated him, above the run-of-the-mill illustrator-artist.

Another version of Christina Olson, the painting "Anna Christina," 1967, depicting her sitting against a
foggy background, is a marvelous character study emphasizing a prominent, hooked nose, eyes that pull
against each other as one looks toward the viewer, a jutting lower lip and weathered cheek. But it just
doesn't hold up as a solid head. It is again the extraordinarily talented illustration of a head, rather than
the three-dimensional re-creation of a head in the sense of Rembrandt, Vermeer, Cezanne, etc.
These questions are designed to develop higher order thinking in response to this painting and several
others by the artist Andrew Wyeth, in preparation by pupils who are planning to make a painting of an
elderly relative.
Knowledge

the recall of specific information
•
•
•
•

Comprehension

an understanding of what has been viewed and of other work by the
artist
•
•
•
•
•

Application

Who was Andrew Wyeth?
Where did he live? And what country do his paintings depict?
Who is the person in the painting?
What is Tempera?

What sorts of scenes are depicted in the Andrew Wyeth
paintings you have seen?
What kind of painting is this?
Where might this picture have been painted or where did the
sitter pose?
What can you tell us about the person in the picture, just by
looking and thinking?
Can you suggest what Anna Christina might do?

the converting of abstract content to concrete situations – applying
what is know and understood to real situations
•
•

•
•

•

Can you describe the way in which the artist will have organised the
room for the portrait to be painted?
If you were to use the same pose in your painting of an elderly
relative, then what would you include in your painting to tell us about
your relative?
How might your painting be different?
How long do you think the sitter had to pose for the portrait? Could
you sit still for that amount of time? How do you think the artist might
have organised the blocks of time for each sitting?
Can you describe the stages the artist may have gone through from
start to finish to complete this painting?

Analysis

the comparison and contrast of the content to personal experiences
•
•
•
•
•
•

Synthesis

the organization of thoughts, ideas, and information from the
content
•
•
•

•
•

•

Evaluation

What kind of person do you think Anna Christina is?
How would you react if you met her?
Can you compare Anna Christina to a member of your own family?
Do you think the painting is an honest description of the person?
Do you know anyone who this painting reminds you of? Describe
that person?
If you heard Anna Christina talking – what would she sound like?

What do you think the sitter (Anna Christina) is thinking?
If you were to pose for a portrait, what would you think about, to pass
the time?
Draw a selection of compositional studies to show how you would
use a similar informal pose if you were planning to make a painting of
an elderly relative. Try to include the actual chair they would sit in
and the background of the room where they would pose and where
you would make the painting.
Make a list of the things you would want to include in your painting.
Describe what your posing figure would look like if viewed from
several different viewpoints around them. Make some sketches if
this would help you.
What other way could you make a portrait, that tells us more about
the person in the picture?

the judgment and evaluation of characters, actions, outcome, etc.,
for personal reflection and understanding
•
•
•
•
•
•
•
•

Do you think Anna Christina is a real person?
Why do you think Andrew Wyeth wanted to paint this portrait?
What does the style of painting tell you about Anna Christina?
What do you think the clothes she is wearing and the chair she is
sitting in, tell you about her?
Do you think this is an honest painting?
Would you want to make your painting of an elderly relative like this
painting by Andrew Wyeth? or how would you make it different ?
How does this portrait compare with others you have seen?
Why do artists make portraits and not just take photographs of people
to exhibit?

Questions
From Imported malaria cases and death, United Kingdom 1992 – 2011
1) Which year had the most deaths in the UK as a result of Malaria?
2) Which year had the most recorded cases of Malaria and how many cases
were there?
3) Describe the trend of Malaria cases in the UK from 2000 to 2011.
4) Do you feel that there is an overall meaningful reduction in the number of
Malaria cases in the UK over the years the data has been recorded? Explain
5) Research Malaria and describe how it is spread. From your newly acquired
knowledge do you think Malaria is spread in the UK or are all the cases
imported from overseas? Explain your answer.
From Imported malaria cases by species and region of travel, United Kingdom
2007 – 2011
6) Use the data in the table from 2011 only to plot the number of cases of
malaria in the UK from the different parts of Africa. (Hint will this be a bar
graph or a line graph). Include your hand drawn graph with these questions.
7) Which continent has the greatest cases of Malaria?
8) Why is Europe not included?
9) Australia has the climate but not Malaria can you find out 2 mosquito borne
infectious diseases in Australia.
From Salmonella by age group and year, United Kingdom 2000 – 2011
10) What is salmonella, what symptoms does it cause and how is it spread?
11) Which age group has the highest numbers of Salmonella infection?
Speculate as to why?
12) What do you think are our numbers of infection in Australia? This data only
looks at pure numbers of infections it does not at the infection rate per 100 or
1000 people. What difference do you think this makes? Comment
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Teaching
Media Literacy
in the Age of
the Internet

The online world is quickly becoming a source of primary
information for both teachers and students.
Considering the enormous amount of
information available online and that about
75% of all K-12 schools have Internet access,
students and teachers need to be able to critically
evaluate Web pages for authenticity, applicability,
authorship, bias, and usability.
Unlike the media center, there are no media
specialists to sort out the valuable information from
the substandard information. With more than 350
million documents available on the Web alone,
finding relevant information online can be daunting.
Therefore, the ability to critically evaluate information
is an invaluable skill in this information age.
The acquisition of digital literacy skills is dependent
upon the student’s ability to find information, determine
its usefulness and accuracy, and utilize it effectively. What
follows are 26 criteria that enable teachers and students to
assess every Web page the Net has to offer.
Authority When we look at Internet information with a
critical eye, we want to know the basis of the author’s
authority. Some filters we can employ are:
• Is the author a well-regarded name you recognize?
• Does the online document contain a biography and
an email address?
• Did you link to this site from a site you trust?
• Are you led to additional information about the author?
http://www.amazon.com

Bias Biased sites contain words that try to persuade rather
than inform. Some of these words include over-generalizations
and simplifications and may also contain games, giveaways,
contests, or celebrity endorsements intended to persuade. Some
things to think about include:
• Is it clear what organization is sponsoring the page?
• Is there is a link to the sponsoring organization’s Web site?
• Is the page actually an ad disguised as information?
Citations If the author of a site includes a source bibliography, students can consult these sources to find additional
information about the topic and compare the author’s content

•
4

December 1998/January 1999

with
other works. If the
author leads the user to related
sources, it allows the student to evaluate the
author’s scholarship. Citations should be full citations to
allow students to locate the book or periodical at the library.
Dates Every credible Web site includes the date that it was
created and the date of last update. Another date that may be
important to your students is the date the data was collected.
Students need to ask themselves if the information they are
looking for is from an area that demands more current
information. In this case, the date of last update is an important
feature to look for.
Efficiency If you plan to use a site with a large group of
students, it is important to try it at all times of day. Some sites
get very busy at midday and may slow down your lesson. If
there are large graphics on the page, make sure the page
resides in your cache to speed up the download time. If you are
planning a major lesson around a site, the best idea is to ask
permission from the site’s author and use WebWhacker or
WebBuddy to retrieve the entire site or a portion of it to your
computer.
http://www.bluesquirrel.com/whacker/
http://www.dataviz.com/products/webbuddy/

Fallacy As with print material, one thing that may happen on
a Web site is that the information presented may be used out
of context. Citations allow students to research the original
© CLASSROOM CONNECT

document and become familiar with the surrounding text.
Another event that occurs on the Web that is unique to
hypertext systems is the ability to jump into a Web site at any
point. Students should be encouraged to find the “top” of the
Web site and read the author’s purpose and rationale for
providing the information.
Graphics As bandwidth shrinks and becomes a precious
commodity, more attention needs to be focused on the
graphics that are included on a Web site. Aclearly labeled
graphic is worth a thousand words when illustrating a point.
Graphics should aid students in reaching the desired objectives
for using the site and should serve a clear purpose for the
intended audience.
Handicapped Access In this day of the graphical browser,
the statement that a page should be usable via a text-based
browser is often disregarded. Visually impaired users may
utilize a screen reader to read the Web page, and it is important
that there be text available and text alternatives for the
graphics software to “read.”

some type of logical order. Students should be able to tell at
first glance how a site is organized and the options available.
An added bonus is the inclusion of a keyword search function.
Online Research Models There are numerous research
models available that are applicable to the online research
process. They all have things in common including the
formation of the research question, the planning of the search
strategy, the gathering of information, and more.
Pertinent Central to the online research model is the need for
students to know when to disregard information. With the
amount of information available, it is imperative that students
learn how to evaluate whether the information that they find is
pertinent to their purpose. This begins by having students
clarify their objectives before they begin the research process.

Quantity of Information Some Web sites continue to grow
in size every day. With the interactive nature of the Internet,
some sites solicit input, examples, and stories from others. If
this type of site meets the students’needs, they should be
reminded to visit it regularly to keep up-to-date. Having
Information Availability Tell students that a particular
students practice extensive searches on topics that they are
piece of information might not be available online because
familiar
with will help them realize the most effective way to
firms who pay to create and disseminate information are
find information and help them eliminate
unlikely to provide this information free
of charge. Also tell students that keeping “Digital literacy is the ability to some of the frustrations of the overabundance of information.
information up-to-date is costly.

understand and use information

Requirements Some sites have certain
in multiple formats from a wide requirements for use. Students should
learn to exercise caution if they are asked
to submit registration information at a
range of sources when it is
site. Another annoyance is the use of
proprietary software (plug-ins or players)
presented via computers.”
that forces the user to access the site
using a specific Internet browser. When
— Paul Gilster
evaluating a Web site to use for
instruction, be aware that, if it was
designed
for
one
browser
or the other, it may not be presented
Knowledge Before researching online, students should have
p
r
o
p
e
r
l
y.
All
Web
pages
should
be designed with the world’s
working knowledge of the topics they are pursuing. This
two
most
popular
browsers
in
mind:
Netscape Navigator and
allows students to relate how the new information compares
Internet
Explorer.
(See
our
October
1998
Newsletter cover
with what they already know about the subject.
story for more information.)
Links Students should also try to find out if a site is meant to
be comprehensive in scope or is just an overview or sampler of Scholastic Reviews There are many Web review columns in
professional periodicals that list and describe Web sites of
links. The links should be appropriate for the site’s intended
value.
Use these reviews to choose sites to support instruction.
audience and also offer something that is not available at any
There
are
many awards given on the Net, and you should use
other online destination.
caution when choosing sites because they have won awards.
Misinformation Students need to realize some of the sources Oftentimes, awards are created to build up visits to the site of
of misinformation on the Net, which include the fact there is
the awarding page. One way to determine if a site is scholarly
nothing to stop a Web page author from modifying the text at
in nature is to see what type of sites have linked to it. This type
any time; the use of opinion verbs and appeals to emotion may
of Internet search can be conducted using both HotBot and
indicate bias; and there are many jokes and pranks on the Net.
AltaVista.
http://www.hotbot.com
Navigability AWeb page should be designed for easy
http://www.altavista.com
navigation. Links should be easy to identify and grouped in

Jerry-Built Webster’s Dictionary defines
jerry-built as “built poorly, of cheap
materials.” When evaluating a site,
students need to understand that a page
that contains multiple spelling and
grammatical errors may have been thrown
together. There is one exception: If the
native language of the Web site designer is
not English, spelling and grammar
inconsistencies should be overlooked.
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HotBot employs a drop-down menu to search for links to
individual sites, while AltaVista allows users to type
link:<URL> in its search box. Try this example with
AltaVista. In the search box at the top of the home page, type
the following:
link:http://www.classroom.com

Theorists The major educational tenets of noted theorists still
remain viable in the online world. Whether it is Eisenberg and
Bekowitz (The Big Six), Robert Marzano (Dimensions of
Learning), or Bernie Dodge (WebQuests), sound educational
theory should be the basis of all learning, including online
research.
http://big6.syr.edu
http://www.mcrel.org/products/dimensions/whathow.html
http://edweb.sdsu.edu/webquest/webquest.html

By having students take the information that they find and
make conscious, educated decisions about what to use and how
to structure it, they gain the higher-order thinking skills
necessary for lifetime learning in an information-rich society.
Uniqueness The Web has many unique characteristics that
are not present in the print world. Marsha Tate and Jan
Alexander describe marketing-oriented Web pages, Web pages
that blend entertainment, information, and advertising, and
software requirements that limit access to information as some
of these unique characteristics.
http://www.science.widener.edu/~withers/webeval.htm

Verifiable Whenever possible students need to verify Internet
information in a reputable print source. If no citations are
included, the student needs to conduct further research to
determine the validity of the site’s content.

Evaluation Web Sites
Critical Evaluation Surveys

http://www.capecod.net/schrockguide/eval.htm

Evaluating Internet-Based Information: A Goals-Based Approach

http://www2.ncsu.edu/unity/lockers/project/meridian/
feat2-6/feat2-6.html

WWW CyberGuide Ratings for Content Evaluation

http://www.cyberbee.com/guide1.html

Evaluating the Quality of Internet Information Sources

http://itech1.coe.uga.edu/faculty/gwilkinson/criteria.html

Evaluation of World Wide Web Sites: An ERIC Digest

http://ericir.syr.edu/ithome/digests/edoir9802.html

The Five W’s As with any investigative reporting, students can
easily apply the five W’s to simply evaluate a Web site: Who
wrote the pages and are they an expert in the field? What does the
author say is the purpose of the site? When was the site created,
updated, last worked on? Where does the information come from?
Why is the information useful?
Xtra information Tate and Alexander have also designed
evaluation instruments for different types of Web pages. They
contend that different criteria need to be examined for the different
types of pages.
http://www.science.widener.edu/~withers/webeval.htm

Yahoo! Information in a general-purpose directory such as Yahoo!
has been filtered and organized to produce a browsable, keywordsearchable index of a portion of the Net’s Web destinations.
Students should take advantage of these directories to get an
overview of what is available on the Net as they formulate their
search strategies.
http://www.yahoo.com

Search engines are useful only when students have gained
their background knowledge, identified key terms, and learned
effective search strategies. There is much more information
available through search engines than directories, and as long
as students have a clear strategy in mind, the number of results
returned should not be overwhelming.
http://www.search.com

Zen In a 1995 issue of Computers in Libraries, Kirk Doran
writes about what the Internet is not. He contends that, since
the Internet cannot be searched all at once or seen in its
entirety, the usual method of matching one type of question
with one type of source does not work. He feels, due to the fact
that the Net is not run by one company, it lacks the organization
and consistency we are accustomed to in print, and the navigation is not consistent.
http://www.stlcc.cc.mo.us/lsdocs/internot.htm

Finally, Paul Gilster’s definition of digital literacy can be
summed up in a single phrase: “the ability to understand and use
information in multiple formats from a wide range of
sources when it is presented via computers.”
http://www.december.com/cmc/mag/1997/oct/bunz.html

If we strive to teach students the best way to critically evaluate
the information that they find in relation to the purpose at hand,
we will produce a generation of digitally literate adults who are
equipped to learn throughout their lifetimes. In the end, is this
not the greatest lesson we can teach today’s students?

Bibliography on Evaluating Internet Resources

http://refserver.lib.vt.edu/libinst/critTHINK.HTM

ED’s Oasis Evaluation Guidelines

http://www.edsoasis.org/guide2.html

•
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by Kathy Schrock
<kschrock@capecod.net>
http://www.capecod.net/schrockguide/
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HPA - Imported malaria cases and deaths, United Kingdom: 1992 - 2011

From 1 April 2013 we are part of Public Health England
Find out more about Public Health England

Imported malaria cases and deaths, United Kingdom:
1992 - 2011
Data from the HPA Malaria Reference Laboratory

View data as a graph
View 2007 - 11 data by region of travel and Plasmodium species
View 2007 - 11 data by reason for travel and Plasmodium species

Year

*P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

Deaths

2011

1149

416

77

31

4

-

1677

8

2010

1263

350

99

37

12

-

1761

7

2009

1179

205

69

36

6

-

1495

6

2008

1087

177

76

20

9

1

1370

6

2007

1139

256

108

30

15

-

1548

5

2006

1386

219

106

26

20

-

1758(†)

8

2005

1338

258

116

29

10

3

1754

11

2004

1221

278

121

28

12

-

1660

5

2003

1339

206

134

27

15

1

1722

16

2002

1469

284

134

43

13

2

1945

9

2001

1576

263

157

37

16

1

2050

9

2000

1576

322

124

30

16

1

2069

16

1999

1504

374

113

41

11

2

2045

14

1998

1388

484

157

26

17

1

2073

7

1997

1401

790

125

27

20

1

2364

13

1996

1283

1014

134

35

33

1

2500

11

1995

1112

742

143

29

29

-

2055

4

1994

1178

501

125

44

39

-

1887

11

1993

1048

708

116

20

30

-

1922

5

1992

935

512

120

24

38

-

1629

10

* P is Plasmodium
†In April 2006, there was one report of Plasmodium knowlesi reported in a traveller who had been to Brunei. P. knowlesi
www.hpa.org.uk/Topics/InfectiousDiseases/InfectionsAZ/Malaria/EpidemiologicalData/malaEpi10CasesandDeaths/#malgraph?printable=true
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is an extremely rare cause of malaria in humans; it is a primate malaria parasite whose hosts include crab-eating
macaques, pig-tailed macaques, and leaf monkeys. It is transmitted by mosquitoes of the Anopheles leucosphyrus
group. Natural infection in humans, in whom it resembles P. malariae, was first reported in 1965. Occasional sporadic
cases have occurred since then. So far, P. knowlesi has been found in humans in Malaysia, Malaysian Borneo, and
Thailand [Jongwutiwes S, Putaporntip C, Iwasaki T, Sata T, Kanbara H. Naturally acquired Plasmodium knowlesi malaria
in a human, Thailand. Emerg Inf Dis 2004; 10 (12): 2211-3. Available at http://www.cdc.gov/ncidod/eid/vol10no12/040293.htm.

Imported malaria cases and deaths, United Kingdom: 1992 - 2011

Last reviewed: 24 April 2012

© Health Protection Agency 2013
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HPA - Imported malaria cases by species and region of travel, United Kingdom: 2007 to 2011

From 1 April 2013 we are part of Public Health England
Find out more about Public Health England

Imported malaria cases by species and region of travel,
United Kingdom: 2007 to 2011
View same data for 2010, 2009, 2008, 2007
Imported malaria cases by species and region of travel, United Kingdom: 2011

Geographic area

*P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

West Africa

743

-

47

20

1

-

811

East Africa

114

4

10

5

1

-

134

Central Africa

62

-

6

2

-

-

70

Southern Africa

53

-

2

-

-

-

55

-

-

-

-

-

-

-

Africa - unspecified

17

-

2

1

-

-

20

Asia§

9

331

1

-

2

-

343

Far East/SE Asia

1

7

-

-

-

-

8

Central/South America

2

2

-

-

-

-

4

Middle East

1

-

-

-

-

-

1

Oceania

-

2

-

-

-

-

2

Not given

147

70

9

3

-

-

229

Total

1149

461

77

31

4

-

1677

North Africa

*P is Plasmodium
§ Asia includes: India, Pakistan, Bangladesh, Nepal, Sri Lanka, Bhutan, Myanmar (Burma), Afghanistan
Imported malaria cases by species and region of travel, United Kingdom: 2010
Geographic area

*P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

West Africa

806

1

61

13

5

-

886

East Africa

111

11

13

11

2

-

148

Central Africa

48

-

5

2

2

-

57

Southern Africa

42

-

7

1

-

-

50

-

-

-

-

-

-

-

Africa - unspecified

22

2

3

2

-

-

29

Asia

24

250

-

-

2

-

276

Far East/SE Asia

1

4

-

-

-

-

5

Central/South America

2

5

-

-

-

-

7

North Africa

www.hpa.org.uk/web/HPAweb&HPAwebStandard/HPAweb_C/1195733783966?printable=true
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Middle East

-

-

-

-

-

-

-

Oceania

-

4

-

-

-

-

4

Not given

207

73

10

8

1

-

299

Total

1263

350

99

37

12

-

1761

Imported malaria cases by species and region of travel, United Kingdom: 2009
Geographic area

*P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

West Africa

750

2

42

17

2

-

813

East Africa

98

9

8

6

-

-

121

Central Africa

30

-

1

2

1

-

34

Southern Africa

33

-

4

4

-

-

41

-

-

-

-

-

-

-

Africa - unspecified

25

-

1

1

-

-

27

Asia

15

133

-

-

-

-

148

Far East/SE Asia

3

4

-

-

-

-

7

Central/South America

-

5

-

-

1

-

6

Middle East

1

-

-

-

-

-

1

Oceania

1

8

-

-

-

-

9

Not given

223

44

13

6

2

-

288

Total

1179

205

69

36

6

-

1495

North Africa

Imported malaria cases by species and region of travel, United Kingdom: 2008
Geographic area

*P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

West Africa

763

1

38

10

6

-

818

East Africa

73

10

7

5

-

-

95

Central Africa

23

-

6

-

-

-

29

Southern Africa

27

2

4

-

-

-

33

-

-

-

-

-

-

-

Africa - unspecified

20

-

5

-

-

-

25

Asia

8

118

-

-

1

-

127

Far East/SE Asia

1

3

-

-

1

-

5

Central/South America

-

3

-

-

-

-

3

Middle East

1

-

-

-

-

-

1

Oceania

-

10

-

-

1

-

11

Not given

171

30

16

5

-

1

223

Total

1087

177

76

20

9

1

1370

North Africa

Imported malaria cases by species and region of travel, United Kingdom: 2007
Geographic area

P.falciparum

P.vivax

P.ovale

P.malariae

Mixed

P unspecified

Total

West Africa

719

2

67

11

9

-

808

East Africa

92

8

11

10

2

-

123

Central Africa

23

-

2

2

-

-

27

Southern Africa

31

1

1

1

-

-

34

-

-

-

-

-

-

-

Africa - unspecified

12

1

1

-

-

-

14

Asia

22

169

1

-

2

-

194

Far East/SE Asia

1

4

-

-

-

-

5

North Africa

www.hpa.org.uk/web/HPAweb&HPAwebStandard/HPAweb_C/1195733783966?printable=true
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Central/South America

2

11

1

-

-

-

14

Middle East

1

-

-

-

-

-

1

Oceania

1

14

-

-

-

-

15

Not given

235

46

24

6

2

-

313

Total

1139

256

108

30

20

-

1548

Last reviewed: 24 April 2012
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HPA - Salmonella by age group and year

From 1 April 2013 we are part of Public Health England
Find out more about Public Health England

Salmonella by age group and year
All human isolates reported to the Health Protection Agency Centre for Infections. England and Wales, 2000-2010
Year <1 1-4 years 5-9 years 10-14 years 15-44 years 45-64 years 65-74 years 75+ years
2000 633 1622

1017

678

6160

3139

788

628

2001 580 1811

1135

861

6809

3574

888

633

2002 699 1617

1000

737

6078

3039

885

699

2003 643 1533

1106

789

6353

3343

810

656

2004 594 1500

937

762

6190

3017

768

522

2005 578 1433

934

606

5090

2746

730

525

2006 652 1468

864

648

5345

2913

774

581

2007 625 1428

708

606

4965

2860

809

540

2008 602 1258

679

500

4144

2423

695

528

2009 656 1280

721

520

3707

2008

592

396

2010 552 1144

482

390

3394

2063

612

434

Source: HPA Salmonella Dataset (Labbase2). Please note, numbers may be higher than previously reported due to the
inclusion of all isolates of Salmonella, rather than only faecal, and lower gastrointestinal tract isolates.

Graph of this data

View epidemiological data for other gastrointestinal infections
www.hpa.org.uk/Topics/InfectiousDiseases/InfectionsAZ/Salmonella/EpidemiologicalData/salmHumannumbersbyagegroup/?printable=true
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Last reviewed: 25 March 2011
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APA 6th REFERENCING
Last updated January 2012

BEFORE you begin, please note:
 This brief guide is primarily for students doing assignments at Curtin University, not for
those publishing using the APA 6th style.
 If you are publishing in the APA 6th style, please consult the APA publication manual:
American Psychological Association. (2009). Publication manual of the
American Psychological Association (6th ed.). Washington, DC: Author.
For more details see the APA Style Blog
 It is important that you check the assignment guide of your Department or School as details
may vary from the guidelines on this sheet. You may be penalised for not using the referencing style
that is required by your School/Department.

What is Referencing?
Referencing is a standardised method of acknowledging sources of information and ideas that
you have used in your assignment in a way that uniquely identifies their source. Direct
quotations, facts and figures, as well as ideas and theories, from both published and unpublished
works, must be referenced.
Why Reference?
Referencing is necessary to avoid plagiarism, to verify quotations, and to enable readers to follow
-up and read more fully the cited author’s arguments.
Steps Involved in Referencing
1.

Collecting Bibliographic Details
Note down the full bibliographic details of the source from which the information is taken,
including the relevant page number(s). This information is the basis of a citation or reference.
In the case of a book, ‘bibliographical details’ refers to: author/editor, year of publication,
title, edition, volume number, place of publication and publisher as found on the front and
back of the title page. (Not all of these details will necessarily be applicable).
In the case of a journal article the details required include: author of the article, year of
publication, title of the article, title of the journal, volume and issue number of the journal,
and page numbers.
For all electronic information, in addition to the above you should note the DOI (Digital
Object Identifier) if one exists, and if one does not exist, the web address (URL) of the
database you found the article in. For more details see the DOI Information Sheet.

2.

In-Text Citations
A citation inserted at the appropriate place within the text of the document is called
an in-text citation. This usually takes the form of the name of the author, followed
by the year of publication.
Two acceptable forms of in-text citations are:
Miller and Collins (2009) - use and when family names are outside parentheses
(Miller & Collins, 2009) - use & when family names are inside parentheses
If two or more authors are cited at the same point in the text then they are included in
the same in-text citation, separated by a semicolon, e.g., (Brown, 1991; Smith, 2003).
Short quotes
For fewer that 40 words incorporate the quote into the text and use double quotation
marks.
“………………………….” (Brown & Brown, 2008, p.112).
Brown and Brown (2008) suggested “……………………………” (p. 112), and this
would provide…
When paraphrasing, the APA 6th manual (p.171) encourages you to provide page or
paragraph numbers to help the reader locate the information.
Use paragraph number for .html documents (e.g. British Empire 1922, 2009, para.4)
Page Numbers
Use p. for a single page and pp. for double pages.
Long Quotes
If the quotation is 40 or more words use a freestanding block of text





3.

start on a new line
indent the block about half an inch from the left
use double spacing
omit quotation marks

Reference List
A reference list includes books, journal articles etc that you have cited in the text of
your essay whereas a bibliography is a list of sources consulted as well as cited.






The reference should appear at the end of your work on a separate page
The reference list is arranged alphabetically by author
Where an item has no author it is cited and listed by its title
The second and subsequent lines of each reference need a hanging indent
Use double spacing between references

Example of a Reference List in the APA style

Elements of a Reference
A reference or citation consists of elements that allow the reader to trace the original book,
article or website you have consulted and cited.

Book:
Author

Book title

(Year)

Mack, C. (2005). Looking at the Renaissance: Essays toward a conceptual appreciation.
London, UK: Taylor & Francis.

Place of publication

Publisher

Journal article from a database:
(Year)

Authors

Title of the journal article

Pope, J., & Owen A. D. (2009). Emission trading schemes: Potential revenue effects,
compliance costs and overall tax policy issues. Energy Policy, 37, 4595-4603.
doi:10.1016/j.enpol.2009.06.014

Journal title

DOI

Volume number
Article page numbers

Web Page:
Authors

(Year)

Title

Steel, W. (2008). Hints for web authors. Retrieved from http://www.mcsr.olemiss.edu/
~mudws/webhints.html

URL of the web page

Underlined hyperlink in URL
This can be removed if required. APA has no rule regarding the inclusion of a hyperlink and
they provide no guidance. This is at the discretion of the respective lecturers. For more
information see the APA Style Blog FAQ

3

Examples of Referencing:

For Reference Types to use with EndNote, click here for the EndNote X5 LibGuide

Books

In-Text Example

Reference List Examples

Single author

The theory was first considered in 2000 (Pash, 2008)
OR
Pash (2008) claimed that…

Pash, C. (2008). The last whale. North Fremantle, W.A.: Fremantle Press.

2 authors

Roitman and LaFontaine (2012) …
OR
“… to achieve consistency” (Roitman & LaFontaine, 2012, p.
45)

3,4,5 authors

Conking, Alley, Broecker, and Denton (2011)
Cite all authors the first time the reference occurs.

Roitman, J. L., & LaFontaine, T. P. (2012). The exercise professional’s guide to optimizing
health: Strategies for preventing and reducing chromic disease. Philadelphia, PA:
Wolters Kluwer Health.

Conking, P. W., Alley, R. B., Broecker, W. S., & Denton, G. H. (2011). The fate of Greenland:
Lessons from abrupt climate change. Cambridge, MA: MIT Press.

In subsequent citations, include only the surname of the
first author followed by et al.
Conking et al. (2011) suggested that …
OR
(Conking et al., 2011)
6,7 authors

Bulliet et al. (2011) found that…
OR
(Bulliet et al., 2011)

Bulliet, R. W., Crossley, P. K., Headrick, D. R., Hirsch, S. W., Johnson, L. L., & Northrup, D.
(2011). The earth and its peoples: A global history (5th ed.). Boston, MA: Wadsworth.

Cite only the surname of the first author followed by et al.
8 or more authors

(Gradel et al., 2007, p. 35)
OR
Gradel et al. (2007, p. 35) stated...
Cite only the surname of the first author followed by et al.

No author

(Employment the Professional Way, 2000)
OR
the book Employment the Professional Way (2000)

Gradel, E., Kolaitis, P. G., Libkin, L., Marx, M., Spencer, J., Vardi, M. Y., … Weinstein, S.
(2007). Finite model theory and its applications. Berlin, Germany: Springer.
For works with 8 or more authors, list the first 6 authors, followed by 3 full stops (…)
then spell out the last author’s name.

Employment the professional way: A guide to understanding the Australian job search
process for professionally qualified migrants. (2000). Carlton, Vic: Australian
Multicultural Foundation.

Shorten title

4 of 12

Multiple works by
same author

University research (Martin, 2008, 2010)
has indicated that…

Martin, G. (2008). Essentials of terrorism: Concepts and controversies. Los Angeles, CA: Sage
Publications.
Martin, G. (2010). Understanding terrorism: Challenges, perspectives, and issues. Thousand Oaks,
CA: Sage Publications.
Order chronologically in the reference list.

Multiple works published in the same
year by the same author

In recent reports (Napier, 1993a, 1993b)
…

Napier, A. (1993a). Fatal storm. Sydney, NSW: Allen & Unwin.
Napier, A. (1993b). Survival at sea. Sydney, NSW: Allen & Unwin.

Use a/b etc. to differentiate between
works in same year.

Order alphabetically by title in the reference list.

Works by different
authors with same
surname

(L. Green, 2010) OR L. Green (2010)

Green, L. (2010). The internet: An introduction to new media. New York: Berg.

(R. Green, 2008) OR R. Green (2008)

Green, R. (2008). Global warming. Ann Arbor, MI: Cherry Lake Publishing.

Editor

(Kasdorf, 2003, p. 15)

Kasdorf, W. E. (Ed.). (2003). The Columbia guide to digital publishing. New York, NY:
Columbia University Press.

Different Editions

(Renton, 2004, p. 51)

Renton, N. (2004). Compendium of good writing (3rd ed.). Milton Keynes, UK: John Wiley & Sons.
OR
Merriam-Webster’s collegiate dictionary (11th ed.). (2005). Springfield, MA: Merriam-Webster.

OR
(Merriam-Webster’s collegiate dictionary,
2005)

An edition number is placed after the title of the work - this is not necessary for a first edition.

Encyclopedia or
Dictionary or multivolume work

The new Grove dictionary of music and
musicians (1980, p.85) defined it as…

Sadie, S. (Ed.). (1980). The new Grove dictionary of music and musicians (6th ed., Vols. 1-20). London,
UK: Macmillan.

Article or chapter in a
book

As discussed by Friedl (2003)…

Friedl, E. (2003). Society and sex roles. In J. P. Spradley & D. W. McCurdy (Eds.), Conformity and
conflict: Readings in cultural anthropology (11th ed., pp. 261-289). Boston, MA: Allyn and Bacon.

Article or chapter in a
book – no author

(“Solving the Y2K Problem,” 1997)

Solving the Y2K problem. (1997). In D. Bowd (Ed.), Technology today and tomorrow (p. 27). New York,
NY: Van Nostrand Reinhold.

Put title in quotation marks.
Image in a book

The poster “The 3 dark years” (Sexton,
2005, p. 184)

Sexton, M. (2005). The great crash: The short life and sudden death of the Whitlam government.
Melbourne, Vic: Scribe Publications.
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E-book (available
in print as well as
electronic version)

(Schultz & Videbeck 2009)

Schultz, J. M., & Videbeck, S. L. (2009). Lippincott’s manual of psychiatric nursing care plans (8th ed.).
Retrieved from http://ovidsp.tx.ovid.com.dbgw.lis.curtin.edu.au/
Supply DOI where available, or URL (shorten URL) in the absence of DOI.

E-book available
only online

(Apolloni, Pedrycz, Bassis & Malchiodi,
2008, p. 130)

Apolloni, B., Pedrycz, W., Bassis, S., & Malchiodi, D. (2008). The puzzle of granular computing.
Retrieved from http://www.springerlink.com.dbgw.lis.curtin.edu.au/content/g6u77ux5v746/
#section=246151&page=1

Journals

In-Text Example

Reference List Example

Article

As mentioned by Morberg, Lagerstrom,
and Dellve (2009)…
OR
“… the head school nurse’s
job” (Morberg, Lagerstrom, & Dellve,
2009, p. 813)

Morberg, S., Lagerstrom, M., & Dellve, L. (2009). The perceived perceptions of head school nurses in
developing school nursing roles within schools. Journal of Nursing Management, 17, 813-821.

(“New Baltic Icebreakers,” 2005)

New Baltic icebreakers under construction at Baltiyski Zavod. (2005). Naval Architect, (July/August),
32-34.

Article – no author

Use a short title with capitalisation
and enclosed in quotation marks.
Newspaper article

(Wilson, 2009)

Where the page numbers in the entire volume run consecutively, do not use issue number after
the volume number.

Wilson, A. (2009, November 26). BHP Billiton cautious on pace of global economic growth. The
Australian, p. 3.
If electronic, give the URL of the newspaper homepage.

(Brody, 2007)
Newspaper article
– no author

Press release

In-press article

Brody, J. E. (2007, December 11). Mental reserves keep brain agile. The New York Times. Retrieved
from: http://www.nytimes.com

(“Ingenuity and Hard Work,” 2009)

Ingenuity and hard work - 20 years of internet in Australia. (2009, November 26). Sydney Morning
Herald, p. 35.

Use a short title with capitalisation
and enclosed in quotation marks.

If electronic, give the URL of the newspaper homepage as above

(Watersmith, 2000)

Watersmith, C. (2000, March 1). BHP enters new era [Press release]. Melbourne, Vic: BHP Limited.

(King Fish Media, 2010)

King Fish Media. (2010). The perfect marriage of content and technology: Is social media the new
CRM? [Press release]. Retrieved from http://www.prnewswire.com\news-releases\the-perfectmarriage-of-content-and-technology-is-social-media-the-new-crm-100760344.html

(Briscoe, in press)

Briscoe, R. (in press). Egocentric spatial representation in action and perception, Philosophy and
Phenomenological Research. Retrieved from http://cogprints.org/57801/ECSRAP.F07.pdf
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Electronic
Sources

In-Text Example

Reference List Examples

Full text journal from
an electronic
database - DOI
available

(Pope & Owen, 2009)
OR
As Pope and Owen (2009) state…

Pope, J., & Owen, A. D. (2009). Emission trading schemes: Potential revenue effects, compliance costs
and overall tax policy issues. Energy Policy, 37, 4595-4603. doi:10.1016/j.enpol.2009.06.014

Full text journal from
an electronic
database - DOI not
available

(Marshall & Anderson, 2008, p.464)
OR
As Marshall and Anderson (2008,
p.464) state…

Marshall, K., & Anderson, J. (2008). The Emperor's new clothes: A meta-study of education technology
policies in Ireland, North and South (1996-2006). Computers & Education, 50(2), 463-474. Retrieved
from http://www.sciencedirect.com

If the article is in .pdf format, cite the
page number. If it is in .html format,
cite the paragraph number.
Full text journal from
an electronic
database – no
author

The Internet has had a huge impact on
the Australian economy (“Mobile Phone
Addiction,” 2010)…
Put title in quotation marks.

Where the page numbers in the entire volume run consecutively, do not use issue number after
the volume number.

APA recommends using the journal homepage. However, for practical reasons the University has
adopted the gateway URL as this will be easier for students. Shorten URL.
Include the issue number if the journal is paginated by issue.

Mobile phone addiction: A point of issue. (2010). Addiction, 105, 373-374. Retrieved from http://
proquest.umi.com
Where the page numbers in the entire volume run consecutively, do not use issue number after
the volume number.
Shorten URL

Full text newspaper,
newswire or
magazine from an
electronic
database – no
author

(“Call to Save Indigenous Languages,”
2009)

Call to save indigenous languages. (2009, October 31). The Canberra Times. Retrieved from
http://global.factiva.com

Put title in quotation marks. Shorten
title if necessary.

Shorten URL

Full text from
Internet – more
than 7 authors

(Keogh et al., 2009, p.256)

Keogh, L. A., van Vliet, C. M., Studdert, D. M., Maskiell, J. A., Macrae, F. A., St John, D. J., … Jenkins, M.
A. (2009). Is the uptake of genetic testing for colorectal cancer influenced by knowledge of insurance
implications? Medical Journal of Australia, 191(5), 255-258. Retrieved from http://www.mja.com.au/
public/issues/191_05_070909/keo11470_fm.pdf

If an article is in .pdf format, cite the
page number. If it is in .html format,
cite the paragraph number.

For works with more than 7 authors, list the first 6 authors, followed by 3 fullstops (…) then spell
out the last author’s name.
For other author variations refer to page 3.
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Article from Curtin
E-Reserve

(Flahvin, 1997, p.12)

Flahvin, A. (1997). Sattin and the spectre of media liability for negligence. Communications Law
Bulletin, 16(4), 11-14. Retrieved from http://edocs.library.curtin.edu.au/eres_display.cgi?
url=dc60209184.pdf

Cochrane Review

(Leach & Morris, 2006)

Leach, A. J., & Morris, P. S. (2006). Antibiotics for the prevention of acute and chronic suppurative otitis
media in children. Cochrane Database of Systematic Reviews 2006, Issue 4. Art. No.: CD004401.
doi :10.1002/14651858.CD004401.pub2

World Wide Web

In-Text Example

Reference List Examples

Document on
WWW

(Steel, 2008 )

Steel, W. (2008). Hints for web authors. Retrieved from http://www.mcsr.olemiss.edu/~mudws/
webhints.html

Document on
WWW – No
author

(“British Empire 1922,” 2009, para.4)

British Empire 1922 and other empires. (2009). Retrieved from http://www.angelfire.com/mac/
egmatthews/worldinfo/europe/empire.html

Document on
WWW – No date

(Royal Institute of British Architects, n.d.)

Image on the web

The photo “Autumn Ivy” (Curtin University
Library, 2007)......

Curtin University Library. (2007). Autumn ivy [Image]. Retrieved from http://www.flickr.com/photos/
curtinuniversitylibrary/1440410713/

Entire Website not
specific document

Give the URLof the site in the text
Kidspsych is a children’s website (http://
www.kidspsych.org).

No entry required in the reference list

Secondary
Sources
Book

In-Text Examples

Reference List Examples

… including neuralgia (Carini & Hogan, as
cited in Thibodeau & Patton, 2002, p. 45)
OR
Carini and Hogan’s study (as cited in
Thibodeau & Patton, 2002, p. 45)

Thibodeau, G. A., & Patton, K. T. (Eds.). (2002). The human body in health and disease. St. Louis, MO:
Mosby.

Carini and Hogan’s study (as cited in Patton,
2002)
OR
“… origins of neuralgia” (Carini & Hogan, as
cited in Patton, 2002, p. 2154)

Patton, K. T. (2002). Neuralgia and headaches. Science, 400, 2153-55.

Journal article

Use paragraph numbers for .html
documents.
Royal Institute of British Architects. (n.d.). Becoming an architect. Retrieved from
http://www.architecture.com/EducationAndCareersBecomingAnArchitectBecominganarchitect.aspx

Record the book that you actually used.

Record the journal that you actually used.
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Government
Publications
Acts of
Parliament
(including bills)

In-Text Example

Reference List Examples

The Commonwealth’s Copyright Act
1968…
(In future references, omit date)

Legislation is included in a list of references only if it is important to an understanding of the work.
Set the list apart from the main body of the reference under the subheading 'Legislation'.
Essential elements:
Short Title of Act (Jurisdiction) eg: Copyright Act 1968 (Cth)
When using a section in an Act, you can do a pinpoint reference eg: Criminal Code WA, s. 348
If legislation is obtained from an electronic database, add a retrieved statement as for electronic
journal articles.

Case

(John Fairfax Publications Pty Ltd v
Gacic, 2007)

John Fairfax Publications Pty Ltd v Gacic [2007] HCA 28
If case is obtained from an electronic database, add a retrieved statement as for electronic journal
articles.

Australian Bureau
of Statistics
Bulletin

(Australian Bureau of Statistics, 2008)
OR
(Australian Bureau of Statistics [ABS],
2008) and for subsequent citations use
(ABS, 2008)

Statistics from the
Australian Bureau
of Statistics
website

(Australian Bureau of Statistics, 2008)

Census
Information

(Australian Bureau of Statistics, 2006)

Government
Report

Australian Bureau of Statistics. (2008). Childhood education and care (No. 4402.0). Canberra, ACT:
Author.
The word ‘Author’ is used as the publisher when the author and publisher are the same

Australian Bureau of Statistics. (2008). Childhood education and care (No. 4402.0). Retrieved from
http://www.abs.gov.au

See above

See above
(Bureau of Infrastructure, Transport and
Regional Economics, 2010)

Australian Bureau of Statistics. (2006). Census of population and housing: B01 selected characteristics
(First release processing) postal area 6050. Retrieved http://www.censusdata.abs.gov.au

Bureau of Infrastructure, Transport and Regional Economics. (2010). Aircraft movements through capital
city airports to 2029-30 (Report 117). Retrieved from http://www.bitre.gov.au/publications/55/Files/
Report%20117.pdf

Patent

U.S. Patent No. 66991798-B1 (2004)
OR
(U.S. Patent No. 66991798-B1, 2004)

Lindsay, S. J. (2004). U.S. Patent No. 66991798-B1. Derwent Innovations Index: United States Patent
Office.

Standard

(Standards Australia, 1997)

Standards Australia. (2010). Child restraint systems for use in motor vehicles (AS/NZ 1754:2010).
Retrieved from http://www.saiglobal.com
Shorten URL
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Other Sources

In-Text Example

Reference List Examples

Thesis or
Dissertation—
unpublished

(Ciccarelli, 2008, p. 89)

Ciccarelli, M. L. (2008). Variation of posture and muscle activity during information and communication
technology use by adults and school children. (Unpublished doctoral dissertation). Curtin
University of Technology, Bentley, W. A.

Thesis or
Dissertation—
published available
from an institutional
database

(Dwyer, 2009, p. 152)

Dwyer, R. (2009). Agency and exchange: An ethnography of heroin marketplace. (Doctoral
dissertation). Retrieved from http://espace.library.curtin.edu.au

Conference paper
in Proceedings

(Prayag & Ramjee, 2009)
OR
As discussed by Prayag and Ramjee
(2009)

Shorten URL

Prayag, I. L., & Ramjee, R. (2009). The impact of Newcastle disease control on smallholder poultry
production in Mauritius. In R. G. Alsers, P. B. Spadbrow, & M. P. Young (Eds.), Village chickens,
poverty alleviation and the sustainable control of Newcastle disease: Proceedings of an
international conference held in Dar es Salaam, Tanzania, 5-7 October 2005 (pp. 132-134).
Canberra, ACT: Australian Centre for International Agricultural Research.
In the case of conference proceedings available electronically, replace publisher and location
details with the DOI where available or URL in the absence of DOI.

Brochure

(Research and Training Centre on
Independent Living, 2008, p. 2)

Research and Training Centre on Independent Living. (2008). Guidelines for reporting and writing about
people with disabilities (11th ed.) [Brochure]. Melbourne, Vic: Author.
Add Author for the publisher when the author and publisher are the same.

Personal
communication, email and discussion
lists with no web
archive

It was confirmed that an outbreak
occurred in London (S. Savieri,
personal communication, April 24,
1999)

Not included in reference list as they cannot be traced by the reader.

Lecture notes

(Brieger, 2005)

Brieger, B. (2005). Lecture 3: Recruitment and involvement of trainees [PowerPoint slides]. Retrieved
from http://ocw.jhsph.edu/courses/TrainingMethodsContinuingEducation/lectureNotes.cfm
These are treated like books if they are published, but like personal communication if they are your own notes
or unpublished. Lecture notes are considered published if they have been copied and distributed in print or on
the web with the instructor's permission.
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Other Sources

In-Text Example

Reference List Examples

Films and
videorecordings of
films.

(Scorsese & Lonergan, 2000)

Scorsese, M. (Producer) & Lonergan, K. (Writer/Director). (2000). You can count on me [Motion picture].
Hollywood, CA: Paramount Pictures.

DVDs and
videorecordings

(American Psychological Association,
2000)

American Psychological Association. (Producer). (2000). Responding therapeutically to patient
expressions of sexual attraction [DVD]. Washington, DC: Author.
The word ‘Author’ is used as the publisher when the author and publisher are the same

Video file
(e.g. YouTube
video)

(markapsolon, 2011)

markapsolon. (2011, September 9). Real ghost girl caught on Video Tape 14 [Video file]. Retrieved from
http://www.youtube.com/watch?v=6nyGCbxD848
Use the screen name markapsolon as it appears online.
If the user’s real name is available list it first, followed by the screen name in brackets
[markapsolon]

Web streaming
video

Fukuyama (2006) recalled that...

Fukuyama, M. (2006). At the corner of me and myself: Voices of multiple social identities [Streaming
video]. Hanover, MA: Microtraining Associates. Retrieved from
http://ctiv.alexanderstreet.com.dbgw.lis.curtin.edu.au/View/535741

Television and
radio programmes
-single episode in a
series

(Thomason, Rudd, & Fineri, 2007)

Thomason, M., Rudd, P., & Fineri, W. (Writers/Directors). (2007). North West Passage [Television series
episode]. In T. Wright (Supervising Producer), Captain Cook: Obsession and discovery. Melbourne,
Vic: Film Australia.

Television and
radio programmes
-series or single
programme

Leonard and de Pieri (2009)

Leonard, D. (Producer), & de Pieri, S. (Presenter). (2009). A gondola on the Murray [Television series].
Melbourne, Vic: ABC Television.

Podcast

(Seega & Swan, 2005)

A single programme is called a Television broadcast. Specify the broadcast date for a single
programme.
Seega, B. (Producer), & Swan, N. (Presenter). (2005, November 28). Adult ADHD [Audio podcast].
Retrieved from http://www.abc.net.au/rn/talks/8.30/helthrpt
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Blog post and reply

McDonald (2010) suggests that...

McDonald, S.(2010, September 27). Noise in the library. [Web log post]. Retrieved from
http://blogs.curtin.edu.au/library/2010/09

(the smart one, 2010)

the smart one. (2010, October 3). Re: Noise in the library. [Web log comment]. Retrieved from
http://blogs.curtin.edu.au/library/2010/09

Use the screen name for the author
of a blog post, if the author has
adopted one.
Computer
Software

(Miller, 1993)

Include full URL
Miller, M. E. (1993). The interactive tester (Version 4.0) [Computer software]. Westminster, CA: Psytek
Services.

Instead of author use the Programmer or Rightsholder
ERIC document
(microfiche)

Davis and Lombardi (1996) put forward
the proposal that…

Davis, R. K., & Lombardi, T. P. (1996). The quality of life of rural high school special education graduates.
In Rural goals 2000: Building programs that work [Microfiche]. (ERIC Document No. ED394765).

E-mail discussion
list – web archive

(cindiann, 2009)

cindiann. (2009, July 23). Re: Recommended photography books [Online discussion group comment].
Retrieved from http://www.flickr.com/groups/365libs/discuss/72157621780867836/
Use the screen name (or nickname) the author adopts if this is used in the discussion group entry.

Twitter

(BarackObama, 2009)
To cite a Twitter feed as a whole or to
discuss it in general give the site URL
in text, inside parentheses. There is no
need for a reference list entry.

Facebook

(Barack Obama, 2009)
To cite a Facebook feed as a whole or
to discuss it in general give the site
URL in text, inside parentheses. There
is no need for a reference list entry.

BarackObama. (2009, July 15). Launched American Graduation Initiative to help additional 5 mill.
Americans graduate college by 2020: http://bit.ly/gcTX7 [Twitter post]. Retrieved from
http://twitter.com/BarackObama/status/2651151366

Barack Obama. (2009, October 9). Humbled. http://my.barackobama.com/page/community/post/
obamaforamerica/gGM45m [Facebook update]. Retrieved from http://www.facebook.com/
posted.php?
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Introduction: Welcome to Thomson Reuters
EndNote X5
EndNote—your complete reference
solution!


EndNote is an online search tool—you can search online
bibliographic resources and retrieve references directly into
your EndNote library. You can also export references to
EndNote from your favorite online resource (see “Direct
Export Providers” in EndNote Help).



EndNote is a reference and full text organizer with a
collaborative Web tool—your personal reference library will
save you countless hours of organizing your research. Group
references according to your research projects and attach up
to 45 files per record for managing related materials.
EndNote can locate full text PDF files for you or create a
reference when importing a PDF file. Transfer references,
and now file attachments, to your EndNote Web account to
share groups with other EndNote users easily and manage
your ResearcherID publication list.



EndNote is a bibliography maker—Cite While You Write™
takes the pain out of citing and formatting references in Apple
Pages ‘09, Microsoft® Word, and OpenOffice.org Writer 3 for
Windows. You can also create bibliographies for other word
processors using Format Paper (RTF files). There is simply
no better tool than EndNote for handling diverse
bibliographic style requirements.

EndNote and EndNote Web are collaborative tools to simplify
working with colleagues.
See “What’s New in EndNote X5” on page 9 for a list of the most
recent features added to EndNote.
For late-breaking news and updates, please go to:
http://www.endnote.com/support.

About the Demonstration Version of
EndNote and the EndNote Viewer
If you are working with the demonstration version of EndNote,
you have 30 days after you first use the program to evaluate
EndNote and all of its features. After those 30 days are up, the
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demonstration version reverts to a feature-restricted EndNote
Viewer.
NOTE: While you can see the entire list of Microsoft Word templates
available with the full version of EndNote, the demonstration version
includes only the Nature manuscript template specifications. Any of the
manuscript templates you choose will launch the Nature manuscript
template.

After the program reverts to an EndNote Viewer, you can still
open EndNote libraries, search, sort, and print references.
With the EndNote Viewer you will not be able to:


Add or edit references in a library that has 10 or more
references already in it.



Format more than 10 citations in a paper.



Retrieve more than 10 references from a remote database.



Import more than 10 references.



Export more than 10 references at one time.

To purchase an unrestricted version of the EndNote program,
open your trial version, and then click the Yes button when the
EndNote dialog appears with the message:
Would you like to activate the full version of EndNote?
You will need to purchase a product key in order to activate the
unrestricted version of EndNote.
If you are upgrading from a previous version of EndNote, then
you need to supply the product key and provide your name in the
Name field.

About this Getting Started Guide
This guide provides a basic overview of installing and using
EndNote. It is not a complete user’s guide, but rather is intended
as a guided tour to show you the highlights of the EndNote
program.
This guide assumes that you know how to use your Macintosh or
Windows operating system and your word processor. For help on
these topics, consult the documentation that comes with these
product.
Because this guide serves both Macintosh and Windows users,
screen representations alternate between the Macintosh and
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Windows versions. While the two platforms are essentially the
same, there may be slight differences between the pictures
shown in this guide and the windows that appear on your
computer screen.
Often there is more than one way to select a command in
EndNote. A single command may be available from one of the
main menus, from a context-sensitive Control+click (Macintosh)
or right-click (Windows) menu, from a toolbar, or with a keyboard
command. In most cases, this manual gives instructions for
selecting commands from the main menus. If a menu command
has a keyboard equivalent, the keyboard command appears next
to the menu item.

Customer Services
Register Your
Copy of
EndNote

You can register your software by either 1) creating or upgrading
your EndNote Web account the first time that you start EndNote
X5, or 2) by going to http://www.endnote.com/register.
Registered users receive:


Free technical support



Special upgrade offers



Notification of new EndNote versions that are compatible
with the latest version of your word processor

NOTE: Even if you purchased EndNote directly from Thomson Reuters,
do not assume that you are registered.

EndNote
Online Help

Online Help: From EndNote’s Help menu, select EndNote Help
(Macintosh) or Contents (Windows) to view the various topics. For
context-sensitive help, click the Help or ? button found on various
windows and dialogs or press the F1Help key on your keyboard.
The EndNote Manual: The online Help file is made available as
a printable PDF file and is available from the “Overview of
Thomson Reuters EndNote” topic in EndNote Help.
Release Notes: For documentation updates and correction
notes for this release, refer to the Readme.txt file installed in the
EndNote folder.
Late Breaking News: For late-breaking news and updates, go to
http://www.endnote.com/support.
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Customer
Service

Contact Sales for general product information, pricing, quantity
discounts, and referrals to dealers.
Contact Customer Service to order new copies or upgrades of
EndNote, to check billing/shipping status, and to register your
software.

Sales Information
Phone:
Phone:
Fax:
Web/Email:

1 800 722 1227 (Toll Free)
760 438 5526 (country code is 01)
760 438 5573 (country code is 01)
http://www.endnote.com/contact

Customer Support (Orders, Billing, and Shipping)
Phone:
800 336 4474 (country code is 01)
Fax:
215 386 2911 (country code is 01)
Web/Email: http://www.endnote.com/contact

Support

Contact Technical Support if you encounter problems while using
EndNote. When you contact us, please have a clear description
of the problem and know the version of your Windows operating
or Macintosh system, EndNote, and word processor. To find the
EndNote version and serial number, start EndNote and select
About EndNote from the EndNote menu (Macintosh) or the Help
menu (Windows).
For web/email or phone contact, including hours and holiday
closures, please go to:
http://www.endnote.com/contact
Technical support tips are also available from the
www.endnote.com/support Web site and the EndNote Discussion
Forum.

International
Customer and
Technical
Support

For customer support or technical support outside of North
America, visit our Web site to check for a local distributor.

Online
Support

EndNote Web Site
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Go to http://www.endnote.com/distributors to find contact
information for your local EndNote support.

The EndNote Web site (http://www.endnote.com) contains free
training options including online videos and Web classes, a
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technical support knowledge base, and information on the latest
versions of EndNote. You can also find updated styles, filters,
and connection files available for download.
EndNote Discussion Forums
If you wish to join an ongoing forum of EndNote users like yourself,
go to http://www.endnote.com/forum. You can browse several
EndNote message lists, easily search for topics, and join to add
messages.
Join the EndNote social network at:

ADA VPAT



www.facebook.com/EndNote



www.twitter.com/EndNoteNews



www.youtube.com/endnotetraining

Thomson Reuters is dedicated to developing software products
that are usable for everyone, including those with physical
challenges and disabilities. EndNote was designed to adhere to
the ADA (Americans with Disabilities Act) Section 508
accessibility standards.
Visit our Web site at http://www.endnote.com/vpat to access the
VPAT (Voluntary Product Accessibility Template) document that
describes the accessibility features that address the Section 508
Standards.
The VPAT is an informational tool developed by industry and
government to help facilitate the understanding of compatibility
issues under Section 508.

What’s New in EndNote X5
The current release of EndNote includes the following new
features:


Add and transfer file attachments to references in your
EndNote Web account for greater mobility. Upgrade or
create your Web account with your EndNote X5 license to
receive this expanded feature.



View and annotate PDF files in the EndNote library new PDF
& Quick Edit tab.



Find Reference Updates on the Record Edit window to
retrieve additional online data such as the PMCID required
for NIH grants.
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Select a new citation option – Author (Year) – within the Find
& Insert My References dialog in Cite While You Write.



Save time with new conditional formatting – substitute empty
fields with alternates such as “Volume and Pages” with DOI.
Support includes DOI, PMCID, and Editor/Translator
conditions.



Review duplicate references quickly with new auto-highlights
for each field where differences are found.



View the new Music reference type as well as new fields for
NIHMSID and Article Number.



Select from an expanded set of bibliographic styles, import
filters, and connection files installed by default – or add more
through customizing.

NOTE: Thomson Reuters recommends that you view our What’s New
video at www.endnote.com/training or on your EndNote X5 CD.
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Chapter 1: Macintosh EndNote Installation
Before You Install EndNote
Please read this section before you proceed with the installation.
If you are installing the full version of EndNote (not the Demo
version), you will need a valid EndNote product key to install the
program. If you are upgrading from a previous version, you will
also need your previous EndNote product key or serial number.

Program
Requirements

Both the full EndNote program and the EndNote Demo are
available on CD or by downloading. If you have a CD you need a
CD-ROM drive to install the program.
System Requirements
EndNote runs under Macintosh OS X (Intel only) versions 10.5.x
(Leopard), 10.6.x (Snow Leopard), and 10.7 (Lion).
In the Finder, select About This Mac from the Apple menu to find
your system version.
See the readme file on our Web site at http://www.endnote.com
for the latest compatibility information about EndNote and
released Apple operating systems.
Hardware Requirements
EndNote requires the following hardware:


A Macintosh OS X (Intel only) 450 MHz or higher



A hard drive with at least 400 MB of free space



A minimum of 256 MB of available memory (RAM)



In order to use EndNote’s Connect command, an Internet
connection is required. To use the Open Link command to
access a Web site, you also need a Web browser installed.

NOTE: Make sure that your computer meets the system and hardware
requirements before continuing. If necessary, contact the distributor,
dealer, or store where you purchased EndNote to arrange for a full
refund. If you have any problem obtaining a refund, contact Thomson
Reuters directly. You must do so within 30 days of purchase.
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NOTE: For Mac, check www.endnote.com/enmac.asp for the
latest compatibility requirements.

Word
Processor
Compatibility

As of September 2011, EndNote for Macintosh is compatible
with:


Microsoft Word 2008 (SP1) and 2011



Apple iWorks Pages ‘09 versions 1, 2.x, 3.x, and 4.x



RTF files created with most word processors, including:
Microsoft Word, WordPerfect, OpenOffice.org Writer,
StarOffice, Nisus Writer, TextEdit, Mellel, and Scrivener.

NOTE: Endnote can also scan RTF documents created by
Mariner Write if the documents are saved in Word's RTF and not
Mariner Write's RTF.
Cite While You Write in Microsoft Word
EndNote’s Cite While You Write commands are available for
Microsoft Word 2008 and 2011.
These Cite While You Write functions put an EndNote submenu
of commands on Word’s Tools menu. They also allow EndNote
to format citations and create a bibliography for the document
that is open in Word. You can format, unformat, and reformat a
single document without ever exiting your word processor.
If Microsoft Word 2008 or 2011 is installed on your computer, the
appropriate Cite While You Write files are installed automatically
when you run the EndNote installation.
Keep in mind that in order for Cite While You Write to install
properly:

12



Microsoft Word must be correctly installed on your computer
prior to installing EndNote.



All applications, including Microsoft Word, must be closed
during the installation of EndNote.



The EndNote installer must be able to locate the Word
startup folder. You need to have full read and write access to
Word’s startup folder in order to install EndNote commands.
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Cite While You Write in Apple iWorks Pages ‘09
EndNote commands are available on the Insert and Edit menus
in Pages ‘09.
RTF and ODT Documents
For word processors other than Word, write your paper, insert intext citations, and then save to an RTF or ODT file to use
EndNote’s Format Paper feature to format the citations and
bibliography.

EndNote Installation
Follow these instructions to install the EndNote program.
If you are upgrading from a previous version of EndNote, please
see“Upgrading from an Earlier EndNote Version” on page 14
before installing EndNote X5.
If you have purchased a Volume/Site License version of
EndNote, please see “Networks and Volume Installations” in
EndNote Help.

Installing
EndNote

To install EndNote:
1. Make sure no applications are running—including virus
protection software and Microsoft Word.
2. Start the EndNote installation program.
If you downloaded the EndNote installer: Double-click the
disk image to display an EndNote X5 folder.
If you received EndNote on a CD: Insert the EndNote CD
into your CD-ROM drive. If the installer does not launch
immediately, double-click the EndNote X5 Site Installer to
display an EndNote X5 folder.
3. Drag the EndNote X5 folder to the Applications folder on your
hard drive.
NOTE: The EndNote folder must reside in the Applications folder in
order to use the Services menu from EndNote and Spotlight searching.

4. Double-click on the Applications folder, then the EndNote X5
folder, then the EndNote X5 application icon in order to
launch EndNote and a Customizer program.
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5. Follow the instructions on the screen to complete the
installation. Click the Next button to move forward as needed
through the installation dialogs:
Welcome: Thank you for purchasing EndNote!
Registration Key: If you are installing the full version of
EndNote, enter your EndNote product key. You must enter a
valid product key to continue with the installation of the full
version of EndNote. The product key can be found in the
EndNote X5 CD packaging or on the order confirmation of
your digital product.
If you are installing the Demo version, select the button to
evaluate EndNote. You do not need a product key or serial
number to install the Demo version of EndNote.
User Information: Enter your name and organization.
If you are upgrading from a previous version, you will also
need your previous EndNote product key or serial number.
Read Me: Read late-breaking news about this version of
EndNote.
License Agreement: You must select “I accept the license
agreement” in order to continue with the installation.
Product Registration: Please register your copy of
EndNote!
When you start EndNote, a Customizer automatically installs Cite
While You Write files for Microsoft Word 2008 and 2011 if any of
them are found on your computer.
To make sure the EndNote program is installed correctly, see
“Checking Your Installation” on page 17.
NOTE: If you use a non-English version of Word, see page 18.

Upgrading from an Earlier EndNote
Version
While it is not strictly required, we recommend that you uninstall
older versions of EndNote before installing your new version of
EndNote.
Back up your files
Before you begin, it is important to back up your EndNote
libraries (including corresponding .DATA folders), custom styles,
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import filters, connection files, and spell check dictionaries, as
well as any Word documents that use Cite While You Write.
Uninstall the older version of EndNote
It is best to check the uninstall instructions supplied with your old
version of EndNote, as the instructions below are not valid for all
older versions of EndNote.
1. Start the older version.
2. From the EndNote menu, select Customizer.
3. Select all of the options, and then click Uninstall.
4. Click Next and follow the prompts.
Install EndNote X5
Install the upgrade just as you would a new installation. See
“EndNote Installation” on page 13. During installation, you will
need to enter both your new EndNote X5 product key and your
old EndNote product key or serial number. EndNote X5 is
installed into an EndNote X5 folder.
After installing EndNote X5, you may have two folders with each
containing EndNote files.
If you have backed up customized styles, filters, or connection
files, you should also copy them to the Styles, Filters, or
Connections folders in the EndNote X5 folder. EndNote includes
a full collection of updated files, so unless you have specially
customized a file for your needs, there is no reason to copy the
old files.
To copy custom dictionaries from EndNote X or earlier versions
to the new Mac OS spell checker, see “Importing Dictionaries” in
EndNote Help.
Once you have copied your customized files and libraries to the
EndNote X5 folder, and EndNote X5 is up and running, you can
drag any remaining items in the old EndNote folder to the Trash.
Be careful not to delete any libraries, papers, or other items that
you need.
To make sure that EndNote is using the most recent set of
files:
1. Start EndNote.
2. Go to the EndNote menu and select Preferences.
3. Click on the Folder Locations item.
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4. If the folder paths do not include an EndNote X5 folder, click
EndNote Defaults to update the paths.
Cite While You Write Users
If you have a Microsoft Word document that was formatted with
an earlier version of EndNote, we recommend that you first make
a backup of the file.
If the file was created with EndNote 5-X2, use the new version of
EndNote to format the document again. From Word’s Tools
menu, select EndNote X5, and then select Format Bibliography.
This updates the document to work with EndNote X5.
If the file was originally created with an even older version of
EndNote, you will need to unformat the citations with the old
version of Word and the original EndNote Add-in before the
document can be used by EndNote X5. If you no longer have
access to the older version of Word or the old EndNote Add-in for
Word, please contact Technical Support.

Opening and
Converting
Old EndNote
Libraries

EndNote X5 opens and uses libraries created with EndNote 8
and later. It converts libraries created with even earlier versions
of EndNote to the latest file format.
To convert an older EndNote library:
1. Start EndNote.
2. From the File menu, select Open, and then select Open
Library.
3. On the file dialog, locate and highlight the old library, and
then click Open.
EndNote will warn you that the selected library was created
with an older version, and will ask for permission to convert it.
4. Click OK to convert the library. Name the new library and
click Save. The conversion makes a copy of the original
library in the latest file format and leaves the original library
intact.
NOTE: Once you have opened and used a library with EndNote X5, you
should use the library only with version X or later.
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Using Old
Style, Filter,
and
Connection
Files

You may have created custom content files with an earlier
version of EndNote. EndNote X5 can use your custom styles,
filters, and connection files that were created with EndNote
versions 4.0.1-X2. Once you edit and save one of these files with
EndNote X5, it is converted to the latest format, which can be
used with EndNote versions 8 to X5.
All of the styles, filters, and connection files supplied with
EndNote X5 have been updated to the latest format. The new
filter and connection files can be used by previous versions of
EndNote, with new fields simply ignored. However, the updated
styles cannot be used with versions of EndNote prior to version 8.
Customized reference types, temporary citation markers, and
display fonts are all carried over from earlier versions of EndNote
for use with EndNote X5.

Checking Your Installation
To Begin
Using
EndNote

To run EndNote, double-click the EndNote X5 icon found in the
EndNote X5 folder.
If this is the first time you have started EndNote, a Customizer
will attempt to install Cite While You Write files for Word.
Next, a dialog may ask whether you want to open a new EndNote
Web account. For information about EndNote Web, see
“Transferring References between EndNote Web and EndNote”
in EndNote Help.
Then, a dialog will ask you to open a reference library file. You
can create or open an EndNote library, or select Close. A Sample
Library is provided in an Examples folder to help you get familiar
with EndNote.
To check the EndNote version number, go to the EndNote menu
and select About EndNote. Click the splash screen to clear it.

Checking
Support for
Microsoft
Word

To see whether Cite While You Write is correctly installed:
Start EndNote, then start Microsoft Word, and then select the
Tools menu.
You should see EndNote’s Cite While You Write commands on
an EndNote X5 submenu in Word.
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If you do not see these commands, Word support was not
correctly installed. Try these three ways to install CWYW (after
each attempt, start EndNote and then Word to check for an
EndNote submenu on the Tools menu in Word):
1. Use the Customizer:
a. Make sure no applications are running—including virus
protection software and Microsoft Word.
b. Start the EndNote program.
c.

From the EndNote menu, select Customizer.

d. On the Component Selection dialog, select the
components you want to install (or keep installed) and
click Next.
2. Try reinstalling EndNote as described under “EndNote
Installation” on page 13.
3. Install the files manually as described in EndNote Help.

Non-English
Versions of
Word

The EndNote installer uses English terms for the various target
folders in the installation (such as “Word Startup Folder”). If you
are running a version of Word localized for a different language,
you may need to install Word support manually as described in
EndNote Help.

Additional Topics
The installation chapter in EndNote Help includes these
additional topics:


Installed Files



Custom Installations/Adding Content Files
The EndNote team has developed thousands of content files
(output styles, filters, and connection files). Because
installing all of these files can slow performance, a typical
EndNote installation includes only the most popular of each
type of file. It is easy to find and install additional content
files!
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Manually Installing Support for Word 2008 or 2011



Updating EndNote Files



Uninstalling EndNote
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Chapter 2: Windows EndNote Installation
Before You Install EndNote
If you are installing the full version of EndNote (not the Demo
version), you will need a valid EndNote product key to install the
program. If you are upgrading from a previous version, you will
also need your previous EndNote product key or serial number.

Program
Requirements

Both the full EndNote program and the EndNote Demo are
available on CD or by downloading. If you have a CD you need a
CD-ROM drive to install the program.
System Requirements:
EndNote runs under the following operating systems:


Windows 7 (32 or 64 bit versions)



Windows Vista (32 or 64 bit versions)



Windows XP with at least Service Pack 3 installed

Hardware Requirements:


A minimum of 256 MB of available RAM



A hard drive with at least 400 MB of free space



An Internet connection is required to access online
databases using the EndNote Online Search feature, to run
the Find Full Text feature, and to transfer references to and
from EndNote Web. You will also need a Web browser to use
the OpenURL Link and Open URL commands.



Unicode compliant

NOTE: Make sure that your computer meets the system and hardware
requirements before continuing. If necessary, contact the distributor,
dealer, or store where you purchased EndNote to arrange for a full
refund. If you have any problem obtaining a refund, contact Thomson
Reuters directly. You must do so within 30 days of purchase.

NOTE: For Windows, check www.endnote.com/enwin.asp for the latest
compatibility requirements.

Chapter 2: Windows EndNote Installation

19

Word
Processor
Compatibility

As of June 2011, EndNote for Windows is compatible with:


Microsoft Office Word 2003, 2007, or 2010 (32 or 64 bit
versions) for Windows



Open Document Format (ODT) documents created with
OpenOffice.org Writer 3



RTF files created with most word processors, including:
Microsoft Word, WordPerfect, OpenOffice.org Writer,
StarOffice, and WordPad



Wolfram Mathematica 8

Microsoft Word
EndNote installs Cite While You Write commands in Microsoft
Word.


Word 2003 displays an EndNote submenu of commands on
Word’s Tools menu.



Word 2007 and 2010 displays Cite While You Write
commands on an EndNote tab.

Cite While You Write allows EndNote to format citations and
create a bibliography for the document that is open in Word. You
can format, unformat, and reformat a document without exiting
your word processor.
In order for Cite While You Write to install properly, Microsoft
Word 2003, 2007, and 2010 must be correctly installed on your
computer prior to installing EndNote. Please make sure that you
close Word and all applications before attempting to install Cite
While You Write.
If a supported version of Microsoft Word is installed on your
computer, the appropriate Cite While You Write files are installed
automatically for the current user when you run the EndNote
installation. This feature can be used with a shared copy of Word
or on a network.
OpenOffice.org Writer
EndNote installs Cite While You Write commands in the
OpenOffice.org version 3 Writer. CWYW commands appear on
an EndNote menu. Cite While You Write allows EndNote to
format citations and create a bibliography for the document that
is open in OpenOffice.org Writer. You can format, unformat, and
reformat a document without exiting your word processor.
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In order for Cite While You Write to install properly, the
OpenOffice.org 3.x suite must be correctly installed on your
computer prior to installing EndNote.
You must close all OpenOffice.org applications before installing
Cite While You Write, including the OpenOffice.org Quickstarter.
RTF and ODT Documents
For word processors other than Word 2003, Word 2007, Word
2010, or OpenOffice.org 3.x, first write your paper and insert intext citations. If the file format is anything other than an
OpenOffice.org ODT document, save as an RTF file. Then, use
EndNote’s Format Paper feature to format the citations and
bibliography from your ODT or RTF file.

EndNote Installation
Follow these instructions to install the EndNote program.
If you are upgrading from a previous version of EndNote, please
see “Upgrading from an Earlier EndNote Version” on page 27.
See “Networks and Volume Installations” in EndNote Help for
information about using EndNote in a network environment,
licensing, and performing mass installations.

Installing
EndNote

To install EndNote:
1. Log in to the local machine with administrative rights or as a
user with program installation privileges. Make sure no
applications are running, including virus protection software,
Microsoft Word, or any OpenOffice.org applications.
The OpenOffice.org Quickstarter may appear in your System
tray. Right-click on the icon, and then select Exit
Quickstarter.
2. Start the EndNote installation program.
If you downloaded the EndNote installer: Double click the
installer file to start the EndNote Setup program.
If you received EndNote on a CD: Insert the CD into your
CD-ROM drive.
The EndNote Setup program will start. If you do not have
Autoplay enabled, select Run from the Start menu, type
“d:\setup” (use the drive letter appropriate to the drive
containing the installation CD), and then press Enter.
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3. Follow the instructions on screen to complete the installation.
Use the Next button to move forward between the installation
dialogs.
Welcome: Thank you for selecting EndNote!
Registration Information: If you are installing the full
version of EndNote, enter your EndNote product key. You
must enter a valid product key to continue with installation of
the full version of EndNote. The product key can be found in
the EndNote X5 CD packaging, or on the order confirmation
of your digital product.
If you are installing the Demo version, select the appropriate
button. You do not need a product key or serial number to
install the Demo version of EndNote.
User Information: Enter your name and organization.
If you are upgrading from a previous version, you must also
enter your previous EndNote product key or serial number.
Read Me Information: Read late-breaking news about this
version of EndNote.
End User License Agreement: You must select “I accept
the license agreement” in order to continue with the
installation.
Select Installation Type: “Typical” installs only the most
popular output styles, filters, and connection files. Limiting
the number of files installed speeds up performance.
Advanced users can select “Custom” to hand pick the file
groups to install, and add additional styles, filters, and
connection files.
Select Destination: By default, EndNote is installed in the
C:\Program Files\EndNote X5 folder. The Demo version is
installed in the C:\Program Files\EndNote X5 Demo folder.
You can use the Browse button to change the folder selection
if you wish.
If a previous installation of EndNote is found in the same
folder, you will be given the option to either back up or
overwrite the older files. If you back up files, they are placed
in a Backup folder in the installation folder.
NOTE: If the installer detects a full version (not a demo version) of
EndNote on your computer, it will give you the option to continue with
the installation or quit. If you continue, be advised that you will need to
reinstall your full version of EndNote to use it after you run the EndNote
X5 Demo version.
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Select Components: (Custom installations only) If you
selected a Custom installation, see “Selecting Features” on
page 26.
Select Default Citation Manager: (Microsoft Word 2007 and
2010 only) If the installer detects Microsoft Word 2007 or
2010, it asks whether to “Use EndNote as my default citation
manager.” Cite While You Write will be installed in Word
2007 or 2010 in any case, but when this item is selected the
installer will hide Word’s native Citations and Bibliography
commands (the group normally found on the References tab
in Word) in order to avoid confusion for the user.
Ready to Install: You can still click Cancel to stop the
installation. Once you click Next, the installation program will
begin installing EndNote files.
4. On the final “EndNote X5 is Successfully Installed” dialog,
click Register to register your copy of EndNote, and then
click Finish to close the installation program.
To make sure the program installed correctly, see “Checking
Your Installation” on page 29.

Installed Files

The full EndNote installation includes the following default
folders and files.

Program Folder
C:\Program Files\EndNote X5, or
C:\Program Files (x86)\EndNote X5 (64-bit Windows versions)


EndNote.exe application file



EndNote.chm Help file
You can double-click the file to view it. In the EndNote
program, select EndNote X5 Help from the Help menu.
Pressing the F1 key on your keyboard or clicking the Help or
? button in the program brings up a context-sensitive topic.



GettingStartedGuide.pdf gives a tour of the program



EndNoteHelp.pdf is a compilation of all the Help topics in the
online Help system



Readme.txt text file contains late-breaking news



Examples shortcut folder
This is a shortcut to an Examples folder that contains sample
files to follow when using the guided tour found in Chapter 3
and the Getting Started Guide. You can also use samples to
experiment while learning EndNote.
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Styles folder
This folder contains bibliographic styles for formatting
citations and a bibliography. A Typical installation includes
only the most popular styles. With a Custom installation, you
can choose from a full collection of over 4,500 bibliographic
styles.



Connections folder
This folder contains connection files to connect to and search
online bibliographic databases. A Typical installation
includes only the most popular files. With a Custom
installation, you can choose from a collection of thousands.



Filters folder
This folder contains import filters for importing text files
downloaded from online bibliographic databases. A Typical
installation includes only the most popular files. With a
Custom installation, you can choose from a collection of
hundreds.



Terms Lists folder
This folder contains journal abbreviation term lists. These
lists contain thousands of journal names and standard
abbreviations. Import a list into your library’s Journals term
list to use the abbreviations in your bibliographies.



Spell folder
This folder contains spell check dictionaries for the EndNote
spell checker.



Templates folder
This folder contains Microsoft Word templates to quickly set
up your papers for electronic submission to publishers.



Various additional folders and files are installed to support
the EndNote program and to integrate EndNote with other
software programs.

Shared Folder
Open the Shared Documents or Public Documents folder in
Windows Explorer to find the EndNote folder located at:
Windows 7: C:\Users\Public\Documents\EndNote
Windows XP: Documents and Settings\All Users\Shared
Documents\EndNote
Windows Vista: C:\Users\Public\Public Documents\EndNote


24

Examples folder
This folder contains a sample library and other sample
documents and graphics to use while learning EndNote.
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You may want to use the shared EndNote folder to store your
libraries so that they are available to all users on your
computer.

Personal Folder
Open the My Documents or Documents folder in Windows
Explorer to find the EndNote folder located at:
Windows 7: C:\Users\UserName\Documents\EndNote
Windows XP: C:\Documents and Settings\[UserName]\My
Documents\EndNote
Windows Vista: C:\Users\[UserName]\Documents\EndNote
These folders are created when you create or modify a file:


Styles folder contains new or modified bibliographic styles



Connections folder contains new or modified connection files



Filters folder contains new or modified import filters

While the Program Files folder contains the default styles,
connection files, and filters, your personal EndNote folder
contains those files that you have created or modified. This
prevents changes to the original files, and assures that you will
not inadvertently delete a customized file when you remove or
upgrade the EndNote program. It also allows you to make
changes to files even though you may not have administrator
access to modify files in the Program Files folder. EndNote
displays a single list of the files found in both locations. If a file of
the same name appears in both locations, EndNote will display
only the file found in your personal folder.
You can change your personal folder locations. See “Folder
Locations” in EndNote Help for more information.

Preferences Folder
Depending on your settings, these folders may be hidden from
view in Windows Explorer.
Windows 7: C:\Users\[UserName]\App Data\Roaming\EndNote
Windows XP: C:\Documents and Settings\[UserName]\
Application Data\EndNote
Windows Vista: C:\Users\[UserName]\App
Data\Roaming\EndNote
While many EndNote preferences are stored in the Windows
registry, some are stored in your personal preferences folder. It
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contains the connect.log file that records your latest online
search, the RefTypeTable.xml file that stores your reference type
preferences, saved search strategies, and various other settings.

Custom
Installations/
Adding
Content Files

Although we recommend that you use the Typical installation
option to install EndNote, the Custom installation option can be
useful if you are low on disk space, or if you need to reinstall only
certain EndNote components, or if you would like to add
additional content files (output styles, import filters, and/or
connection files).
To perform a new custom installation:
1. Follow the instructions for “EndNote Installation” on page 21.
2. On the Select Installation Type dialog, select Custom.
3. From the Select Features dialog, read “Selecting Features”
on page 26 to determine what you would like to select or
deselect for your installation.
NOTE: If the installer detects another copy of EndNote in the
destination folder, it gives you the option to either backup or remove
older files during the installation. When doing a custom install, only
selected components are affected. For example, if you are installing
only the Anthropology styles, and you choose to remove older files, only
the older Anthropology styles are removed; no other part of the
installation is affected.

To install components after EndNote is already installed:
1. Log in to the machine with administrative rights or as a user
with program installation privileges.
2. Do one of these:


Start the EndNote installation program.



From the Windows Start menu, select Control Panel.
Then select Add or Remove Programs. In the list, click
EndNote X5, and then click Change.

3. On the Application Maintenance dialog, select the Modify
option, and then click Next.
4. From the “Select Features” dialog, expand the list of items,
and then select or deselect the EndNote features for your
installation.

Selecting Features
There are several major categories of components that can be
installed with EndNote.
26
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The components you can select for installation include:
EndNote Application
 EndNote Program
 Sample Files



EndNote Help
Getting Started Guide

Word Templates/Add-ins:
 Templates for Microsoft Word
 Cite While You Write for Microsoft Word
OpenOffice.org Extension
Additional Styles: These formats for creating bibliographies
are grouped by type.
Additional Connections: These files for directly retrieving
references from online reference databases are grouped by
information service provider.
Additional Filters: These files for importing text files of
reference data are grouped by information service provider.
Spelling Dictionaries: These are dictionaries available for
the spell checker.
Click the plus sign next to each category to display a detailed list
of items. For each category or subcategory, click the triangle next
to the name to select from the available installation options. To
install a feature, select one of these:


Will be installed on local hard drive.



Entire feature will be installed on local hard drive.

Upgrading from an Earlier EndNote
Version
Before you begin, back up any custom styles, import filters, and
connection files that you do not want overwritten.
We strongly recommend that you uninstall any earlier version of
EndNote before you install EndNote X5. See “Uninstalling
EndNote” on page 31.
NOTE: If you do not uninstall your earlier version of EndNote, then the
Setup program will install EndNote X5 in its own folder and call the
folder EndNote X5.
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During installation, you will need to enter both your new EndNote
product key (located in the EndNote X5 CD packaging or on the
order confirmation for your digital product) and your old product
key or serial number. Note that the Demo version of EndNote
does not require these.
Install the upgrade just as you would a new installation. See
“EndNote Installation” on page 21.

Backing Up or
Replacing
Files

If you try to install EndNote X5 in the installation folder of an
earlier version of EndNote, the program alerts you and gives you
two options.


Backup older files: EndNote X5 provides complete,
updated sets of style, filter, and connection files, but if you
want to keep any of your older modified files to use with
EndNote X5, you should select this option. Doing so has
EndNote create a Backup folder in the EndNote folder and all
of the styles, filters, and connection files from your older
installation are copied into that folder. After installing
EndNote, you should move any of these files that you want
to use into the Styles, Filters, or Connections folders installed
with EndNote X5.



Remove older files: If this option is selected, Setup replaces
all of the styles, filters, and connection files from your existing
EndNote installation with the new ones included with
EndNote X5. Do not select this option if you have custom
styles, filters, or connection files that you want to save. If they
have the same names as any of the files to be installed, the
installer will overwrite them with the new files.

NOTE: No matter which option you choose, your libraries will not be
deleted nor will any non-EndNote files in the EndNote folder.

Opening and
Converting
Old EndNote
Libraries

EndNote X5 opens and uses libraries created with EndNote 8
and later. It converts libraries created with even earlier versions
of EndNote to the latest file format.
To convert an old EndNote library (created before version 8):
1. Start EndNote.
2. From the File menu, select Open, and then select Open
Library.
3. On the file dialog, locate and highlight the old library, and
then click Open.
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EndNote will warn you that the selected library was created
with an older version, and will ask for permission to convert it.
4. Click OK to convert the library. Name the new library and
click Save. The conversion makes a copy of the original
library in the latest file format, and leaves the original library
intact.

Using Old
Style, Filter,
and
Connection
Files

EndNote X5 can use custom styles, filters, and connection files
that were created with EndNote versions 4.0.1 - X5. Once you
edit and save one of these files with EndNote X5, it is converted
to the latest format, which can be used with EndNote versions 8
to EndNote X5.
All of the styles, filters, and connection files supplied with
EndNote X5 have been updated to the latest format. The new
filter and connection files may be used by previous versions of
EndNote, but you cannot edit EndNote X5 styles in previous
versions of EndNote.

Checking Your Installation
To Begin
Using
EndNote

From the Start menu, select All Programs > EndNote > EndNote
Program.
First, a dialog may ask whether you want to open a new EndNote
Web account or integrate with an existing EndNote Web account.
For information about EndNote Web, see “Transferring
References between EndNote Web and EndNote” in EndNote
Help.
Next, a dialog may ask you to open a library file. You can create
or open an EndNote library, or select Cancel or Close. A Sample
Library is provided in an Examples folder to help you get familiar
with EndNote.
To check the version number of EndNote, select About EndNote
from the Help menu. Click the splash screen to clear it.
If you have trouble accessing the program, repeat the installation
steps to verify that the program was correctly installed

Checking Cite
While You
Write Support

To see whether Cite While You Write is correctly installed, start
Microsoft Word or the OpenOffice.org Writer.


In Word 2003, click on the Tools menu to see EndNote
commands on an EndNote X5 submenu.
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In Word 2007 and 2010, you should see an EndNote tab.



In OpenOffice.org Writer, you should see EndNote
commands on an EndNote X5 menu.

NOTE: Cite While You Write commands may not be available if you
installed or upgraded your word processor after installing EndNote.

1. Log in to the machine with administrative rights or as a user
with program installation privileges.
2. Make sure that all Microsoft Office and OpenOffice.org
applications are closed, including any Quickstarter
applications.
The OpenOffice.org Quickstarter may appear in your System
tray. Right-click on the icon, and then select Exit
Quickstarter.
3. From the Windows Start menu, select Control Panel.
4. Select Add or Remove Programs.
5. Highlight EndNote X5, and then click Change.
6. Select Repair, and then click Next.
Your entire EndNote installation is checked and repaired as
needed. For more information, see “No EndNote commands in
Word” in EndNote Help.

Automatically Updating Files
You can automatically update EndNote X5 when incremental
program enhancements are available.
To update your copy of the EndNote program:
1. Open a connection to the Internet.
2. From EndNote’s Help menu, select EndNote Program
Updates.
The wizard checks for an update, lets you know whether an
update is available, and then downloads the file(s) and applies
the update to your EndNote installation.
NOTE: You also have the option to download the latest content files at
any time from our Web site at http://www.endnote.com. We continually
update output styles, filters, and connection files.
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Uninstalling EndNote
Before you remove EndNote, back up your libraries and any
other files you have created or customized.
For volume and site license installations, see “Licensing of
Volume Copies” in EndNote Help.

Uninstalling
Word 2007
and 2010
Settings

Word 2007 and 2010 settings are typically registered during
installation of the EndNote program, and in those cases they will
also be uninstalled along with the program. You can jump to the
next section called “Uninstalling the EndNote Program” on page
31 for more information.
If you used the Configure EndNote utility for a specific user
account, to suppress the “Citations and Bibliography” group on
the References tab in Word 2007 or 2010, you should use that
utility again to uninstall.
To uninstall Word 2007 or 2010 settings:
1. Log on to the workstation as the current user. You do not
have to be an administrator.
2. Launch the Configure EndNote utility. You can do this in one
of these ways:


From the Windows Start menu, select All Programs >
EndNote > Configure EndNote.



Go to the EndNote program folder and double-click
Configure EndNote.exe.

3. Select Remove all EndNote components for me, and then
click Next.
4. Continue through the uninstall process as instructed.
This uninstalls a single Word 2007 or 2010 setting, and only for
the current user.

Uninstalling
the EndNote
Program

To uninstall EndNote:
1. Log in to the machine with administrative rights or as a user
with program installation privileges.
2. From the Windows Start menu, select Control Panel.
3. Select Add or Remove Programs (Windows XP) or Programs
and Features (Windows Vista or Windows 7).
4. In the list of currently installed programs, select EndNote X5.
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5. Click Remove (Windows XP) or Uninstall/Change (Windows
Vista or Windows 7).
Or, you can uninstall by using the EndNote installation
program:
1. Log in to the machine with administrative rights or as a user
with program installation privileges.
2. From your EndNote CD, run Setup.exe.
3. On the Application Maintenance dialog, select Remove, and
then click Next.
4. Click Next again to begin removing EndNote.
The uninstall procedure removes only files, groups, and icons
installed by the EndNote installer the last time it was run. For
example, if you used the installer’s Custom installation option to
reinstall only style files, the Uninstall program removes only style
files.
To remove any modified EndNote files that remain:
We purposely do not remove any EndNote libraries or
customized files. You can manually delete these files from
Windows Explorer from the following folders.
Windows XP
C:\Program Files\EndNote X5
C:\Documents and Settings\All Users\Shared
Documents\EndNote
C:\Documents and Settings\[UserName]\My
Documents\EndNote
C:\Documents and Settings\[UserName]\Application
Data\EndNote
Windows Vista
C:\Program Files\EndNote X5
C:\Users\Public\Public Documents\EndNote
C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote
Windows 7
C:\Program Files\EndNote X5
C:\Users\Public\Public Documents\EndNote
C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote
NOTE: If you are using a 64-bit version of Windows, your EndNote
program folder will be: C:\Program Files (x86)\EndNote X5.
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Chapter 3: Introduction to an EndNote Library
This chapter covers the basics of working with EndNote. In
particular, you will learn how to:

Start EndNote



Start EndNote and open a library.



Sort the reference list.



Select, open, and close references in the EndNote library.



Save references to custom groups.



Quit from the EndNote program.

To start the EndNote program and open the sample library:
1. Macintosh: Open the EndNote X5 folder and double-click
the EndNote program icon. By default, the EndNote X5 folder
is installed in the Applications folder on your hard drive.
Windows: From the Start menu, select All Programs >
EndNote > EndNote Program.
NOTE: If this is the first time you have used the EndNote program, a
dialog appears and prompts you to set up EndNote Web. For this
section of the tour, skip setting up EndNote Web.
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The following dialog appears prompting you to open a
reference library.

NOTE: If you have set a favorite library to open automatically, that
library will open instead of the dialog shown above. If this happens,
close the library. From the File menu, select Open > Open Library.
Continue with step 3.

2. Click the File Cabinet icon.
3. In the file dialog, locate and open a reference library:
Macintosh: Navigate to the EndNote X5 folder, select the
Examples folder, and then click Open.
Windows: Use the Look In menu to find the EndNote X5
Examples folder.
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Select the C: drive and Open.



Select Program Files and Open.



Select the EndNote X5 folder and Open.



Select the Examples folder shortcut and Open. The
Examples folder is actually in your Shared Documents or
Public Documents folder.
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The example library is shipped to you as a single
compressed file called Sample_Library_X5.enlx.
Open the Sample_Library_X5.enlx file and EndNote extracts
the uncompressed library files (Sample_Library_X5.enl and
Sample_Library_X5.Data) for viewing.
If you have previously opened the compressed sample
library, select Sample_Library_X5.enl, and then click Open.
If your folder settings are not set up to show file extensions,
determine the file type based on the icons indicated in the picture
below.

Uncompressed Library
Compressed Library
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The Library
Window

When you open the sample library you will see the Library
window listing all of the references that the library contains.

Move column dividers to adjust column widths

The Library window includes three panes:
Reference List pane: Displays a multi-column list of references.
By default, the first column in the reference list shows a paper
clip icon for references that include an attached file in the File
Attachments field. This is followed by:
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Author’s last name, first name, initial (all names are shown)



Year



Title



Journal name or secondary title



Reference type



URL
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Last Updated

NOTE: You can changes the order of the fields that display in the
reference list by selecting from the Endnote X5 menu (Macintosh) or
Edit menu (Windows) Preferences > Display Fields.

Groups pane: Displays various groups of references for easy
retrieval.
Tab pane: Displays a Preview tab to view formatted references,
a Search tab for searching either the current library or an online
database, and a PDF & Quick Edit tab for quickly editing and
viewing PDF files attached to a reference.
The information displayed in the reference list, as well as the font
used for the display, can be changed using EndNote
Preferences. Chapter 4 provides more information about
customizing the Library window.
You can browse through the reference list by first selecting a
reference, and then using the scroll bar, the scroll arrows, or the
Page Down, Page Up, Home, End, and Arrow keys.

Preview
References

You can easily see more detail about a reference by highlighting
the reference and viewing the Preview pane at the bottom of the
Library window.
To preview a reference:
1. First, if you do not have a Tab pane in the window, click the
Show Tab Pane button at the bottom of the window, and then
click the Preview tab.
2. For this example, click the reference titled “Bats: Biology,
behavior, and folklore.”
The Preview tab uses the current output style to display the
selected reference as it will be formatted for a bibliography.
EndNote’s output styles represent the rules for creating
bibliographies for a variety of journals and other publications.
The styles determine how your references look when you
print, export, preview, or create bibliographies.
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Output Style menu

3. To select a different output style to apply to the reference, go
to the toolbar and select Numbered from the Output Styles
menu.
Macintosh Toolbar

Windows Toolbar

Only one reference is displayed in the Preview pane. If multiple
references are selected, only the active reference (surrounded
by a dotted line) is displayed.
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When the Tab pane is showing, a Hide Tab Pane button is
available at the bottom of the window. You can click the Hide Tab
Pane to hide the Preview tab and the other tabs.

Sort the
References

References can be easily sorted by clicking on a column heading
such as Author, Year, or Title.
To change the sort order:
1. Click the Author column heading to change the current
Author sort from ascending order to descending order.

NOTE: This example shows references that include Japanese
characters. EndNote uses Unicode to encode special characters, so
that data is easily translated between platforms, programs, and
languages. If boxes appear instead of characters, you may need to
change the EndNote display fonts to a Unicode font. You will learn how
to do this in Chapter 4: "Setting EndNote Preferences". If you are
running Windows, you may need to install special Windows Language
Packs for some display elements. Consult your Windows
documentation for more information about Language Packs.
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2. Click the Year column heading to see the references sorted
in ascending order based on the year of publication.
3. Click the Year column heading again to reverse the sort order
and see the references sorted in descending order.
4. Click the Author column heading to return the sort order of
the library to an alphabetical list sorted by the author names.

Select and
Open a
Reference

To work with specific references, you must first select them in the
Library window.
There are different ways to select a reference, such as:
1. Clicking on the reference using the mouse;
2. Using the arrow keys; or
3. Typing the first few letters found in the field by which the
library has been sorted.
To see how this works, click any reference to select it. Press the
Up or Down Arrow to select the previous or next reference.
To quickly find and display a reference:
1. Select the first Argus reference in the list. Now that the
reference is selected, there are a number of things you can
do with it, such as view its contents, copy, cut, delete, or edit
it.
2. Open the selected Argus reference by pressing the Return
key (Macintosh) or Enter key (Windows) or by using the Edit
References command on the References menu. You can
also open a reference by double-clicking on it in the
reference list.
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The Reference window opens to display all of the information
associated with the reference.
Show or Hide empty
fields in the reference.

Click and drag to resize the window.
Note that all windows in EndNote are
maximized when opened.

This is where you enter or edit information for a reference.
To view the rest of the reference, use the mouse to scroll down
the Reference window or press the Tab key to move forward from
one field to the next.

Close the
Reference



Press Shift+Tab to move backwards through the fields.



Click the Toggle Empty Fields button (Macintosh) or Show
Empty Fields / Hide Empty Fields button (Windows) to toggle
between showing all fields in the reference and only those
fields that contain data.

Close the reference. You can do this in one of these ways:


Click the X Close button (Windows) in the upper corner of the
Reference window (not the outer close button for the library)
or the red Close button (Macintosh) in the upper left corner
of the window.



From the File menu, select Close Reference.
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From the keyboard, press Command+W (Macintosh) or
Ctrl+W (Windows). Note that many of the menu commands
have a keyboard equivalent next to them.

EndNote prompts you to save your changes. Click Yes to save
your changes.

PDF & Quick
Edit Tab

About the Quick Edit Pane
You can quickly edit your references by clicking on the PDF &
Quick Edit tab. Most functionality is the same as working in the
Reference window. Enter text in a field by clicking on the field. All
commands are available via the menus including contextual
menus.
The Quick Edit pane displays the contents of the highlighted
reference. Each part of the reference is stored in its own field,
and the reference type is displayed below the title bar.

About the PDF Viewer Pane
The PDF Viewer pane allows you to open and view PDF files
attached to the current reference.
Let’s attach a PDF file to the reference
1. Place your cursor inside the PDF Viewer pane. Note that a
message displays that says: “There are no PDFs attached to
this reference.”
2. Press Ctrl+Alt+A to open a “Select a File” dialog.
Alternatively, you can click the paper clip icon, and then
select Attach PDF from the menu.
3. Navigate to the folder Program Files\EndNote X5 (Windows)
or to Applications/EndNote X5 (Macintosh).
4. Notice the check box titled “Copy this file to the default file
attachment folder and create a relative link.” Make sure this
44
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box is selected so that EndNote will make a copy of the file
to store with the library. That way, the attached file is always
available to you, even when you move the library.
5. Select the file titled GettingStartedGuide.pdf.
6. Click Open to insert the file into the reference.
7. To save the PDF file, navigate away from the current
reference by clicking on another reference in the library list.
8. Select the Argus reference to display the Getting Started
Guide in the PDF Viewer pane.

EndNote automatically opens the first PDF file attached to a
reference when you select the PDF & Quick Edit tab.
Windows
Floating Toolbar

A floating toolbar appears within the PDF Viewer pane that
displays the following icons.
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Macintosh
Floating Toolbar

The options include:


PDF Attachments (Paper Clip icon with contextual menu)



Save PDF



Print



Previous Page \ Next Page



Go to (page)



Zoom Out \ Zoom In



Rotate Counterclockwise \ Rotate Clockwise



Sticky Note



Highlight Text



Find (search PDF).

You can also right-click within the PDF Viewer pane to open a
contextual menu that includes many of these options.
Let’s create a sticky note
1. Select the Sticky Note icon from the floating toolbar.
2. Navigate to the section in the PDF where you want to add
the sticky note.
3. Click the left mouse button to display a Sticky Note icon.
4. Double-click the Sticky Note icon to display a Sticky Note
text box.
5. Enter your comments in the Sticky Note text box.
6. Click the Save icon in the floating toolbar. Click Yes when
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prompted.

See “The PDF & Quick Edit Tab” in EndNote Help to learn more
about the PDF Viewer and Quick Edit features.

Save
References to
a Custom
Group

The left pane of the Library window lists groups of saved
references. The first three groups are permanent.


All References displays all of the references in the library.



Unfiled contains references that are not part of a custom
group.



Trash contains references that have been deleted from the
library but not yet permanently eliminated.

Below the permanent groups, you can create group sets to
organize up to 5,000 custom, smart, and combination groups in
the library.


A custom group is built by specifically adding individual
references to the group.
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A smart group is compiled automatically and is based on a
search strategy.



A combination group consists of custom and/or smart
groups.

The sample library has several custom groups of references.
Click the group names under the Bats set in the left pane of the
Library window to view the references in each group.
Group set name
Custom groups
Smart group

Then, click All References to display all of the references in the
library again.
To create a custom group and add references to it:
1. Display one of the groups in the Paleontology set so that the
new group will be created in that set.
2. From the Groups menu, select Create Group.
In the Groups pane of the Library window, a group titled New
Group is now highlighted for editing.
3. Type “Extinction” as the group name, and then press Return
(Macintosh) or Enter (Windows) or click in the reference list
area to save the change.
There are no references in the new Extinction group.
4. Select the All References group to display all references in
the library.
5. In the Author column, highlight the first reference by Argus
and the first reference by Billoski. To select noncontiguous
references, hold down the Command key (Macintosh) or Ctrl
key (Windows) as you click on them.
6. Drag the selected references to the new Extinction group and
drop them on the title of the group. You could go to the
Groups menu, and then select Add References To >
Extinction.
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7. Select the Extinction group to display the two references now
included in the group.

Click All References to display all of the references in the library
again.
To move the group to a different group set:
1. Click the Extinction group.
2. Drag it to the Bats group set, and then drop the group
anywhere in the Bats set.
To delete a custom group:
1. Control+click (Macintosh) or right-click (Windows) on the
Extinction group name to display a contextual menu, and
then select Delete Group.
2. When you are asked to verify the deletion, click Delete.
Only the Group subset is deleted; no references are deleted from
your library.
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Many of the commands for managing groups are available both
from the Groups menu and from the right-click contextual menu.

Related
Sections in
EndNote Help
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See the following topics in EndNote Help for information related
to this portion of the tour:


“Sorting the Library” to learn more about sorting.



“The EndNote Library” to learn how to change the display of
the Library window.



“The PDF & Quick Edit Tab” to learn more about PDF Viewer
and Quick Edit features.



“Using Groups” to learn more about creating and managing
groups.
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Chapter 4: Setting EndNote Preferences
In this part of the guided tour you will learn how to:


Display EndNote Preferences.



Set a favorite library to open each time you start EndNote.



Change the display fonts.

Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Access
EndNote
Preferences

To view or change the EndNote preferences:
From the Endnote X5 menu (Macintosh) or Edit menu
(Windows), select Preferences.

Set a Favorite
Library

You can assign a library to open automatically every time you
start EndNote. You will find it useful to set the sample library
(Sample_Library_X5.enl) as your favorite library for now. Later,
when you create your own library, you can set it as your favorite
library.
To set a favorite library:
1. Go to the Endnote X5 menu (Macintosh) or Edit menu
(Windows), and then select Preferences.
2. In the list on the left, click Libraries.
3. Select “Open the specified libraries” from the When EndNote
Starts menu.
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4. Click Add Open Libraries. You should see the full path and
file name of the sample library (Sample_Library_X5.enl)
listed at the top of the box.

5. Click Save (Macintosh) or Apply (Windows) to save this
change.
While you could click the red Close button (Macintosh) or OK
(Windows) to leave the Preferences dialog, we are going to
change another preference first.

Change the
Library
Display Font

Pick a different font to display text in the Library window and the
Reference window.
To change the display fonts:
1. Go to the Endnote X5 menu (Macintosh) or Edit menu
(Windows), and then select Preferences.
2. In the list on the left, click Display Fonts to display a dialog
with four tabs.
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The Library tab determines the font and size of the
references listed in the Reference List pane of the Library
window.



The General tab changes the font used to display most
text that is typed into EndNote such as in the Reference
or Style windows. The General font is also used for most
of the previews and information panels in EndNote, as
well as for bibliographies that are printed or copied
directly from EndNote.
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The Labels tab determines the font and size used for the
Reference window field labels.



The Search tab determines the font and size applied to
user-entered text on the Search tab.

3. On the Library tab, click the Change (Macintosh) or Change
Font (Windows) button.
4. In the Font list, select a different font (for Windows, select
Arial Unicode MS, if available, since it supports Japanese
characters). Close the Fonts dialog, and then click Save
(Macintosh) or OK (Windows) to save the change.
EndNote uses Unicode to correctly handle extended
characters. By selecting a Unicode font here, you can view
extended characters in the Library window, such as the
Japanese characters found in the Paleo library.
5. On the General tab, click the Change (Macintosh) or Change
Font (Windows) button.
6. In the Font list, select a different font (for Windows, select
Arial Unicode MS, if available, since it supports Japanese
characters), and then Save (Macintosh) or OK (Windows) to
save the change.
7. Click the red Close button (Macintosh) or OK (Windows) to
leave the Preferences dialog.
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Related
Sections in
EndNote Help
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See the following topics in EndNote Help for information related
to this portion of the tour:


“The EndNote Library” to learn how to change the display of
the Library window.



“Preferences, Toolbars, & Shortcuts” to learn how to
customize your version of EndNote.
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Chapter 5: Entering a Reference
In this part of the guided tour you will learn how to:


Enter a reference into a library.



Attach a file to a reference.

Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Create a New
Reference

There are various ways to add references to an EndNote library:


Type the reference information into the Reference window.



Connect to an online bibliographic database and retrieve the
references directly into EndNote as demonstrated in
“Searching an Online Database” on page 61.



Import text files of references that have been downloaded
from online bibliographic databases as demonstrated in
“Importing Reference Data into EndNote” on page 73

Once a library is open, you can add a new reference to it:
1. Click in the reference list, and then from the References
menu, select New Reference to display an empty Reference
window.
Reference
Type list
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New references appear as Journal Article (unless you
change the default setting). They can be changed to another
reference type using the Reference Type list at the top of the
window.
2. Select the Book reference type from the Reference Type
menu.

Notice that the Field list changes to reflect the type of
bibliographic information you would record for a book. Select
other reference types from the list to see how the list of fields
changes for each type of source.
Three reference types (Figure, Chart or Table, and Equation)
are available specifically for cataloging picture files and
object files, although you can add File Attachments, Figures,
and Captions to any reference type.
When you are done looking at different reference types, set
the reference type back to the Journal Article reference
type. You are now ready to enter reference information
beginning with the author names.
3. Enter author names for the reference. Individual author
names must be entered one per line.
a. Enter an author name with the first name first. With the
cursor in the Author field, type:
Tiberius Rex
As you type, EndNote suggests names similar to the one
you are entering. This is EndNote’s way of using Term
Lists to facilitate the process of entering new references.
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NOTE: The auto-complete feature can be turned on or off with EndNote
Term Lists preferences. It is available for Author fields when you enter
author names with the last name first.

The name you are entering, Tiberius Rex, is a new author
in this library, so keep typing until you complete the
name, and then press Return (Macintosh) or Enter
(Windows).
The name appears in red text to indicate that it is a new
name in the Author term list for this library. When you
close the reference, it will be added to the Author term list
and the red text will change to black. You can read more
about term lists (and how to turn these options on or off)
in EndNote Help.
b. Enter the second author’s name, but with the surname
first.
Morre, Nicole
This author’s last name is already in the sample library,
so as you start typing the last name, you will see
EndNote complete the name for you.

Press Return (Macintosh) or Enter (Windows) to accept
EndNote’s suggested author name.
c.

For the third author, enter:
de Young, John Robert, Jr.
The first comma separates the last and first name. The
second comma is inserted before suffix text, to make it
clear that it is not part of the author’s name for
manipulation of name order or stripping to initials. Suffix
text will always print after the other information for this
author. Press Return (Macintosh) or Enter (Windows).

d. For the fourth author’s name, which in this case is a
corporate author, enter:
University of California,, Berkeley
Corporate author names are entered with a following
comma, so they will not be manipulated like personal
author names. In this case, the corporate author name
has a comma within the name. We inserted two commas
to allow for correct formatting. The first comma makes it
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clear that text up to that point should not be manipulated,
and the second comma indicates that there is no “first
name,” yet includes suffix text.
4. Press Tab to accept the author name and move to the Year
field. Type “2006” as the search term.
5. Continue entering the reference as shown below using the
Tab key to move to the next field and Shift+Tab to move to
the previous field. You can also use the mouse to click in the
desired field. If information is not provided for a particular
field, leave that field empty.
Title:

The scale and the feather: A
suggested evolution

Journal:

Paleontology

Volume:

3

Issue:

1

Pages:

125-128

Date:

November 22

Keywords: Feathers
Evolution
Birds
No extra punctuation (such as parentheses around the year)
or text styles (such as bold or italic) are entered into the
reference. EndNote adds the necessary punctuation and text
style changes to the references when it creates a
bibliography.
While we are not entering any text into the Abstract or Notes
fields, you could enter up to 64 K into each of these fields,
which amounts to 10-12 pages text.
6. Attach a PDF file to the reference. You can attach almost any
type of file to the File Attachments field of a reference.
Scroll to the File Attachments field, and from the References
menu, select File Attachments > Attach File to display a file
dialog. On the file dialog:
a. Navigate to the folder:
Applications/EndNote X5 (Macintosh)
Program Files\EndNote X5 (Windows)
b. Notice the check box titled “Copy this file to the default
file attachment folder and create a relative link.” Make
sure this box is selected so that EndNote will make a
copy of the file to store with the library. That way, the
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attached file is always available to you, even when you
move the library.
c.

Highlight the file titled GettingStartedGuide.pdf.

d. Click Open to insert the file into the File Attachments
field. A file icon will appear in the field.

You can attach up to 45 different files to a single
reference. Double-click the file icon to open the file with
the default program for the file type.
7. From the File menu, select Close Reference to close the
Reference window.
8. When prompted to save changes, click Yes. Your new
reference will appear in the Library window.

A paper clip icon appears next to the reference to indicate an
attached file.
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Locate
References
that Contain
Attached Files

You can easily locate those references that contain attached
files.
To locate the references containing attached files:
Click the paper clip icon in the first column heading twice to sort
records containing attached files at the top of the list. References
that include a paper clip have one or more attached files.

You can double-click an individual reference if you would like to
view the complete reference. When you are done viewing a
reference, click the Close button.
Click the Author column heading to again order the list by author
names in ascending (A to Z) order.

Related
Sections in
EndNote Help
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See the following topics in EndNote Help for information related
to this portion of the tour:


“The EndNote Library” to learn how to create your own
library.



“Entering and Editing References” to learn about typing
references into your library and inserting images.
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Chapter 6: Searching an Online Database
With the EndNote Online Search command, you can search
online bibliographic databases just as easily as you can search
an EndNote library on your own computer. The results of your
searches can be downloaded either into a temporary EndNote
library or directly into your own EndNote library.
Another way to search online sources is with the Find Full Text
command, which locates full text articles for your existing
EndNote references.
This section will guide you through these basic steps:


Connect to an online database.



Search the database and download the references into an
EndNote library.



Find and attach the full text article for a reference.

NOTE: To follow this exercise, you must be at a computer with access
to the Internet (either dial-up or a direct network connection).

About the PubMed Database
For this lesson, you will connect to PubMed, the U.S. National
Library of Medicine’s online public access version of their
MEDLINE database.

For Users With “Dial-up” Internet Connections
This section pertains to you if you use a modem and a phone line
to connect to the Internet, as opposed to a direct network
connection.
Connecting: Most setups for dial-up connections are configured
to automatically dial your information provider and connect to the
Internet when you use an application that requests an online
connection (as EndNote’s Online Search command does).
However, some setups require that you establish an online
connection (sign on) before choosing EndNote’s Online Search
command.
Disconnecting: EndNote disconnects from an online database
as soon as a search is completed. EndNote will not disconnect
your Internet connection at any point. You need to shut down
your connection when you have finished using EndNote’s Online
Search feature.
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Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Select a
Display Mode

You can choose from different display modes in the Library
window by selecting one of these from the toolbar.


Integrated Library & Online Search Mode



Local Library Mode



Online Search Mode

There are actually two different workflows. You may want to
always work in Integrated Mode, with all groups and commands
available, and with online search results downloaded directly into
your open library. Or, you may want to work primarily in Local
Library Mode, with Online Groups suppressed until you explicitly
switch to Online Mode to download references into a temporary
library.


In Integrated Library & Online Search Mode, all groups and
commands are available. When you download references
from an online database, they are saved directly into the
open library.



In Local Library Mode, the Online Search groups are not
available. All local library commands are available. If you
initiate an online search from the Tools menu, the display
switches to Online Search Mode.



In Online Search Mode, only the Online Search groups are
available. When you download references from an online
database, the references are stored in a temporary library
until you save them to a permanent EndNote library. This
allows you to download references from online databases
and review them without affecting your local library. Many
library commands are not available in Online Search Mode.
When you close Online Search Mode, the display changes to
Local Library Mode.

Try clicking on the three different mode buttons at the left of the
toolbar to see how the Group pane changes in the Library
window.
Integrated Library &
Online Search Mode

Online Search Mode
(Temporary Library)
Local Library Mode
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To continue the tour, click the left icon to select Integrated Library
& Online Search Mode so that all groups and commands are
available.

Connect to an
Online
Database

The first step in searching an online database is connecting to it.
To connect to the PubMed Database:
1. Go to the Tools menu and select Online Search to see the
available list of online databases. You could also look under
Online Search in the Groups pane, and then click the More...
link.

Click to
show more
info about the
connection file.
NOTE: The Groups pane will remember databases you have
connected to in the past for easy access under Online Search. You can
also customize a list of favorite databases to search by using the
Connection Manager.

NOTE: This window displays the connection files available in your
Connections folders. A Typical installation installs only the most popular
connection files, but more than 4,100 connection files are available with
EndNote.
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2. Click the Find by Category button (Macintosh) or the Find by
button (Windows) to view a list of various categories of
databases to help you locate the one that you need. Or, type
text into the Quick Search text box and press Return
(Macintosh) or Enter (Windows).
3. Select the PubMed connection file, and then click Choose.
You can begin entering your search terms in the fields.
By selecting this connection file, you have directed EndNote to
connect to the U.S. National Library of Medicine’s PubMed
database. If for any reason the connection cannot be
established, EndNote alerts you with an error message and
closes the connection.
When the connection has been established, EndNote displays a
Search tab titled, “Online Search - PubMed MEDLINE at PubMed
(NLM).” The PubMed MEDLINE database is selected and
EndNote is ready to search.

NOTE: For more detailed information on how to search PubMed,
see “Importing References from PubMed” in EndNote Help.

NOTE: If you previously set a default configuration for the Search tab,
the search field lists display the fields you selected as your defaults. If
one of those default fields is not a valid option for this particular online
database, the field selection may appear as “Any Field” or “All Fields.”

Search the
Database

The next step is to enter the search term(s) to find the references
you need. Searching an online database is very similar to
searching an EndNote library (with a few exceptions).
Let’s say you are interested in finding more information about
fossils for the sample library.
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To enter the search term(s) and perform the search:
1. In the Groups pane, select PubMed (LMN)
2. Set the Field list for the first line to MeSH Terms, and enter
“fossil” into the search text field. The Comparison list for
online searches is always set to Contains.
Field List

Comparison List

Search Term

Match Case and Match Words are not available for online searches

3. Click Search.
EndNote sends the search request off to the online database
and a summary of the search results is displayed.

The dialog displays the number of references that were found
to match your search request, and gives you the option to
retrieve them.
NOTE: You can halt a retrieval in progress by clicking the Cancel button
on the Search tab. Records that have been processed up to that point
already exist in the library.

NOTE: PubMed is updated regularly, so you may find a different
number of references than illustrated here.

If the result set seems too many, you can refine the search to
get closer to exactly those references you want. Let’s refine
this search by looking for just those references that include
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mention of a “trilobite,” a group of extinct marine animals that
were abundant in the Paleozoic era.
4. Click Cancel to return to the Search tab.
5. Set the operator at the beginning of the second search line to
And.
6. In the second search line, select All Fields from the Field list
and type “trilobite” as the search text.

7. Click Search.
This time fewer references are found.

8. Click OK to retrieve and save the matching references.
The references are downloaded into your library and appear
both in the All References group and in a temporary PubMed
(NLM) group for the PubMed database connection.
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The temporary PubMed (NLM) group will reset back to 0
references when you close the library.

NOTE: If you would prefer to save references to a temporary library
first, to verify which references you want to save, you would begin by
selecting Online Search Mode.

NOTE: You can click the triangle icon (Macintosh) or plus or minus icon
(Windows) next to a group set heading to display or hide the list of
groups under that heading.

Review the
References

At this point, you can view the retrieved references to make sure
you want to keep all of them. You may find that some of the
references are not helpful for your research.
While you could open each reference individually to scan through
the bibliographic data, you can also use the Preview tab or the
Quick Edit pane.
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To quickly look at the new references:
1. Click on a reference in the reference list.
2. Click the Preview tab to display a reference to view.
3. On the toolbar, select the Show All Fields output style from
the Output Style list.
The Show All Fields style is not bibliographic, but represents
all of the fields in your references. On the Preview tab, scroll
through the data in the selected reference.
NOTE: If Show All Fields is not in the Output Style list, then choose
Select Another Style to go to the Choose a Style dialog. Select Show
All Fields from the list.

Delete
Unwanted
References

Because you are working in the Integrated Mode display,
references were downloaded directly into the open library. Any
references you do not want must be deleted.
NOTE: If you had downloaded references in Online Search Mode, the
references would be in a temporary library; you would need to highlight
the references you wanted to keep and copy them into a permanent
EndNote library.

To delete references:
1. In the PubMed (NLM) group, select two of the displayed
references by holding down the Command key (Macintosh)
or the Ctrl key (Windows), and then clicking on the individual
references. Use Shift+click to select a range of references.
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2. From the References menu, select Move References to
Trash. The selected references are removed from the library
and put in the Trash group.
While the references are officially no longer in your library
(they will not appear in any other group or reference list, they
are not included in your reference count, and they cannot be
cited), they are not completely deleted until you go to the
Groups menu and select Empty Trash. Until you select
Empty Trash, you can still drag references from the Trash
group back to your active library.
3. Because you are sure that you want to delete the references,
click the Trash group, and then go to the References menu
to select Empty Trash.
4. Confirm the deletion by clicking OK.
5. Click the All References group to return to the full reference
list, and on the toolbar, set your output style back to
Numbered.
If you wanted to do another search of PubMed, you could display
the PubMed group, enter another search strategy, and then click
Search again. On the Confirm Online Search dialog, you are
asked, “Clear currently displayed results before retrieving
records?” This check box simply removes the previous
downloaded references from the PubMed group; they still exist in
the library. It is an easy way to see just those references
downloaded with the current search strategy.

Find the Full
Text for a
Reference

Many online sources now supply not only bibliographic
information, but the full text of the document you are referencing.
In this exercise, you will find the full text for a reference.
To find the full text for a reference:
1. Click in the list of All References and type “Chiu” to jump to
the reference by the author Chiu, C.
2. Highlight the reference by Chiu as well as the reference by
the author Chang, Kenneth.
3. From the References menu, select Find Full Text > Find Full
Text.
EndNote displays a copyright notice advising you to adhere
to downloading and usage guidelines as required by your
information provider. We will use the default EndNote
settings to search public sources that do not require
authentication for access.
4. Click OK to begin the Find Full Text search.
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In the left-hand column, under the Find Full Text group set
heading, you will see a Searching group indicating that a search
is in progress. This search can work in the background, so if you
had many references selected, you could continue working in
your library.
When the Find Full Text search is completed, the Searching
group is removed. Depending on the results, you may see a
combination of three different groups under the Find Full Text
heading.


Found PDF



Found URL



Not found

In this case, EndNote was able to locate a PDF file for one of the
references.

In the reference list, you can see that the Chiu reference now has
a paper clip icon next to it indicating an attached file.

Select the Chiu reference in the library window, and then click the
PDF & Quick Edit tab to open the PDF in the PDF Viewer pane.
See “PDF & Quick Edit Tab” on page 44 to learn more about this
feature.
The Chang reference does not have a PDF icon in the File
Attachments field.
NOTE: EndNote did not find a URL for either Chiu or Chang. Had
Endnote found a URL for either reference, the URL would be added to
the URL field. The URL would take you to the provider’s Web site where
either the full text article is available or you will find information about
how to obtain the full text article.
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Related
Sections in
EndNote Help

See the following topics in EndNote Help for information related
to this portion of the tour:


“Searching Online Databases” to learn about establishing
connections, searching for references, retrieving references,
and finding the full text for a reference.



“Troubleshooting” to learn how to resolve problems
establishing a connection.



“Connection Files” to learn about creating and editing
connection files.



“Importing References from PubMed” to learn how to import
records from the PubMed database.
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Chapter 7: Importing Reference Data into
EndNote
Online searching, described in the previous section, is the
easiest way to retrieve references from online databases, but not
all information providers offer that option.
If you have access to an online bibliographic database or a
university catalog, you can probably use EndNote’s import filters
to import text files saved or downloaded from these sources.
EndNote filters are configurable so they give you the flexibility to
import the reference data you need and eliminate data you do not
need.
In this part of the guided tour you will learn about:



Downloading data in a tagged output format.
Selecting an import filter and importing data into EndNote.

Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Search the
Database and
Save the
References

Often when you search a database, the matching references are
displayed as text, with no clear indicator between each piece of
bibliographic information. The PubMed reference below, saved in
a Citation format, is an example. There is no clear indicator for
EndNote to be able to differentiate a title from an address or an
abstract.
Science. 1966 Dec 9;154(3754):1333-1339.
Early Eocene Bat from Wyoming.
Jepsen GL.
A fossil skeleton of an early Eocene bat, the
oldest known flying mammal, was found in
southwest Wyoming. The bat is assigned to the new
species Icaronycteris index of the suborder
Microchiroptera. It was apparently of a young
male whose body was buried in varved marls of the
Green River Formation, on the bottom of Fossil
Lake, about 50 million years ago. The bones, some
as slender as a human hair, show a few
"primitive" characteristics such as a clawed

Chapter 7: Importing Reference Data into EndNote

73

index finger and a complete phalangeal formula,
but the bat was fully developed - an anatomically
precocious contemporary of the dog-sized
polydactylous horse.
PMID: 17770307 [PubMed - as supplied by
publisher]
To use this information effectively, each piece of bibliographic
information must be consistently tagged so it can be directed to
the correct EndNote field.
Database providers typically offer several different download
formats. Regardless of which system you are searching, you
need to save the references in a tagged format to a text file.
For this tour, we will use a text file of PubMed references that
were previously downloaded in the tagged MEDLINE format. The
file pubmed_result.txt is provided in the EndNote Examples
folder. A single reference in the file appears like this:
PMIDOWN STATDA DCOMLR IS VI IP DP TI -
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PG
AD

-

FAU
AU
FAU
AU
LA
GR

-

GR
PT
PT
PT
PL
TA

-

18198331
NLM
MEDLINE
20080116
20080313
20081121
0890-9369 (Print)
22
2
2008 Jan 15
Understanding of bat wing evolution takes
flight.
121-4
Department of Genetics, Harvard Medical
School, Boston, MA 02115, USA.
Cooper, Kimberly L
Cooper KL
Tabin, Clifford J
Tabin CJ
eng
F32 HD 052349/HD/NICHD NIH HHS/United
States
R37 HD 32443/HD/NICHD NIH HHS/United States
Comment
Journal Article
Research Support, N.I.H., Extramural
United States
Genes Dev
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JT
JID
RN
SB
CON

-

MH MH MH MH MH MH MH MH EDATMHDACRDTAID AID PST SO -

Genes & development
8711660
0 (Homeodomain Proteins)
IM
Genes Dev. 2008 Jan 15;22(2):141-51. PMID:
18198333
Animals
Chiroptera/*genetics
*Evolution
Forelimb/anatomy & histology
Fossils
*Genetic Variation
Homeodomain Proteins/*genetics
Wing/*growth & development
2008/01/17 09:00
2008/03/14 09:00
2008/01/17 09:00
22/2/121 [pii]
10.1101/gad.1639108 [doi]
ppublish
Genes Dev. 2008 Jan 15;22(2):121-4.

Each tag can be mapped to a corresponding EndNote field. If
data is inconsistently tagged, or poorly delimited, it may not be
possible to import all of the data accurately.
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Choose the
Correct Import
Filter and
Import into
EndNote

Once you have captured and saved your data file in a tagged
format, you need to identify the proper EndNote filter to import
the data. There are hundreds of filters included with EndNote;
each one is designed to read a specific tagged format from a
specific information provider.
To import the sample PubMed text file into the sample
library:
1. From the File menu, select Import.

The
Windows
Import
dialog

The
Macintosh
Import
dialog

2. Select the file to import.
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Macintosh: Browse to the Applications/EndNote X5/
Examples folder and highlight the pubmed_result.txt file.
Windows: Click the Choose button to display a file dialog.
Browse to the Program Files\EndNote X5\Examples folder,
and then highlight and open the pubmed_result.txt file.
3. From the Import Option list, select Other Filters to display the
list of filters supplied in the EndNote Filters folder.
You may want to peruse the list, to get an idea of what filters
are supplied. You can create new filters or copy and edit
existing filters.
NOTE: A Typical installation installs only the most popular filters, but
there are hundreds available with EndNote.

4. Type “PubMed” to jump to the filter in the list.

Click to
display
more or
less info
about
the file.

If the More Info button is available, click it and notice that the
Comments section at the bottom of the window gives tips for
downloading references from the selected source.
5. With the PubMed (NLM) filter highlighted, click the Choose
button.
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6. Leave the other two options at their default settings.
Duplicates: Import All
By default, a reference is considered a duplicate if the
Author, Year, Title, and Reference Type match a reference
already in the library. You can change the duplicates criteria
under EndNote Preferences. We will import all references
regardless of duplicates.
Text Translation: No Translation
This option allows you to specify the text character encoding
of the file you import. This is important when you import
references in languages that include extended characters.
You can also find the correct language encoding information
by opening the text file in Microsoft Word or another word
processor.
7. Click Import to import the file.
When the process is complete, only newly imported
references display in the reference list. This is a good time to
peruse the new references to make sure they imported as
expected. You can display the Preview tab to view the
formatted references, you can open individual references to
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make sure all information transferred to the correct fields,
and you can easily edit or delete the new references.

Notice that the focus in the Groups pane has switched from
the All References group to a new Imported References
group.
The Imported References group is a temporary group. It is
replaced each time you import a new set of references, and
it is removed when you close the library. The references
themselves remain in the library unless you specifically
delete them.
8. To return all of your references to the library display
(including the newly imported references), select Show All
References from the References menu or click the All
References group.
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Downloading
Records from
PubMed

The example below gives the recommended download format
and import option for the U.S. National Library of Medicine’s
PubMed system.
Information Provider: PubMed
Import Option: PubMed (NLM) Filter
Follow the steps below to download your search results from the
PubMed Web site and to import them into your EndNote library.
1. Go to the PubMed Web site in your Web browser at http://
www.pubmed.gov.
2. In the Search field, enter your search criteria to execute
your search. Click the Search button.
3. On the Results page, select Clipboard from the Send To
menu in the PubMed navigation bar to save records from
multiple searches as you work (optional). You can also click
the Add to Clipboard button to save the first 500 results.
4. Select the needed results and then select File from the Send
To menu.
5. Select MEDLINE from the Format menu.
6. Select a sort order from the Sort By menu. The default sort
order is Recently Added.
7. Click the Create File button. This will bring up a dialog box
allowing you to save your selected references as a text file.
8. Click the Save button to save the file to your computer. Save
the file somewhere easily accessible such as your
desktop. The default file name is pubmed_results.txt. You
may change the file name, but we recommend saving the
file with the .txt extension.
9. In EndNote, open the library where you would like to save
these references.
10. From the File menu, select Import > File to open a dialog
window.
11. Click the Choose button, and then select the downloaded
pubmed_result.txt file from your PC.
12. In the Import Option field, select Other Filters, and then
select the import filter called PubMed (NLM) from the
Choose an Import Filter dialog.
13. Click the Choose button to go to the Import File dialog.
14. Do not make any selections in the Duplicates and Text
Translation fields.
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15. Click the Import button to import your references.
16. Look in your Groups panel to see a new group called
Imported References. All the references that you
downloaded from PubMed will appear in this group.
NOTE: In step 4, do not use File > Save from your browser as the file,
along with the results, will not import.

NOTE: In step 7, if you have a popup blocker enabled, such as the one
that comes by default from Windows XP Service Pack 2, you may need
to disable the popup blocker temporarily to allow the PubMed Web site
to send you the file.

When you close the current library, EndNote removes the
imported records from the Imported References group.

Direct Export
from Web
Pages

Certain Web sites include a download button that will send your
search results directly to EndNote, pick the correct import filter,
and start the import process automatically.
Start by opening the EndNote library into which the data should
be imported. This “direct export” or “direct download” method
does away with the additional steps of saving the references to a
text file, and then importing that file with the appropriate filter.
The systems listed below provide a direct export of references
into EndNote. A detailed table of instructions can be found in
”Direct Export Providers” in EndNote Help. The list keeps
growing, so contact your information provider to find out whether
they participate!
ALEPH

Los Alamos National Laboratory

American Psychological
Association, PsycInfo Online

MicroPatent

Bibliotech.dk

Nature

BioMedCentral

Nerac

BioOne

NISC

Blackwell Synergy

OCLC

BMJ

OhioLink

Buffalo University

OVID

CABI-Direct

Oxford Press Journals

Canadian Journal of
Communication

Pacific Northwest Labs
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CCLR

Patent Cafe

Delphion

PILOTS

EBSCO

PNAS Online

EI Engineering

ProQuest

Elsevier

RLG

EMBASE

Science Magazine

ERIC

Scopus

ESDS Government

St. John of God, Ireland

Google Scholar

Stanford University's Highwire Press

HAPI

Telemed

IEEE

Thieme

JAMA

Web of Science

JISC

WebFeat

JSTOR

WilsonWeb

Karger Publishing

Exporting
Records from
Web of
Knowledge
and Web of
Science

You can easily export bibliographic records from the Web of
Knowledge platform. A subscription to Web of Knowledge is
required.
Go to the All Databases or Web of Science Search page and
perform a search using the Topic, Title, Author, or other fields.
1. From the Results page, click the check boxes to select the
records that you wish to export to EndNote.
2. Go to the Output Records section of the page and select the
option to output Full Record in step 2.
3. Click the EndNote button.
4. On the Processing page, click the Export button (Internet
Explorer) to export the records to EndNote. If you are using
Firefox, select Open With, and then click OK to export the
records.
5.

If a Choose Destination dialog opens, select EndNote, and then
click OK.

6. At this point, the EndNote program opens, and the records
are exported to a temporary group called Imported
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References.
NOTE: When you install EndNote, the system automatically installs the
ISI ResearchSoft - Export Helper plug-in. The plug-in opens a dialog
window on the Processing Records page that allows you to select a
reference program (if more than one program is installed) and a
reference library. If only EndNote is installed, then the system
automatically exports the records form All Databases or Web of
Science as explained in step 4 above.

Related
Sections in
EndNote Help

See the following topics in EndNote Help for information related
to this portion of the tour:


“Importing Reference Data” to learn about import options and
about importing references from other bibliographic software
programs.



“Filters” to learn how to create or modify filters that map
downloaded references to corresponding fields in EndNote.



“Direct Export Formats and Import Formats” to learn about
tables of instruction for importing reference data from various
online systems.
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Chapter 8: Searching an EndNote Library and
Saving it as a Smart Group
In this part of the guided tour you will learn how to:


Search an EndNote library for a set of related references.



Save the search strategy to create a smart group that is
dynamically updated each time you enter or edit a reference.

Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Search for a
Set of
References

Let us assume that you want to generate a list of all references
found in the sample library that are about extinction and that were
published from 2000 to 2010.
To search for references:
1. Make sure that the All References group is displayed.
2. Click the Search tab.
3. The Search tab remembers the last search you entered. To
clear it, use the Action menu (Macintosh) or the Options
button (Windows) to select Restore Default.

Click the
Action
menu to
display a
list of
options

4. On the first search line:
a. In the first drop-down list, the Field list, scroll up and
select Any Field. This means that EndNote will search all
fields.
b. In the next drop-down list, the Comparison list, the
Contains comparison operator means that EndNote will
search for the string of text anywhere in the field.
c.

Type “extinct” as the first search term.
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Next, set up the search to find references dated from 2000 to
2010.
5. From the Field list in the second search line, select Year;
from the Comparison list, select Is greater than or equal to;
and then type “2000” as the search term for the second
search line.
6. If you do not have a third search line available, click the plus
sign button next to the last search line to insert another line.
You can also click and drag the top of the pane to view more
of the Search tab.
7. From the Field list in the third search line, select Year; from
the Comparison list, select Is less than or equal to; and then
type “2010” as the search term.
8. Notice the “And, Or, Not” logical operator list at the beginning
of each search line. Select the And logical operator between
the three search lines.
Your Search tab should look like this:
Logical
Field list
Operator List

Comparison List

Search Terms

This search will find all references containing the text
“extinct” that also were published between 2000 and 2011.
Notice that the following check boxes are not selected for this
search:
Match Case: This option would limit our search to “extinct” in
lowercase. If it were found capitalized at the beginning of a
sentence, or all uppercase, it would not match the search.
Match Words: This option would limit matches to full words,
with no truncation. The word “extinction” would not match our
search.

86

Chapter 8: Searching an EndNote Library and Saving it as a Smart Group

9. Click the Search button to begin the search. In a moment,
EndNote displays the search results.

The status area at the bottom of the Library window should read,
“Showing 5 of 5 references in Group.”
Notice in the Groups pane that these search results are
automatically retained in a Search Results group. This makes it
easy to display other sets of references, but still go back and
display your most recent search results. This temporary Search
Results group will be replaced the next time you run a search on
the library. When you close the library, this group is removed.
As you enter additional references into your library, you may
want to keep track of the references that meet this search
criteria. An easy way to do this is with a smart group as described
next.

Create a Smart
Group

You could create a custom group, and then drag your search
results to the group, but as you entered new references into your
library, you would need to manually keep updating the custom
group. Instead, create a smart group that updates automatically.
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The Search tab should still display the search strategy to find
“extinct” and the publication years between 2000 to 2011.
To use the search strategy to create a smart group:
1. Click the Action menu (Macintosh) or the Options button
(Windows), and then select Convert to Smart Group.

A Converted Search smart group is created under the first
custom group set, Paleontology.
2. Type “Extinct” for the Converted Search title, and then press
Return (Macintosh) or Enter (Windows).
If you have already clicked away from the editable title, you
can Control+click (Macintosh) or right-click (Windows) on
Converted Search, and then select Rename Group.
Each time a reference is added to the library or edited, the smart
group will update as needed.
To show all references again in the library window, click the All
References group.

Create a
Combo Group

Let us assume that you want to combine all your custom groups
and smart groups under the Paleontology group set in order to
create a combination group.
To create a combination group:
1. In the Groups pane, click on any of the groups in the Paleontology group set.
2. From the Groups menu, select Create from Groups.
3. In the Group Name field, type “Paleontology Combo Group.”
4. Go to the “Include References in” section of the dialog. In
the first field, select Earth Studies from the Paleontology
group set.
5. In the second field, select Eocene, and then select the OR
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Boolean operator.
6. In the third field, select Excavation, and then select the OR
Boolean operator.
7. Lastly, in the fourth field, select Fossils, but then select the
NOT operator.
8. Click the Create button to save your changes. Your combo
group should appear in the Groups pane.

Your combined group should contain 44 references from the
following custom groups and smart groups.


Earth Studies



Eocene



Excavation



Fossils

Notice that your combination group shows six references in the
Fossils group. However, because we used the Not operator to
exclude references from this group, those references do not
appear in the Paleontology Combo Group. Moreover, duplicates
are excluded from the combination group.
NOTE: If you delete a reference from a combined group, EndNote
removes that reference from the custom and/or smart group from which
it originally came. References deleted from a custom group are
removed from the group, and from the combo group, but not from the
All References list. References deleted from a smart group are
removed from the smart group, the combo group, and the All
References list, and moved to the Trash group.
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Related
Sections in
EndNote Help
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See the following topics in EndNote Help for information related
to this portion of the tour:


“Searching and Sorting in EndNote” to learn more about
searching the EndNote library and saving references in
groups.



“Using Groups” to learn more about creating and managing
groups.
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Chapter 9: Using EndNote While Writing a
Paper with Microsoft Word
Continue with this part of the tour only if you use Microsoft Word
2008 or 2011 (Macintosh) or Microsoft Word 2003, 2007, or 2010
(Windows). If you use a different word processor, or if you have
an older version of Word, see one of these EndNote Help topics
to learn how to cite EndNote references and create
bibliographies in your papers.


OpenOffice.org Writer/Cite While You Write (Windows)



RTF Files/Scanning and Formatting

EndNote’s Cite While You Write feature inserts EndNote
commands into Word’s Tools menu (or on an EndNote tab in
Word 2007 and 2010 for Windows) to give you direct access to
your references while writing in Microsoft Word. The Cite While
You Write commands enable EndNote to do bibliographic
formatting to the document that is currently open in Word.
In this part of the tour, you will learn how to:


Insert EndNote bibliographic citations into your paper and
create a bibliography.



Edit citations to suppress author names and add cited pages.

Open the
Sample
Library

If EndNote is not already running, start it and open the library
called Sample_Library_X5.enl as shown in “Start EndNote” on
page 35.

Open a
Microsoft
Word
Document

Start Microsoft Word and open a new document.

EndNote will look for matching references in the currently open
library. While EndNote can start and open your favorite library
when needed by Word, opening the library first assures you that
you are citing references from the appropriate library.

While we are not using one for this tour, EndNote does include
manuscript templates that make it easy to set up your paper for
electronic submission to a publisher. When you use one of these
templates to start your paper, many formatting issues are already
set up for your target publication, such as proper margins,
headings, pagination, line spacing, title page, font type, and font
size.
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For more information about using manuscript templates, see
“Creating a Word Document Based on a Template” in EndNote
Help.

Cite EndNote
References

You are going to start entering some text and citations for this
tour. This example assumes that your output style is set for
Annotated. If not, we will show you how to select an output style
in “Select a Bibliographic Style” on page 95.
To start writing your paper and inserting citations:
1. Open Word and enter the following text as though you were
writing a paper.
The fossil in question was generally
regarded to be the 220 million year-old
remains of tyrannosaurus. Several years ago,
however, Morehouse overturned this hypothesis
with the discovery of yet another species.
Now you are ready to insert a citation.
2. From the Tools menu, go to the EndNote X5 submenu, and
then click Find Citation(s).
Word 2007 and 2010: On the EndNote tab, click the Insert
Citation icon.
3. The Find & Insert My References dialog appears. Type the
author name “Morehouse” in the text box, and then click Find
(Windows) or Return (Macintosh).
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EndNote lists the matching references.

4. Click the Down arrow on the Insert button to display a menu.
Select the Insert & Display As: Author (Year) option.
EndNote inserts a citation and Instant Formatting formats the
citation in the currently selected style and adds it to a
formatted bibliography at the end of the paper.
EndNote automatically creates a link from the citation to the
bibliography. If you have multiple bibliographies (for example,
one at the end of each chapter and one at the end of the
document), you can link in-text citations to the reference list at
the end of each section and/or chapter. See “Select a
Bibliographic Style” on page 95 for information on how to turn
this feature on and off.
5. Add more text to the paper:
It is now the undisputed progeny of the
species at hand.
6. From the Tools menu, go to the EndNote X5 submenu, and
then click Find Citation(s).
Word 2007 and 2010: On the EndNote tab, click the Insert
Citation icon.
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7. Type the date “1987” into the text box and then click Find
(Windows) or Return (Macintosh). EndNote searches all
fields and lists the matching references.

8. Select the reference by the author Turnhouse.
9. Click the Down arrow on the Insert button to display a menu.
Select the Insert & Display As: Author (Year) option.
EndNote inserts a citation and Instant Formatting formats the
citation in the currently selected style and adds it to a
formatted bibliography at the end of the paper.
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Your document text should look similar to this example.

9. Assume that you have finished inserting citations in your
paper.
Keep your document open in order to select a bibliographic style
to continue the tour in “Select a Bibliographic Style” on page 95.
NOTE: You can also insert citations in footnotes. First, use the
appropriate Word command to create the footnote. Then, insert the
EndNote citation in the footnote. Word controls the placement and
numbering of the footnote, and EndNote formats the citation based on
the current style. You must select a style that formats footnotes; for
example, Chicago 16th.

Select a
Bibliographic
Style

You can format your citations and bibliography as many times as
you like, changing the output style and various other layout
settings each time.
To select the bibliographic style used for formatting:
1. From the Tools menu, go to the EndNote X5 submenu, and
then click Bibliography Settings.
Word 2007 and 2010: On the EndNote tab, in the
Bibliography group, click the bottom corner arrow.
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A Format Bibliography dialog appears where you can select
a bibliographic style.

Styles contain instructions for how EndNote will format
citations and the bibliography. Some styles sequentially
number citations, and then insert a numbered reference list
at the end of the paper. Other styles insert Author-Date
citations.
As you can see, there are other formatting options available
here; you can make changes that override the settings in the
current output style.
2. The Annotated style should appear in the “With output style”
field. If not, click the Browse button next to the field, and
select the Annotated style.
Note that you can sort the list of styles by Name or by
Category by clicking on a column header within the style
menu.
3. Click the “Underline linked in-text citations” check box so that
our citations within a document are visible as hyperlinks with
underlining and blue text.
4. Click OK to leave the Format Bibliography dialog.
EndNote automatically updates the existing citations and
regenerates the bibliography in the Annotated style.
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Your document text should look similar to this example.

NOTE: In the future, if you need to make changes to the paper such as
adding or deleting citations or text, just do the necessary updates in
your paper. If you want to change the output style or bibliography layout
settings, select the Format Bibliography command again. EndNote will
reformat the in-text citations and generate a new bibliography based on
your changes.

NOTE: More than 5,000 styles are available. To see the list of styles
currently installed, select Output Styles from the Endnote X5 menu
(Macintosh) or Edit menu (Windows), and then select Open Style
Manager. The Style Manager includes a Get More on the Web button to
easily locate and download individual styles. Or, you can install entire
categories of styles with the EndNote Customizer (Macintosh) or
installation program (Windows).

Edit a Citation

If you directly edit a citation or the bibliography, the changes will
be lost when you Format Bibliography again because EndNote
reformats according to the rules of the selected output style. To
make and retain changes to all citations and/or the bibliography,
modify the output style. However, if you want to make a change
to an individual citation, select the Edit & Manage Citation(s)
option as described below.
For some bibliographic styles, the majority of references are
cited in an “Author, Date” format; but if the author’s name is
mentioned within the paragraph text, the style dictates that the
name not be repeated in the citation. In our example, we mention
Morehouse and the date within the text of the paper.
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To edit an individual citation:
1. In Word, click anywhere on the Morehouse citation.
2. From the Tools menu, go to the EndNote X5 submenu, and
then click Edit & Manage Citation(s).
Word 2007 and 2010: On the EndNote tab, in the Citations
group, select Edit & Manage Citation(s).

3. Select the Edit Citation tab.
4. From the Format menu (Macintosh) or Formatting menu
(Windows), Select the Exclude Year option.
5. Leave the Prefix, Suffix, and Pages field blank.
6. Click OK to update the citations in your paper.
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Your document text should look similar to this example. Note that
the date is gone.

As you are working, remember to often save your document. You
can continue adding text and bibliographic citations to the paper,
and EndNote will continue adding to the list of references..
This completes the guided tour. You can close Microsoft Word.

Related
Sections in
EndNote Help

See the following topics in EndNote Help for information related
to this portion of the tour:
 “Microsoft Word/Cite While You Write” to learn about the
process of citing references and creating bibliographies.


“Bibliographic Styles” to learn about and install output styles.
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Whale Rescue Dilemma
Authors:

Dr Dominique Blache, Agriculture & Natural Sciences, University of WA
Stan Koios, Department of Education and Training

You and your family are on holidays on the south-east coast of Tasmania. You are
staying at the local caravan park in a small beachside town. You have spent the
first 3 days visiting a variety of tourist attractions. You and your parents make a
decision to have a quiet day around town today. You suggest a beach walk on a
remote beach about 5 minutes from your chalet. Whilst walking on the beach you
notice a large dark patch in the water off in the far distance. Excitement spreads
through the whole family. This is what you came to Tasmania for, this is whale
watching season. Could this be a pod of whales on their way down to Antarctica?
As you move closer to the dark patch you notice it is not out in the ocean, but quite
close to the beach. The feeling of excitement from the groups starts to dissipate
and a very different feeling descends upon the group.
You come across 100 or more adult Long-finned Pilot Whales that are either in
shallow water or on shore. Some are already dead but some are still alive. The
species is not endangered but they are listed as "Lower Risk; conservation
dependent" on the Red List of Threatened Species of the International Union for the
Conservation of Nature and Natural Resources (IUCN). Tourists and locals are
present on the beach around the whales and they are asking what course of action
should be taken. Three options emerge; do nothing, euthanise the whales that are
still alive or push the whales back into the water.
1. Organise students into pairs.

10 mins

What would you do? Why?
Compare your decision with the other person in your pair and discuss the reasons for your
decision. Try to understand why the other person has made the decision that they have.

The decision to push the whales back into the water is taken and while you help, the
National Park ranger tells you about the whales. Each whale 3.5 to 5 m long and
weighs between 1.5 and 3 tons, for females and males. Males live for about 45
years and females for about 60 years. Whales are social animals living in large
groups with a leader and a communal support system in which weaker or
endangered animals are helped by the rest of the pod. The groups are mainly 10 to
30 in number, but some groups may be 100 or more. They eat mainly squid. Some
of the females are pregnant. It takes a lot of work and effort to push each whale
back into the water. It is obvious that you will not have enough time to save them all.
2.

Organise students into groups of 3.

10 mins

Which animals would you push back first? Why?
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Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
This group of stranded pilot whales has attracted the attention of a group of Marine
scientists who would like to take tissue and blood samples to study the whales and
try to find some explanation for the stranding. The scientists want to know if the
whales are closely related using DNA profiling techniques and assess their health by
testing for toxic poisoning, infection or organ failure. All these causes have been
observed in other single stranded cetaceans.
3.

Organise students into groups of 3.

10 mins

Would you agree for the scientists to take samples from all the whales? Why?
Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
After 2 days, only a dozen whales have been successfully pushed back into sea
because each animal needs to be put on a sling and dragged across the sand of the
sea bed to deeper water. Their skin is fragile and the crew does not want to harm
them further. Also, because the beach is in a remote part of Tasmania, it is
impossible to use heavy equipment to lift and put the animals back in the water
because there is no dock or access road for heavy equipment. The whales cannot
be towed from the beach to the water using a towboat because it would break their
back. Time is crucial and it becomes obvious that some animals will not be rescued.
Before whaling bans, the pilot whale was hunted for meat and fat. It is possible to
contact a company that would euthanise the remaining whales and process them for
fat. The company will take only the animals that are freshly killed and would pay for
each whale. This money would help to cover part of the cost of the rescue.
Because they want to process the meat and fat for human consumption, the
company propose to euthanise the whales by blowing their heads off with a small
explosive, rather than an overdose of drugs which would render the meat unfit for
consumption.
4.

Organise students into groups of 3.

10 mins

Would you agree for the company to euthanise the remaining whales and
process them? Why?
Do you agree with this method of euthanasia? Why?
Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
A few months after the event, the scientists publish their finding in a public report.
The scientists point out that the causes for the stranding of cetaceans are numerous

Whale rescue dilemma

2

and not fully understood. One of the hypotheses proposed by the scientists is that
the whale’s navigation system and communication was disturbed by ultrasound
emitted during sonar equipment testing by the Navy. The number of cetaceans
stranded on beaches has doubled over the last decade in the UK. There are no
reliable data available for Tasmania.
5.

Organise students into groups of 3.

10 mins

If you knew that the whales beached themselves because of human activities,
would you have taken the same decision in Q1? Why?
Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
Later, however, Navy records show that their sonar testing started on day after the
first group of whales beached themselves.
The second hypothesis to explain the stranding is that, as suspected, the animals of
the group were genetically related and that some of the animals in the group were
carrying a genetic defect leading to heart defect (cardiomyopathy). It has been
documented that most isolated cases of cetacean stranding are linked to health
problems, often, bacterial infection or heart defects. Because of the very strong
social bond between the members of a group, it is possible that the mass beaching
is the result of the leader beaching itself because of its health problem and the rest
of the group following him. This is a natural process that has occurred since
recordings began.
6.

Organise students into groups of 3.

10 mins

If you knew that the whales beached themselves because of a genetic defect
and following a natural process, would you have taken the same decision in
Q1? Why?
Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
A few weeks later, a Blue whale is seen off Tasmania. The animal is wounded after
being attacked by a killer whale; its natural predator. Blue whales are large
mammals, 24-27 m long and weighing up to 136 tons. They are listed as
Endangered on the IUCN red list. The seriousness of the wound will need to be
assessed, a dangerous task for professional divers. The probability of the animal
surviving would be increased if future attacks were averted by human intervention,
giving the animal time to recover. This operation would be very expensive. Three
options emerge; do nothing, euthanise the whale or try to save it.

Whale rescue dilemma

3

7.

Organise students into groups of 3.

10 mins

Would you try to save this single Blue Whale? Why
Compare your decision with the other people in your group and discuss the reasons for your
decision. Try to understand why the other people have made the decision that they have.
The government has proposed that warning beacons for whales are set up at certain beaches
to help prevent of whales stranding, at a cost of $500 000. Write a letter to your local
newspaper to put forward your views on this idea.

Whale rescue dilemma
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Introduction
The whale shark ((Rhincodon typus) is the largest shark in the
ocean, reaching lengths of 20 metres and a weight of 20 tonnes
(figure 1). This icon species is often referred to as ‘charismatic
megafauna’ and a ‘gentle giant’. With very few defences,
it has become susceptible to exploitation and has a global
conservation status of ‘vulnerable to extinction’ as listed by
the World Conservation Union in the Red List of Threatened
Species.

then, consistent sightings have been recorded in Australia. A
lucrative ecotourism industry revolving around their annual
appearance at Ningaloo Marine Park (NMP), on the Western
Australian northwest coast, is now well established.

Distribution
Whale sharks have a broad distribution in tropical and warmtemperate seas, usually between latitudes 30ºN and 35ºS (figure
2). They are thought to prefer surface sea-water temperatures
of 21–25ºC. Sightings at NMP, however, are most common in
water temperatures around 27ºC.

Figure 2. The whale shark is widely distributed through tropical seas
(© CSIRO).

Whale sharks are known to inhabit both deep and shallow
coastal waters and the lagoons of coral atolls and reefs.
Australia is one of the most reliable locations to find them.
Regular sightings have also been recorded from many other
regions including India, the Maldives, South Africa, Belize,
Mexico, the Galapagos Islands, Southeast Asia and Indonesia.
Figure 1. The whale shark ((Rhincodon typus) (© Brad Norman).

History
The whale shark is a relatively recent addition to the human
record of the ocean and its inhabitants. However, the ancestry
of this shark goes back to the Jurassic and Cretaceous periods
245–65 million years ago, when the present groups of sharks
began to appear.
It was not until 1828 that the first whale shark specimen known
to science was discovered off the South African coast.
Dr Andrew Smith formally described the species later that year
as the largest living shark in the ocean.
This species is rare. Prior to the mid-1980s, there had been less
than 350 confirmed reports of whale sharks worldwide. Since

This species is widely distributed in Australian waters.
Although most common at NMP (and to a lesser extent at
Christmas Island and in the Coral Sea), sightings have been
confirmed further south than Kalbarri (on the mid-west coast of
Western Australia) and near Eden (New South Wales). Whale
sharks have also been recorded from Australian waters between
Australia and Indonesia.

Biology
This species is closely related to the bottom-dwelling sharks
(Orectolobiformes), which include the wobbegong. There
is a pattern of lines and spots on the skin of each shark
that enables them to ‘blend’ into their surroundings. This
‘camouflage’ makes the sharks less conspicuous in their
oceanic environment. The unique patterning does not appear to
change over time and can be used to identify individuals (see
photoid.whaleshark.org).
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One of only three filter-feeding sharks (the other two being
the basking and megamouth sharks), the whale shark feeds
on minute organisms (figure 3) including krill, crab larvae,
jellyfish, etc, and has been known to feed on larger prey
(e.g. sardines, anchovies, mackerels, small tunas and squid).
Although they have approximately 3000 tiny teeth (each less
than 6 mm in length), these teeth are not used while feeding.
Instead, the whale shark can sieve prey items as small as 1 mm
through the fine mesh of the gill-rakers. They are able to open
their mouth to a great width (greater than 1 metres) to optimise
feeding and are occasionally sighted hanging vertically in the
water allowing baitfish and other concentrated food items to be
‘sucked’ in.

Figure 3. Copepods and juvenile
crabs are eaten by whale sharks
( Brad Norman).

Reproduction
Whale sharks have internal fertilisation and produce live young
(the eggs hatch in the uterus prior to birth [ovoviviparity]).
They have more young than any shark, producing litters of
around 300 pups—although these are very small at an average
length of around 55 cm. The length of gestation, how often
they breed, and where they breed remains unknown. The only
pregnant female whale shark ever recorded was found off the
coast of Taiwan. There have been very few juvenile whale
sharks seen at any location throughout their range.
Studies of the whale sharks at NMP have established that
male whale sharks do not usually mature before they reach a
length of around 8–9 metres. Males can be distinguished by
the presence of two claspers (absent in females) near the pelvic
fin. The size at maturity of female whale sharks cannot be
determined through external observation.

Habitat and ecology
Although whale sharks are most often observed swimming
at the surface during ‘seasonal’ aggregations, evidence from
tracking studies indicate that whale sharks can dive to great
depths (~700 metres). They can also remain beneath the surface
for long periods.
They regularly appear at locations where seasonal food
‘pulses’ are known to occur. The predictable annual whale
shark aggregation at NMP is closely linked with an increase
in productivity of the region associated with a mass coral
spawning that occurs around March–April each year. It is likely
that this represents a critical habitat in the life cycle of this
species.
Acoustic-tracking studies at NMP reveal that individual whale
sharks sometimes stay close to Ningaloo Reef over day–night
periods. In addition, using the ECOCEAN Whale Shark Photoidentification Library, it has been possible to record many
sharks returning to Ningaloo in different years and remaining
there over long periods during the whale shark ‘season’. As
an example, one individual (A-012) was resighted at NMP on
14 separate days over a 28-day period within a very restricted
area. In addition, some sharks appear to show a level of
‘site-attachment’ when returning to the Australian northwest
coastline.

Migration
Whale sharks are regarded as highly migratory—although
their ‘migration patterns’ are poorly understood. Research at
NMP suggests the sharks may undertake a northerly migration
when leaving the area. Their seasonal appearance at Christmas
Island and sightings near Ashmore Reef provide support for
this theory (figure 4). It is when the sharks leave Australian
waters that they are potentially at risk of ‘unsustainable hunting
pressure’.
Satellite tracking of whale sharks in waters off the United
States of America and also in the South China Sea reveals
that these animals can travel great distances (thousands of
kilometres). These migrations may take years to complete. A
far greater understanding of whale shark movements will be
possible with the continuation of tagging and tracking studies
throughout the world and through expansion of the ECOCEAN
Whale Shark Photo-identification Library. Using ‘natural
tagging’ via photo-identification, it is possible for snorkellers
and SCUBA divers from around the world to help with
research on this species, by sending basic sighting information
(e.g. date and location) with a photograph of the unique natural
patterning on the skin of each shark to the online Library.
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Threats
Targeted or bycatch fisheries
• The most significant threat to the species appears to be
humans. In one fishery alone (India), as many as 1000 whale
sharks were believed killed in 1999 and 2000. Their habit of
swimming at the surface makes them particularly susceptible
to fishing. In previous times, the fins of whale sharks were
sold for high prices on the Asian market, although demand has
declined. There is still a market for whale shark meat in several
countries including Taiwan and China.
• In Taiwan, there is a quota of 120 whale sharks for capture
per year, although this is feared to be unsustainable. Of great
concern is the reduction on the size of individuals caught in
the Taiwanese fishery today compared with those of the early
1980s.

Natural predators
• There are very few known predators of the whale shark. In
nature, the most dangerous period in their life cycle appears to
be before reaching a substantial size (i.e., when the sharks are
still very young). Pups are a fraction of their adult size—only
approximately 55 cm in length at birth. The skin of an adult
whale shark provides their main protection. On average, the
thickness of the skin on the dorsal surface is 12–15 cm, greater
than that of any other living animal. In young whale sharks,
however, this ‘protection’ his not fully developed.

Figure 4. Satellite-tagged whale sharks in 2002
( http://www.marine.csiro.au/research/pelagic/tagging/hopetraveller/
index.htm).
Figure 5. a) A-076 photographed in 1999 with dorsal fin intact;
( http://www.shepherdproject.org/sharks.jsp?shark=A-076);
b) A-076 photographed in 2003 with dorsal fin damaged from attack
( http://www.shepherdproject.org/sharks.jsp?shark=A-076).
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• Very few juvenile whale sharks (i.e., less than 1–2 metres)
have ever been reported, although it is known that small
individuals are sometimes preyed upon by blue marlin and blue
sharks. There is also a record of an adult whale shark taken by a
killer whale in Mexican waters, and evidence of a whale shark
(A-076) being attacked by a larger shark off Australia. This
individual was sighted in 2002 with fin intact and resighted in
2003 at Ningaloo with fresh wounds (figure 5 a, b).

Vessel contact
• Because of their habit of swimming slowly at or near the
surface, whale sharks are particularly susceptible to boat strike.
Earlier in the 19th century there were occasional reports of
whale sharks being impaled on the bow of steamships. Today
there are very few reports of this happening, although many
sharks that are sighted near ecotourism activities in some parts
of the world show propeller wounds (i.e., evidence of vessel
contact).

Ecotourism
• Ecotourism is well-managed in Australia via a collaborative
approach between industry and the management agency,
which is the Western Australian Department of Conservation
and Land Management (CALM). Ecotourism is developing at
other locations throughout the world, and it is important that
such activity is well-regulated to minimise any impacts on this
threatened species.
• Whale sharks have shown a reaction to SCUBA bubbles,
touching and flash photography. These activities are not
permitted during whale shark ecotours in Australia (figure 6).

Protection
The whale shark is protected in the waters of very few of the
approximately 100 countries where it is known to visit. It is
protected in Honduran and some waters off the United States of
America. The Maldives brought in legislation to protect whale
sharks in 1995, and the Philippine government banned the
hunting of whale sharks in 1998. India followed in mid-2001.
However, at several other locations, unregulated fishing for
whale sharks is still apparent.

Figure 6. Whale sharks move slowly enabling ecotourists to swim
alongside ( www.ecocean.org).

• In Western Australian waters, the whale shark is fully
protected under the Wildlife Conservation Act 1950 (and under
this Act the Wildlife Conservation (Closed Season for Whale
Sharks) Notice 1996) and the Fish Resources Management Act
1994.
• The whale shark is also listed on the Bonn Convention
for the Conservation of Migratory Species. This identifies the
whale shark as a species whose conservation status would
benefit from the implementation of international cooperative
agreements.

What can you do?
When swimming with whale sharks, follow the Regulations to
minimise impacts on this species (figure 7).
Also, assist monitoring by noting simple sighting details of the
whale shark and if an identification photo(s) is available, please
submit this to the public online ECOCEAN Library
(http://photoid.whaleshark.org).

• The whale shark is identified as a migratory species
and a threatened species on the Australian Commonwealth
Environment Protection and Biodiversity Conservation Act
1999 and fully protected in Commonwealth waters.
• The whale shark is listed on Appendix II of the Convention
on International Trade in Endangered Species. This listing will
enable all member countries (~160) to monitor international
trade in whale shark products.
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For further information
ECOCEAN Whale Shark Conservation:
http://www.ecocean.org/whalesharks01.html
National Plan of Action for the Conservation and Management
of Sharks (Shark-plan):
http://www.daff.gov.au/sharkplan
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Figure 7. CALM / Industry management guidelines to minimise
impacts on sharks from ecotourism activities
( http://www.calm.wa.gov.au/tourism/whalesharks_
swimming.html).
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